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1. Введение 
 
FreePCB является свободным, с открытыми исходниками редактором печатных плат для Windows, который я начал 
писать потому что я быть неудачный с к настоящему времени доступному свободному или дешёвому PCB 
редакторам. Те которые я пробовал были либо непригодны по ограничениям ножек и слоёв, или глюковатые и 
трудные в использовании. Я наконец решил, что любой идиот может написать лучше и я быть идиот сделал это! 
Это руководство пользователя содержит главы на процес PCB дизайна и интерфейса пользователя FreePCB , и 
консультация которая передавать пользователя через процесс создания PCB из схемы и файла netlist. В процессе 
описания наиболее главных характеристик FreePCB. 
FreePCB написан для Microsoft Windows, но может быть запущен под Linux с использованием Wine, или на 
Macintosh компьютерах с VirtualPC. Исходный код охраняется авторским правом но выпущенный под Открытое 
лицензионное соглашение GNU (версия 2 или позже)[http://ru.wikipedia.org/wiki/GNU_General_Public_License]. 
Здесь есть срок лицензии. 
Если вы имеете вопросы относительно FreePCB, пожалуйста сначала просмотрите форум www.freepcb.com. Если 
вы хотите контактировать со мной напрямую, мой email адрес: allan@freepcb.com 
Благодарю за опробование FreePCB. 
 
  



2. Хронология Руководства пользователя  
2.1 Что нового в версии 1.4 
 
Вот новые особенности, которые были добавлены начиная с версии 1.2: 

� Добавлены функции для импорта и экспорта файлов в\из FreeRoute WEB автотрассировщик. 
� Project > Options теперь позволяет переименовывать проект, изменяя заданную по умолчанию 

библиотечную папку, и изменять число уровней. 
� Авто сохранение улучшено, так, чтобы авто сохраненные файлы хранились в подпапке проектной папки, с 

возрастающими именами файлов, сгенерированными автоматически. 
� Формат Gerber изменился от 2.6 до 2.4.  
� Группа функций copy/paste добавлена. Группы могут быть сохранены как проектные файлы, и проектный 

файл может быть вставлен как группа в другой проект. 
� Трассы могут теперь иметь ветви.  
� Новая функция Tools > Check Traces добавлена, которая улучшает трассировку комбинируя коллинеарные 

сегменты и устраняет сегменты нулевой длинны. 
� Трассировка из точек вне сетки улучшена, с тем чтобы "dogleg (излома соединительной линии)" сегменты 

трассировки были созданы получать обратно на сетку в один шаг. 
� Ширина трасс и переходных отверстий могут теперь быть изменены независимо в Project > Nets. 
� Вы можете изменить позиционное обозначение части в Edit > Part. 
� Там есть функция Change Layer для полигонов. 
� Редактирование полигонов улучшено. Полигон может теперь содержать другие полигоны. 
� В редакторе отпечатков, когда вы изменяете установки для ножки вы можете применять замену к другим 

ножкам. 
� Gerber вывод теперь включает маски пасты. 
� Gerber и сверления выходы могут теперь генерировать panelized данные. 
� Платы теперь могут содержать многочисленные контуры. 

 
2.2 Что нового в версии 1.2  
Вот новые особенности, которые были добавлены начиная с версии 1.0: 

� Когда трассируете с ratline, вы можете завершить трассу на любой ножке в сети трассировкой в ножку. Вы 
можете также делать это с обрубленными трассами. 

� View > Show part... позволяет вам выбрать часть в проекте через позиционное обозначение, затем 
центрируете окно на этом. 

� Отпечаток теперь может содержать текст шелкографии 
� Овальные, восьмиугольные и закруглённый квадрат площадки поддерживаются. 
� Функциональная кнопка и меню списка слоёв теперь "кликабельны" 
� Несколько меню правого клика расширены. 
� Отпечаток может содержать SMT площадки на обоих сторонах платы. Эта характеристика добавлена 

главным образом для краевых коннекторов. 
� Добавлены опции в File > Import Netlist, позволяющие ручной выбор корпусов, отпечатков и соединений, 

которые уже существуют в проекте. 
� Лист "последних файлов" теперь работает должным образом. 
� Вы можете обменивать соединение ножек, выбрав одну ножку, удерживая вниз "s" кнопку, и затем выбрав 

другую ножку. 
� Вы можете создать контур в слоях маски пайки (для примера, устранять "дамбы" маски пайки между 

штифтами края коннектора). 
� Check connectivity (проверка соединений) инструмент добавлен в меню Tools. Также, контролёр правил 

дизайна может сигнализировать об ошибках соединений.  
� Вырезы могут быть добавлены в полигоны.  
� Move Origin инструмент добавлен к меню Tools для перемещения начала координат.  
� Всю трассу можно выделить, удерживая "t" клавишу и нажимая на сегмент или вершину. Всё соединение 

может быть выделена, удерживанием "n" клавиши и нажимая на сегмент, вершину или вывод. 
� Функция "Change layer" была добавлена, когда сегменты или трассы выбраны.  
� Когда Вы изменяете ширину трассы соединения в Project > Nets... диалоге, Вы можете применить новую 

ширину к существующим трассам. 
� Через отверстие площадки теперь тянут на каждый слой меди. Слой "through-hole (через отверстие)" 

заменён слоем "drilled hole(просверленное отверстие)". 
� Большинство элементов может быть перемещено с клавишами курсора.  



� Вы можете выбрать группу элементов (таких как части, трассы, полигоны, и т.д.) нарисовав прямоугольник 
мышкой. Тогда вся группа может быть перемещена с мышью или клавишами курсора. 

� Опции были добавлены к File > Generate CAM files... диалогу, таким образом вы можете выбирать 
независимо использовать тепловую нагрузку на площадки и переходные отверстия, и независимо создавать 
открытие в паяльной маске через площадку переходного отверстия. 

� Было добавлено меню "Selection mask", таким образом Вы можете управлять типами элементов, которые 
могут быть выбраны мышью. 

� Когда перемещаются элементы, относительное расстояние отображается в строке состояния.  
� В меню Help есть элемент, который показывает список горячей клавиатуры. 

 



3. Установка FreePCB 
 
В конечном счете, FreePCB будет идти с хорошим инсталлятором, но пока Вы должны сделать это вручную. Вот 
инструкции 

� Загрузите последнюю версию программного обеспечения от www.freepcb.com. Это может быть в форме 
файла в zip архиве с названием freepcb_1000_bin.zip, само устанавливающегося архива с названием 
freepcb_1000_src.exe, или полное приложение инсталлятора, такое как freepcb_1000_setup.exe. 

� Установите программное обеспечение в папку на Вашем жестком диске, таком как C:\FreePCB или 
C:\Program Files\FreePCB. Эта папка должна теперь содержать подпапки как показано: 

 

 
� Подпапка bin содержит выполнимую программу FreePCB.exe, файл конфигурации default.cfg, 

задающий конфигурацию по умолчанию, и несколько других файлов.  
� Подпапка doc содержит документацию (главным образом это Руководство пользователя). 
� Подпапка lib содержит основные библиотеки отпечатков.  
� Подпапка lib_contrib содержит библиотеки отпечатков внесенные другими пользователями. 
� Подпапка lib_extra содержит реже используемые библиотеки отпечатков.  
� Подпапка projects содержит папки для каждого проекта PCB.  
� Подпапка src содержит исходный код для FreePCB. 

 
� Если Вы использовали приложение инсталлятора, Вы были запрошены создать настольный ярлык, чтобы 

запустить FreePCB. Если Вы использовали один из архивов, Вы можете сделать ярлык вручную. Откройте 
.\FreePCB\bin папку в Windows Explorer и перетащите файл FreePCB.exe на рабочий стол с ПРАВОЙ 
кнопкой мыши. Вы должны быть запрошены со списком опций включая создавание ярлыка. 

 
 



4. Краткий обзор Процесса проектирования PCB 
Это - краткий обзор процесса проектирования PCB, с объяснениями некоторых терменов, которых имеют особое 
значение в FreePCB. Их показывают в жирном шрифте, поскольку они представлены.  
 
4.1 Схема  
Большинство проектов PCB начинает со Схемы (Schematic Diagram), которая показывает Компоненты (Devices), 
используемые в проекте и Соединения (Connections) между ними. У каждого компонента в схеме есть 
Позиционное обозначение (Reference Designator), такое как "U1" или "R3". Точки подключения компонентов  
называют Штырьками (Pins), даже в том случае, когда они фактически могут быть нештырьковыми, такими как 
позиции наконечники, проволочные выводы, винтовые зажимы, и т.д. В общем, PCB должен содержать 
компоненты соединённые точно как показано на схеме. Если проектировщик производит изменения в схеме 
размещения PCB, которые создают несоответствия между PCB и схемой, схема должна быть Скорректирована 
(Back-Annotated), чтобы отразить изменения.  
 
4.2 Определение Корпусов, Упаковочной информации и Названий Штырьков 
Первым шагом в проектирование PCB из схемы является  выбор физического Корпуса (Part) для каждого 
компонента в схеме. Спецификация корпуса, по крайней мере, должна включать упаковочную информацию - 
Упаковку (Package) и Схему расположения выводов (Pinout) для корпуса. Как только корпуса и упаковочная 
информация  были выбраны, может быть необходимо возвратиться к схеме и назначить Названия Штырьков (Pin 
Names). Название должно быть назначено на каждый штырек в проекте, даже на корпусах, у которых есть 
взаимозаменяемые штырьки, такие как резисторы.  
Названия штырьков обычно - числа, но могут также содержать буквы. Если буквы используются, FreePCB 
требует, чтобы они предшествовали любым числам. Например, "12", "A", "SOURCE" и "A23" являются 
допустимыми названиями штырька, в то время как "1A" и "A1A" нет. Другие символы кроме букв и чисел не 
допускаются.  
Идентификатор упаковки (Package Identifier) является строкой, такой как "DIP16", которая идентифицирует 
упаковку для FreePCB, и определяет какой Отпечаток (Footprint) используется для корпуса. Отпечаток включает 
медные Контактные площадки (Pads) к которым припаиваются штырьки, а так же графические элементы, такие 
как Контур корпуса (Part Outline) и Текстовая строка (Text String) для позиционного обозначения.  
 
4.3 Список корпусов (Partlist Partlist) 
Partlist, это список всех корпусов проекта, с их позиционными обозначениями и идентефикаторами упаковки. 
Пример списка корпусов показан ниже: 

Позиционное обозначение Идентификатор упаковки 

U1 DIP14 

R1 RES_1/4W_AXIAL 

C1 CHIP_0805 

 



4.4 Список соединений 
Соединение (Net) устанавливает штырьки которые соединены вместе линиями на схеме. Каждый штырек в 
соединении идентифицирован текстовой строкой, состоящей из позиционного обозначения корпуса, содержащего 
штырек, символа ".", и названия штырька. Например, штырек 8 корпуса U5 был бы "U5.8". У каждого соединения 
должно быть уникальное имя, которое может быть выразительным и описательным, или просто отличительным. 
Установка штырьков в соединении называется Списком штырьков (Pin List).  
Список соединений (Netlist) является списком всех соединений в проекте, с их списками штырьков. Типовой 
список соединений показан ниже: 

Имя соединения Список штырьков 

VCC U1.14, R1.1, C1.1, Q1.C 

GND U1.7, C1.2, Q1.E 

$$1234 U1.1, R1.2, U1.2, Q1.B 

 
4.5 Создание Файлов списка соединений 
Если схема была создана схематическим редактором, список корпусов и список соединений могут быть 
автоматически записаны в Файл Списка соединений (Netlist File). Большинство редакторов произведет файлы 
списка соединений во множестве форматов. Вы должны выбрать формат, который распознаётся FreePCB, таким как 
"PADS-PCB". Файл списка соединений в этом формате показан ниже. Распечатка в значительной степени очевидна. 
 
*PADS-PCB*  
*PARTS*  
U1 DIP14  
R1 RES_1/4W_AXIAL  
C1 C0805  
 
*NETS*  
*SIGNAL* GND 
U1.7 C1.2  
 
*SIGNAL* $1234  
U1.1 R1.2 U1.2  
 
Если Вы работаете с напечатанной или нарисованной от руки схемой, Вы придётся сделать файл списка 
соединений вручную. Это довольно легко, хотя может стать утомительным на большом проекте. Я обычно делаю 
фотокопию схемы, которую я могу привлечь. Затем я начинаю делать файл списка соединений, используя 
редактора текста. Для каждого компонента я подсвечиваю позиционное обозначение на схеме желтым 
фломастером, поскольку я добавляю это в список корпусов. Затем я назначаю названия соединениям и названия 
штырькам (если они уже не находятся на схеме), и делаю список соединений. Для каждого соединения я использую 
желтый маркер и отмечаю каждое подключение, по мере пополнения списка штырьков. Когда я заканчиваю, 
каждый компонент и каждое подключение на схеме должны быть закрашены жёлтым. Тогда, я распечатываю файл 
списка соединений и проверяю его построчно. Поскольку я иду, я снова подсвечиваю части и подключения в схеме, 
но на сей раз красным пером, удостоверяясь, что каждая часть и каждое подключение включены. Я делал весьма 
большие файлы списка соединений этим путем без ошибок. 
 
 
 



4.6 Импортирование Файлов Списка соединений в FreePCB  
Однажды Ваш файл списка будет готов, Вы можете импортировать это в FreePCB, чтобы запустить Ваш проект. 
FreePCB попытается найти отпечаток соответствующий идентификатору упаковки для каждого корпуса. Если это 
неудачно, Вы можете назначить отпечатки вручную, или возвратиться и редактировать список соединений. Все 
отпечатки будут помещены в левом нижнем углу области проекта PCB. FreePCB затем загружает соединения из 
списка соединений, разрывая каждое соединение в ряд подключений между штырьками в соединении. Они 
появятся как розовые линии между штырьками, называемыми Связями (Ratlines). Если Вы перемещаете корпуса, 
то связи будут перемещаться вместе с ними.  
 
4.7 Добавление корпусов и соединений "На лету"  
В качестве альтернативы, Вы можете создать проект в FreePCB без файла списка соединений при использовании  
методики редактирования "на лету". Начиная с пустого проекта, добавьте каждый корпус, соединение и 
подключение, используя меню Modify и Add. Вы будете запрошены относительно позиционных обозначений и   
названий соединений по мере необходимости. Это работает разумно хорошо для маленьких проектов, но я 
предпочитаю создавать файл списка соединений как описано выше.  
 
4.8 Размещение корпусов  
Следующим шагом является Размещение (Place) корпусов на PCB, двигая и вращая их по мере необходимости. 
После того, как Вы переместите корпус, FreePCB автоматически переназначит связи каждого соединения, 
подключенного к корпусу, минимизируя их полную длину. Выравнивание частей делает более простым  
использование Сетки (Snap Grid).  
 
4.9 Разводка дорожек (Трассировка)  
Когда корпуса размещены, начинается разводка. Это обычно самая сложная часть процесса проектирования PCB, 
отнимающая много времени. Каждое подключение должно быть преобразовано в медную дорожку (Trace), 
состоящую из множественных прямолинейных Сегментов (Segments). Точки, где сегменты объединены 
называются Вершинами(Vertices). Сегменты могут все быть на одном том же самом медном Слое (Layer), или 
могут быть на различных слоях, и в этом случае они будут подключены через Переходный отверстия (Vias). В 
этом пункте FreePCB поддерживает только полную толщину vias, не поддерживает слепых или скрытых 
переходных отверстий. Дорожки могут содержать Ответвления (Branches) к дополнительным штырькам, помимо 
оригинальных конечных точек дорожки. Полигоны (Copper Areas) могут также быть созданы, которые полезны 
для плоскостей питания  и земли. Обрубленные дорожки (Stub Traces) могут использоваться для подключения 
площадок SMT к полигонам. Сетка излома полезна для выравнивания дорожек. Вы можете также установить Угол 
Излома (Snap Angle), который вынуждает сегменты дорожки быть ориентированными во многих углах излома 
(обычно 45 степеней).  
 
4.10 Добавить текст  
Текстовая строка может быть добавлены для пометок, исправления чисел, объявлений об авторском праве, и т.д. 
Они будут обычно размещаться в уровни шелкографии.  
 
4.11 Файлы прорисовки и сверления  
Прорисовки каждого слоя, могут быть экспортированы в виде Gerber файлов (Gerber Files), которые 
используются для создания Фотошаблонов (Photoplots) для изготовления PCB. FreePCB может также произвести 
Файлы Сверловки (Drill Files), которые определяют все отверстия, которые будут просверлены в плате. Вы 
можете использовать бесплатный Просмотрщик Gerber (Gerber Viewer), такой как ViewMate от PentaLogix, для  
проверки Ваших файлов и сделать Проверочную Прорисовку (Check Plots) на принтере Windows. Затем пошлите 
свой Gerber файл и файл сверловки в Компанию Изготовления PCB (PCB Fabrication Company) (вместе с 
некоторым количеством Денег (Money)), и они пришлют назад законченные платы, обычно через несколько дней. 
Как это Круто (Cool)! 
 
 
 



5. Размещение PCB  
 
5.1 Копия экрана 
 
Копия экрана FreePCB показана ниже. 
 

 
Основные элементы окна:  
1. Строка меню, с File, Edit, View, Project, Tools, Add и Help меню  
2. Панель задач (непосредственно ниже строки меню), с 8 иллюстрированными кнопками и 5 раскрывающихся 
меню для установки единиц измерения (Units) (mil или мм) и интервала сеток Видимости (Visible), Размещения 
(Placement) и Трассировки (Routing) и угла излома (Angle)(в градусах).  
3. Список слоёв на левой стороне клиентской области, с окошками рядом с каждым слоем, показывающими его 
цвет и видимость.  
4. Выбор маски, ниже списка слоёв, с полями, чтобы разрешить/запретить выбор различных элементов.  
5. Окно размещения, где показана PCB.  
6. Меню функциональных клавиш ниже списка слоёв и окна размещения, показывает доступные команды 
функциональной клавиши.  
7. Строка состояния в основании.  
 
Эти элементы описаны более подробно в следующих разделах. 
 
 
 



5.2 Меню  
Следующие меню доступны из строки меню: 
♦ File 

• New — создать новый проект PCB (быстрая клавиша = Ctrl-N) 
• Open... - открыть файл проекта PCB ( быстрая клавиша = Ctrl-O) 
• Save — сохранить файл проекта PCB ( быстрая клавиша = Ctrl-S) 
• Save As... - сохранить файл проекта PCB под новым именем 
• Close — закрыть проект 
• Import netlist... - импорт файла списка соединений 
• Export netlist... - экспорт файла списка соединений 
• Convert library... - конвертировать библиотеку отпечатков из Ivex в FreePCB формат 
• Generate CAM files... - конвертировать библиотеку отпечатков из Ivex в FreePCB формат 
• Open Footprint Editor... - перейти из редактора PCB в редактор отпечатков 
• Export .dsn file... - Экспортировать файл дизайна в автотрассировщика 
• Import .ses file... - импортировать файл сессии из автотрассировщика 
• Print... - (пока не осуществлено) 
• Print Preview - (пока не осуществлено) 
• Print Setup... - (пока не осуществлено) 
• Exit — закрыть приложение 

 
♦ Edit 

• Undo — отменить последнюю операцию ( быстрая клавиша = Ctrl-Z) 
• Cut — сохранить в буфер обмена и удалить (доступно только для групп) 
• Copy — сохранить в буфер обмена (доступно только для групп) 
• Paste — вставить из буфера обмена (доступно только для групп) 
• Save group to file... - сохранить группу как файл проекта 
• Paste group from file... - вставить группу из файла проекта 

 
♦ View 

� Show board outline — увеличить масштаб, чтобы отобразить всю плату 
� Show all — увеличить масштаб, чтобы отобразить все элементы размещения (сокращённо=Home) 
� Show part... - открыть диалог для выбора корпуса, затем выбрать это и цент на этом 
� Layers... - открыть диалог просмотр/редактирование слоёв 
� Show log... - показать лог окна 

 
♦ Project 

• Options — открыть диалог Опции Проекта, чтобы редактировать опции проекта 
• Parts... - открыть диалог Смотреть/Редактировать корпуса для редактирования списка корпусов 
• Nets... - открыть диалог Смотреть/Редактировать соединения для редактирования списка соединений 



♦ Tools 
• Move origin — переместить оригин системы координат в новую позицию 
• Footprint Wizard — открыть Мастер отпечатка для создания нового отпечатка 
• Footprint Editor — открыть редактор отпечатка для создания или редактирования отпечатка 
• Check parts and nets — Проверить проект на внутренние ошибки базы данных 
• Check traces — проверить и очистить дорожки 
• Check connectivity — проверить проект на неполные подключения списка соединений 
• Check Copper Areas — проверка полигинов, объединить если нужно 
• Design Rule Check — Проверить согласованность с правилами проекта и показать ошибки 
• Clear DRC Errors — Очистить символы для всех ошибок DRC 
• FreeRoute autorouter... - запустить web-основанный автотрассировщик 

 
♦ Add 

• Board Outline — добавить контур PCB 
• Part — добавить новый корпус 
• Net - (пока не осуществлено) 
• Copper Area — добавить полигон 
• Text — добавить строку текста 
• Solder Mask Cutout — добавить контур в слой паяльной маски 

 
 ♦ Help 

• User Guide – показать это руководство пользователя 
• FreePCB Website – посетить вебсайт FreePCB 
• FreeRouting Website – посетить доступ к on-line трассировщику FreeRoute  
• Keyboard shortcuts – показать список быстрых клавиш 
• About FreePCB... – показать информацию о программе FreePCB 



5.3 Панель задач  
Панель задач показана ниже: 

 
 
Она содержит 8 иллюстрированных кнопок, которые являются ярлыками для следующих пунктов меню: 
 New 
 Open 
 Save 
 Cut 
 Copy 
 Paste 
 Print 
 About 
 
Они сопровождаются 5 раскрывающимися меню для установки единиц измерения и сетки, используемых в 
FreePCB. Это: 
 Units – выбрать mils или mm для измерений размеров 
 Visible – установить интервал прямоугольного массива точек в окне размещения, как видимые ссылки 
 Placement – установить сетку для размещения корпусов, текста и т.п. 
 Routing – установить сетку для разводки дорожек и прорисовки полигонов 
 Angle – установить угол излома (в градусах) для разводки дорожек, прорисовки границ платы и полигонов 
 
Заданные по умолчанию данные для раскрывающихся меню (кроме меню Angle) находятся в файле default.cfg, в 
папке, которая содержит FreePCB.exe. Когда проект создан, они копируются в секцию опций проектного файла. 
Они могут быть изменены при помощи любого текстового редактора, например таким, как Блокнот. 



5.4 Строка состояния  
строка состояния (находится в нижней части окна FreePCB) показана далее: 

 
 
Она содержит следующие элементы: 
 

� Подсказку (“Ready”), которая изменяется, если курсор помещается поверх различных элементов 
пользовательского интерфейса 

� X и Y координаты курсора в mils или мм 
� Информация об элементе, который выбран (если выбран). В примере выше, корпус U1 был выбран. Его 

позиционное обозначение, отпечаток, позиция, угол и сторона отображены. 
� Текущий трассируемый слой (“Top”) 



5.5 Список слоёв и выбранная маска 
Это два вертикальных списка в окне FreePCB, слева от области размещения.  
 
5.5.1 Список слоёв  

Это - список всех слоёв рисования используемых в проекте. Рядом с названием каждого слоя 
маленький квадрат, показывающий цвет слоя. Если уровень был сделан невидимым, квадрат будет 
белым с "X" через него (таким как "inner 1" и "inner 2" в примере). Вы можете переключить 
каждый слой от видимого до невидимого, нажимая на квадрат.  
Слой активный для трассировки ("top copper" в примере ниже) будет идентифицирован со стрелкой 
- указателем. Вы можете изменить активный уровень трассировки, нажимая числовую клавишу на 
клавиатуре (то есть клавиши с "1" до "8"), или кликая на названии слоя в списке. Активный слой 
трассировки будет всегда отображаться поверх других слоёв в окне размещения. 
 
 
 
 
 

 
Цвет каждого слоя можно изменить. Для изменения цвета слоя выбираем 
Layers в меню View, которое вызывает  диалог View/Edit Layers, 
показанный ниже. Нажмите на кнопки в столбце Edit, чтобы изменить цвета. 
Вы можете также изменить видимость слоёв в этом диалоге. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
5.5.2 Маска выбора 

Элементы в размещении можно выбрать для редактирования, кликнув по ним или нарисовав 
вокруг них прямоугольник мышкой. Так как элементы могут наложиться друг друга, то иногда 
бывает трудно выбрать точно тот элемент, который Вам нужен. В этом случае можно 
использовать маску выбора, чтобы позволить или отключить выбор различных типов элемента. 
Маска состоит из списка типов, с цветным блоком рядом с каждым. Зеленый блок означает, что 
тип элемента может быть выбран, в то время как красный блок означает, что это не может. Вы 
можете переключить состояние каждого блока, нажимая на него. 
 
 
 
 
 

 



5.6 Функциональные клавиши и Контекстное меню 
Большинство программ рисования Windows делают тяжелым использование "кликнуть-тащить" с мышью для того, 
чтобы редактировать. Это означает удерживать в нажатом состоянии левую кнопку мыши, перемещая мышь. 
Можно изменить размеры элемента кликнув по нему, что влечёт за собой блок выбора с "ручками", которые можно 
затем кликнуть и перетащить, чтобы увеличить или уменьшить элемент. Конечные точки линии могут быть 
перетащены щелчком к новой позиции, и т.д., и т.д.  
Однако, клик-перемещение не работает достаточно хорошо для трассировки дорожек, который является самой 
отнимающей много времени частью схемы размещения PCB. Дорожки - в основном ломаные линии, состоят из 
множества подключенных линий сегментов. Размещение каждого сегмента требует отдельного щелчка мыши, 
который подразумевает, что сегменты нужно перетащить, не удерживая в нажатом состоянии кнопку мыши.  
Кроме того, пока трассируются дорожки или размещаются корпуса, полезно быть в состоянии к панорамированию 
и увеличению масштаба изображения, которое мне нравится делать с использованием прокрутки на мыши. Очень 
трудно использовать прокрутку, одновременно удерживая кнопку мыши.  
Поэтому FreePCB использует немного другой подход. Элемент выбирается, если кликнуть по нему. После элемент 
подсвечивается, что указывает на то, что он был выбран, и описание элемента появится на строке состояния. 
Операция редактирования может тогда быть выполнена, нажимая функциональную клавишу на клавиатуре. 
Операции, назначенные на каждую функциональную клавишу, перечислены в нижней части окна FreePCB. Этот 
список контекстно-зависим, и изменится, в зависимости от того, какой элемент был выбран. Например, меню, когда 
выбрана корпус, показано ниже. 

 
 
Если операция потребует перемещения, то это начнется, как только функциональная клавиша будет нажата. 
Операция обычно заканчивается нажатием левой кнопки мышки, или может быть отменена, щелкая правой 
кнопкой мыши. Пока делается перемещение, функциональные клавиши остаются активными, так, чтобы могли 
быть выполнены дополнительные операции. Например, во время перемещения корпуса, нажатие F3 позволит 
вращать его, в то время как нажатие F2 позволит переместить его на противоположную сторону платы. Этот стиль 
пользовательского интерфейса требует, чтобы Вы держали свою левую руку на клавиатуре, и Вашей правой 
работали с мышкой, редактируя (предполагается, что Вы правша). Во времена DOS многие программ CAD 
использовали этот стиль, и некоторые еще продолжают использовать. Если у Вас есть сомнение относительно 
скорости и эффективности подхода "левая рука на клавиатуре, а правая с мышкой", тогда проведите несколько 
минут, наблюдая за кем-то, кто играет в одну из популярных игр, таких как Doom, Quake, Unreal Tournament, Half-
life, Tribes, и т.д. Они все используют именно этот стиль пользовательского интерфейса. И трассировка PCB 
обычно является более простой операцией, чем обстрел неистовствующих нацистских мутантов, наседающих со 
всех сторон!  
Назначение операций редактирования функциональным клавишам является не полностью произвольным, как 
может показаться сначала. Так как пальцы левой руки обычно лежат на клавишах F1-F4, то они используются для 
первичных операций редактирования. F4 (под указательным пальцем) используется для самой общей операции на 
выбранном элементе (такой, как перемещение корпуса), в то время как F2-F3 используются для менее общих 
операций. F1 часто используется, чтобы вызвать своего рода диалог, позволяющий редактировать свойства 
выбранного элемента. Клавиши F5-F8 обычно используются для удаления или перетрассировки, так как они 
требуют движения рукой, что уменьшает вероятность их случайного нажатия. Клавиша F9 зарезервирована для 
того, чтобы повторно вычислить ratlines. Это расположение очевидно оптимизировано для пользователей, которые 
в основном используют правую руку (как я). Я предполагаю добавить опцию "left-handed (левша)" в будущем.  

 
Если Вы предпочтете не использовать функциональные клавиши, то щелкая правой 
кнопкой можно вызвать более традиционное меню Windows, показано ниже. Это так 
называемое "меню контекста", и его информационное наполнения изменяется, в 
зависимости от того, какой элемент выбран. Меню контекста не доступно, в то время как 
Вы перетаскиваете элемент мышкой, таким образом функциональные клавиши всё равно 
должны использоваться, чтобы выполнить операции во время перемещения. 
 
 



5.7 Панорамирование и Изменение масштаба изображения  
Имейте в виду, что в окне FreePCB нет никаких линеек прокрутки. Использование полосы прокрутки для 
панорамирования не очень практично для программы размещения PCB, так как вынуждает часто выполнять 
панорамирование, направляя дорожки или перемещая корпуса. Это неэффективно, так как вынуждает сдвигать 
курсор из рабочей области к линейки прокрутки.  
Поэтому, панорамирование и изменение масштаба изображения в FreePCB выполнено или клавишами клавиатуры 
или (предпочтительно) путём прокрутки мышки. Для панорамирования, переместите курсор в пункт на PCB, 
который будет новым центром изображения, и надавите клавишу пробел или прокрутите колёсико мышки на один 
щелчёк в любом направлении. Изображение повторно центрируется на позиции курсора. Чтобы увеличить 
изображение, нажмите клавишу "Page Up" или прокрутите вперёд колёсико мышки более чем на один щелчёк. 
Чтобы уменьшить изображение, нажмите "Page Down" или прокрутите назад колёсико мышки. Если бы у Вас нет 
мышки с колёсиком, я рекомендовал бы её приобрести.  
Вы можете отобразить всю схему PCB, используя View->Show board outline элемент меню. Вы можете показать 
все элементы в проекте (которые могут находится за пределами PCB), выбрав View->Show all, или нажав клавишу 
"Home". Вы можете выбрать корпус и панорамироваться к его местоположению, используя View->Show part... 



5.8 Проекты  
В FreePCB, размещения PCB упоминаются как проекты. Вся информация, описывающая проект, хранится в 
единственном текстовом файле с расширением .fpc, который обычно сохраняется в папке с тем же самым 
названием как проект. Например, проект под названием "Motor" был бы сохранен в файле Motor.fpc в папке 
C:\FreePCB\projects\Motor  
Новый проект создаётся с помощью File > New. Это начнет Project Options диалог, который показан ниже. 

Имейте в виду, что большинство полей диалога уже 
заполнено. Эти настройки по умолчанию взяты из файла, 
названного default.cfg, который должен быть расположен в 
той же самой папке как и приложение FreePCB.exe. Если 
Вы не хотите использовать значения по умолчанию для 
своего проекта, Вы можете изменить их в диалоге. Если Вы 
хотели бы изменить значения по умолчанию для всех 
будущих проектов, Вы можете отредактировать файл 
defaults.cfg любым редактором текста. Формат этого файла 
описан в Части 8: Форматы файлов. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Каждое поле в диалоге объяснено ниже: 
 
 Name: Это - название проекта, которое не должно содержать пробелов или любые символы, которые 
недопустимы в имени файла. 
 Project Folder: Это - папка, где будет сохранён Ваш файл проекта. Уже заполнен путь заданной по умолчанию 
родительской папки для новых проектов. Поскольку Вы вводите имя своего проекта в поле Name, каждый символ 
будет автоматически добавлен к пути. Например, если Вы введете "Motor" в поле Name, то поле Project Folder  
станет "..\projects\Motor". Если Вы хотите использовать отличную папку проекта, Вы можете отменить значение по 
умолчанию, введя новый путь непосредственно в поле Project Folder. 

� Примечание: Заданный по умолчанию путь начинается ".. \", указывая на то, что это - относительный 
путь. Фактически, это местоположение расположенное относительно приложения FreePCB.exe. Если Вы 
выполнили заданную по умолчанию инсталляцию в C:\FreePCB, приложение будет в C:\FreePCB\bin, и 
проектные папки будут в C:\FreePCB\projects. Если Вы устанавливали FreePCB где-то в другом месте, 
заданный по умолчанию путь будет все еще работать пока \bin, и \projects находятся в той же самой папке. 
В противном случае Вы можете редактировать default.cfg файл. Например, когда я работаю над исходным 
текстом FreePCB, я выполняю приложение из E:\allan\SVNwork\FreePCB\Debug, но я все еще хочу 
создавать свои проекты в C:\FreePCB\projects. Поэтому, в E:\allan\SVNwork\FreePCB\Debug\default.cfg, 
я изменил строку  
parent_folder: "..\projects \" 
на 
parent_folder: "C:\FreePCB\projects \" 

 
 Library Folder: Это - путь к папке, которая содержит файлы библиотеки отпечатков для FreePCB. Путь по 
умолчанию задан относительно папки приложения, но это может быть изменено в диалоге, если необходимо, и 
значение по умолчанию будет изменено в default.cfg так же, как для Project Folder (см. примечание выше). 
 Number of copper layers: Это - число слоев меди на PCB, между 1 и 8.  
 Default trace and via widths (mils): Это значение по умолчанию для ширины дорожки, диаметр площадки 
переходов и диаметр отверстия переходов. Они могут быть отменены позже для специфических дорожек и 
соединений. 
 Menu of trace and via widths: Это - список ширины дорожек и переходов, который предложен как меню, если вы 
модифицируете ширину конкретной части дорожки или соединения. Вы не ограничены этими значениями, но  
удобно иметь их в меню, и это уменьшает шанс ошибки. Вы можете использовать кнопку Add, чтобы добавить 
новые данные в список. Если Вы выбираете элемент, Вы можете использовать кнопку Delete, чтобы удалить его 
или кнопку Edit, чтобы изменить. 
 Autosave: Разрешение Автосохранения заставляет FreePCB автоматически сохранять проектный файл каждые 
несколько минут.  
Когда Вы удовлетворены своими данными, кликните OK. Проектная папка будет создана, если она уже не  
существует (однако, родительская папка должна существовать, или Вы получите сообщение об ошибках). 
Проектный файл не будет написан в папку, пока Вы Save от меню File. Я обычно немедленно делаю это после 
того, как создал новый проект.  
Между прочим, Name проекта используется, чтобы создать названия для проектного файла и заданной по 
умолчанию проектной папки. После этого FreePCB использует название проектного файла как название проекта. 
Вы можете переименовать проектный файл, или использовать Save As из меню File, чтобы сохранить проект под 
другим названием. Вы можете найти полезным сохранять несколько различных версий Вашего проекта в 
проектной папке, под различными названиями. Например, Вы могли экспериментировать с некоторыми новыми 
идеями в проекте, но вернуться назад к более ранней версии, если они не удаются.  



Как упомянуто выше, Вы можете изменить значения по умолчанию для новых проектов, редактируя default.cfg 
файл в прикладной папке. Формат для этого файла описан в Секции 8: Форматы файлов, и у Вас не должно быть 
никакой проблемы, выясняя, как изменить это (но сохранить копию на всякий случай). Вы можете также 
редактировать проектный файл, если Вам хочется. Это - более сложный файл, с секциями, описывающими 
проектные опции, отпечатки, корпуса, соединения, текстовые строки, и т.д. Секция опций очень похожа на 
default.cfg файл. Вы скорей всего не захотите возиться слишком много с другими секциями. 

 
Как только проект создан, он может быть закрыт, 
сохранен и открыт с использованием обычных 
выборов из меню File.  
После того, как проект был создан, проектные 
опции можно отредактировать, выбирая Options... 
в меню Project. Это возвратит диалог Project 
Options. Вы можете произвести изменения в 
любом из позволенных полей, и сохранить их, 
нажав OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



5.9 Элементы PCB  
5.9.1 Отдельные элементы  
Представление PCB в окне размещения состоит из различных элементов, которые перечислены в этой части. 
Отметьте, что большинство из них может быть выбрано, нажимая на них. Как только элемент был выбран, с ним 
могут быть выполнены операции, путём нажатия функциональной клавиши или кликая правой кнопкой мыши и 
делая выбор из меню контекста. Если операция вовлекает перемещение элемента, функциональные клавиши могут 
иногда использоваться, чтобы выполнить дополнительные операции, пока происходит перемещение.  
Элементы PCB перечислены ниже, наряду с их связанными операциями функциональной клавиши. 

� Origin: Это - символ, который идентифицирует начало системы координат PCB (то есть пункт, где X = 0 и 
Y = 0). Это похоже на перекрестие с маленьким кружком в его центре. Он всегда видим, и не может быть 
выбран. Но может быть перемещён с использованием Tools > Move origin.  

� Visible grid: Точки в регулярно распределённом массиве, используемые для визуальной привязки. 
Интервал точек устанавливается при помощи выпадающих меню в панели задач. 

� Board outline: Это - замкнутая ломаная линия, состоя из ряда точек (углы), со линиями между ними. 
Стороны могут быть прямыми линиями или дугами. Углы и стороны являются выбираемыми, и могут быть 
отредактированы следующим образом: 

o Corner: 
� F1 (Set Position) - выскакивают диалог, который позволяет Вам явно редактировать 

координаты X и Y. 
� F4 (Move Corner) – начинает перетаскивание угла курсором.  
� F5 (Delete Corner) - удаляет угол.  
� F8 (Delete Outline) - удаляет контурную линию платы.  

o Side:  
� F1 (Straight Line) - делает сторону прямой линией.  
� F2 (Arc CW) - делает сторону, рисуя дугу по часовой стрелке.  
� F3 (Arc CCW) - делает сторону, рисуя дугу против часовой стрелки. 
� F4 (Add Corner) - вставляет угол в сторону, и запускает его перетаскивание.  
� F8 (Delete Outline) - удаляет контурную линию. 



� Part footprint (Отпечаток корпуса): Это - составной символ, состоящий из ряда медных контактных 
площадок, границы корпуса, текстовой строки для позиционного обозначения корпуса, и возможно других 
текстовых строк. Целый отпечаток, одиночная контактная площадка или позиционное обозначение могут 
быть выбраны для редактирования. 

o Entire footprint (Целый отпечаток):  
� F1 (Edit Part ) - выскакивают диалог, чтобы редактировать свойства корпуса.  
� F2 (Edit Footprint) - переключает на окно Footprint Editor, с отпечатком корпуса уже 

импортированным для редактирования. 
� F3 (Glue/Unglue Part) - "Склеенный" корпус нельзя переместить, не "расклеивая" его.  
� F4 (Move Part) - запускают перетаскивание отпечатка, чтобы переместить это. 

• Пока перетаскивается:  
o F2 – перебрасывает корпус с одной стороны платы на другой.  
o F3 - вращает корпус на 90 градусов по часовой стрелке.  

� F8 (Delete Part) - удаляют корпус с PCB и списка корпусов.  
� F9 (Recalc. Ratlines) - переназначает ratlines для всех соединений, которые соединены с 

корпусом,  для минимизации их длины. 
o Pad: 

� F1(Set net) - выскакивают диалог, чтобы назначить контактную площадку соединению.  
� F3 (Start Stub) - запускает перетаскивать нового обрубка дорожки.  
� F4 (Connect Pin) – начать перетаскивать ratline к другой контактной площадке. 
� F9 (Recalc. Ratlines) - переназначает ratlines для соединения, которое подключено к этой 

контактной площадке для минимизации  длины. 
o Reference designator text (Текст позиционного обозначения): 

� F1 (Set Size) - выскакивает диалог, который позволяет Вам изменить размер и направление 
текстовой строки. 

� F4 (Move Ref Text) - запускает перетаскивание текстовой строки, чтобы переместить это.  
• Пока перетаскивается:  

o F3 (Rotate Ref Text) - вращает текстовую строку на 90 градусов по 
часовой стрелке. 

 



� Trace (Дорожка): Это - ломаная линия, представляющая соединение между двумя контактными 
площадками. Она состоит из одного или больше прямолинейных сегментов с вершиной между сегментами. 
Сегменты могут быть разведенными (то есть физически существующими на медном уровне) или 
неразведёнными. Неразведённые сегменты называют ratlines. 

o Ratline: Это - линия, представляющая собой неразведённый сегмент дорожки.  
� F1 (Set Width) - выскакивает диалог, который позволяет Вам устанавливать  ширину 

дорожки и перехода для сегмента, дорожки или соединения.  
� F3 (Lock/Unlock Connect) - блокированный ratline не может быть уничтожен операцией 

"Recalc.Ratlines".  
� F4 (Route Segment) - начинает перетаскивать оконечную точку разводимого сегмента,  

чтобы заменить ratline.  
• Пока перетаскивается:  

o F4 (Законченный Сегмент) - расширяет направленный сегмент, на 
который перетаскивают оконечная точка ratline. 

� F5 (Change Pin) - изменяет штырек, к которому подключена ratline.  
� F6 (Unroute trace) – Отменить разводку любых разведённых сегментов в дорожке.  
� F8 (Delete Connect) – удалить подключение (от стартовой до конечной ножки) из 

соединения.  
� F9 (Recalc.Ratlines) - переназначают ratlines для соединения, для минимизации длины.  

o Segment: Это - строка, представляющая разведённый сегмент дорожки.  
� F1 (Set Width) - выскакивает диалог, который позволяет Вам устанавливать   ширину 

дорожки или соединения.  
� F2 (Change Layer) - изменяет слой сегмента.  
� F4 (Add Vertex) - вставляют вершину в сегмент и запускают перетаскивать ее.  
� F5 (Unroute Segment) – отменить разводку сегмента, преобразовав его в ratline.  
� F6 (Unroute Trace) – отменить разводку дорожки, преобразовав её в ratline.  
� F8 (Delete Connect) - удаляет подключение (от начальной до конечной точки) от 

соединения.  
� F9 (Recalc. Ratlines) - переназначает ratlines для сети, чтобы минимизировать их длину. 

o Vertex(Вершина): Это есть точка соединения двух сегментов, или сегмента и ratline. Если оба 
сегмента разведены на различных слоях, то вершиной будет переход.  

� F1 (Set Width) - выскакивает диалог, который позволяет Вам явно редактировать 
координаты X и Y. 

� F3 (Connect Pin) - запускает перетаскивание ratline, чтобы подключить вершину к штырьку 
для дорожки ответвления.  

� F4 (Move Vertex) – начинает перетаскивание вершины, чтобы переместить это.  
� F6 (Unroute Trace) – Отменить разводку дорожки.  
� F7 (Delete Vertex) – удалить вершину, отменить разводку смежных сегментов.  
� F8 (Delete Connect) - удалить подключение (от первого до последнего штырька).  
� F9 (Recalc. Ratlines) - переназначают ratlines для соединения, чтобы минимизировать их 

длину. 
� Branch Trace: Ответвление является дорожкой между вершиной другого дорожки и штырьком. Функции 

для ratlines, сегментов и вершин - те же самые, как для обычной дорожки. 



� Stub Trace: Обрубленная трасса начинается на контактной пложадке, но не заканчивается на контактной 
площадке. Это обычно заканчивается переходом, который используется, чтобы подключить трассу с 
полигоном на другом слое. Это может содержать ratlines, сегменты и вершина как обычная дорожка, но 
последний сегмент и последняя вершина обрабатываются особенно. 

o End Segment: Последний разведённый сегмент.  
� F1 (Set Width) - вызывает диалог, который позволяет Вам устанавливать изменение 

ширины дорожки и перехода дорожки или соединения. 
� F2 (Change Layer) – изменяет слой сегмента.  
� F4 (Add Vertex) - вставляет вершину в сегмент и запускает перетаскивание ее.  
� F5 (Unroute Segment) – отменить разводку сегмента, преобразовав его в ratline.  
� F6 (Unroute Trace) – отменить разводку дорожки, преобразовав её в ratline.  
� F7 (Delete Segment) – удалить сегмент.  
� F8 (Delete Connect) – удалить обрубленную трассу целиком.  
� F9 (Recalc. Ratlines) - переназначает ratlines для соединения, чтобы минимизировать их 

длину.  
o End Vertex: Последняя вершина (то есть оконечная точка обрубленной дорожки).  

� F1 (Set Position) - вызывает диалог, который позволяет Вам явно редактировать 
координаты вершины X и Y. 

� F2 (Add Segment) – запустить перетаскивание нового сегмента, чтобы расширить 
обрудленную дорожку.  

� F3 (Add/Delete Via) – добавить или удалить переход в конце обрубленной дорожки.  
� F4 (Move Vertex) – начать тащить конечную вершину, чтобы двигаться.  
� F5 (Add/Delete Via) - добавить/удалить переход.  
� F7 (Delete Vertex) - удалить вершину.  
� F8 (Delete Connerct) – удалить целиком обрубленную дорожку.  
� F9 (Recalc. Ratlines) - переназначить ratlines для соединения, чтобы минимизировать их 

длину. 
 

� Copper Area: Это замкнутая ломаная линия, которая определяет область твердой или сформированной  
меди на одном из слоёв меди. Это используется для создания земли, охлаждения и т.д. Это состоит из ряда 
углов со сторонами между углами. Это заполнено шаблоном штриховки диагональных строк. Отметьте, 
что этот шаблон штриховки для визуальной идентификации области только, и не представляет 
фактический медный шаблон, который будет применен к PCB. Это может также содержать вырезы 
(cutouts), которые являются "отверстиями" в полигоне. Вырезы редактируются так же как полигоны.  

o Corner:  
� F1 (Set Position) - вызывает диалог, чтобы установить угловую позицию явно.  
� F4 (Move Corner) - запускает перетаскивать угол, чтобы переместить это.  
� F5 (Delete Corner) - удаляет угол.  
� F7 (Add Cutout) - запускает тянуть новый полигон для выреза в полигоне.  
� F8 (Delete Area) - удаляет всю область.  

o Side:  
� F1 (Straight line) - если сторона есть дуга, преобразовать в прямую линию.  
� F2 (Arc (CW)) - преобразовать сторону, чтобы по часовой стрелке образовать дугу.  
� F3 (Arc (CCW)) - преобразовать сторону, чтобы против часовой стрелки образовать дугу. 
� F4 (Add Corner) - добавить новый угол и запустить его перетаскивание.  
� F7 (Add Cutout) - запускает тянуть новый полигон для выреза в полигоне.  
� F8 (Delete Area) - удалить весь полигон. 



� Text String: Это - строка алфавитно-цифровых символов, используемых для того, чтобы добавлять 
пометки, объявления об авторском праве и т.д. Это может быть помещено на шелкографии или медном 
слое. 

o F1 (Edit Text) - выскакивает диалог, чтобы редактировать строку и ее свойства, такие как размер и 
ширина штриха. 

o F4 (Move Text) - запускает перетаскивание строки, чтобы переместить это.  
o F8 (Delete Text) - удалить всю строку. 

 
� Solder Mask Cutout: Это - замкнутая ломаная линия, которая определяет вырез в слое маски припоя.  

o Corner:  
� F1 (Set Position) - выскакивает диалог, чтобы явно установить угловую позицию.  
� F4 (Move Corner) - запускает перетаскивать угол, чтобы переместить это.  
� F5 (Delete Corner) - удаляет угол.  
� F8 (Delete Area) - удалить вырез полностью.  

o Side:  
� F1 (Straight Line) - делает сторону прямой линией.  
� F2 (Arc CW) - делает сторону дугой по часовой стрелке.  
� F3 (Arc CCW) - делает сторону дугой против часовой стрелки.  
� F4 (Add Corner) - добавляет новый угол и запускает его перетаскивание.  
� F8 (Delete Area) – удалить вырез полностью. 

 
5.9.2 Группы Элементов  
Группы элементов могут быть выбраны рисованием прямоугольника вокруг них с помощью мышки. Все элементы 
в группе будут подсвечены. Индивидуальные элементы могут быть добавлены к группе или удалены от группы, 
нажимая на них с удержанной клавишей CTRL. Операция, которая может быть выполнена на группах: 

� F4 (Move Group) – стартует перемещение группы 
� F8 (Delete Group) - удаляют группу из проекта  
� ctrl-C – копировать группу в буфер обмена 
� ctrl-X – копировать группу в буфер обмена и удаление её из проекта 

 
5.9.3 Перемещение элементов или групп клавишами курсора  
Когда элемент или группа выбраны, Вы можете переместить их, выбирая операцию перемещения  
функциональными клавишами или меню контекста, и затем перетаскивая это с мышью. Большинство элементов и 
групп могут также быть перемещены, нажимая клавиши курсора на клавиатуре. Нажим клавиши курсора 
переместит элемент или группирует расстояние, равное текущему урегулированию архитектуры размещения или 
маршрутизации архитектуры, в зависимости от выбранного элемента. Меньшие движения могут быть сделаны, 
удерживая Клавишу SHIFT, нажимая клавишу курсора, которая переместит элемент 1 mil или 0.01 MMS, в 
зависимости от модулей в использовании. 



5.10 Контур платы (Board Outline) 
Контур платы представляет границу PCB. В FreePCB это состоит из замкнутой ломаной линии (closed polyline) 
(или полигон (polygon)) состоящей из 3 или более сторон, с углами между сторонами. Стороны могут быть 
сегментами прямой линии или дугами (arcs). Дуга - один квадрант эллипса, главная ось которого параллельна или 
x или y. Преимущество использования этого ограниченного определения дуги состоит в том, что дуга полностью 
определена позицией ее оконечных точек и направления, которое может быть по часовой стрелке или против 
часовой стрелки. Типовую схему платы, состоящую из 10 углов и 10 сторон, показывают ниже. Отметьте, что две 
из сторон - дуги.  
В проекте может быть больше чем один контур платы. 
 

 
 
Контур платы можно создать выбрав Add > Board Outline. Курсор изменится в перекрестие. Поместите стартовый 
угол левым кликом мышки. Вы затем обнаружите сами резиновую линию, которая тянется за курсором. Повторным 
левым кликом мышки отметьте второй угол, и Вы будете создавать вторую сторону методом резиновой нити. 
Продолжите, пока Вы не поместили последний угол, затем щелкаете правой кнопкой мыши, чтобы замкнуть 
ломаную линию, отодвигая сторону к стартовому углу.  
Рисуя Вы можете изменить стиль (style) текущей стороны от прямой линии до дуги при использовании 
соответствующих функциональных клавиш (F1 для прямой линии, F2 для дуги по часовой стрелке и F3 для дуги 
против часовой стрелки). Стиль, который Вы выбираете, останется в силе, пока Вы не измените его. Отметьте, что 
дуги становятся прямыми линиями, если оконечные точки являются вертикальными или горизонтальными. 
Размещение углов будет управляться сеткой размещения, которая должна быть установлена в соответствующее 
значение прежде, чем начать рисовать контур платы. Размещение будет также управляться углом излома. Если угол 
излома будет 45 степенями, то дуги будут квадрантами круга. 



Как только контур платы был создан, Вы можете редактировать его следующими способами: 
� Вы можете снова установить угол, кликнув по нему, чтобы выбрать новое значение. Маленький белый 

квадрат появится вокруг угла, указывая, что он был выбран, и строка состояния, укажет, какой угол был 
выбран. Тогда нажмите F4 ("Move Corner (Перемещение Угла)"), чтобы запустить перетаскивание угла к 
новой позиции. 

 
Или нажмите F1 ("Set Position (Установка позиции)"), чтобы выскочил диалог, 
который позволит Вам устанавливать позицию угла явно, как показано ниже: 
 
  
 
 
 
 
 
 
 
 

� Вы можете добавить угол, нажимая на сторону, чтобы выбрать это. Это побелеет, чтобы указать, что это 
было выбранно. Тогда нажмите F4 ("Add Corner (Добавить Угол)"), и Вы будете перетаскивать новый угол, 
с резиновыми сторонами к смежным углам. Левым кликом, поместите это. Это только работает с прямыми 
сторонами, так, если сторона - дуга тогда, Вы должны будете изменить ее сначала на прямую линию (см. 
ниже). 

� Вы можете удалить угол, выбирая это, и нажимая F5 ("Delete Corner (Удалить Угол)"). Угол исчезнет, и 
смежные стороны будут заменены одной стороной между смежными углами. 

� Вы можете изменить стиль стороны, выбрав это и затем нажимая F1 (Straight Line (Прямая линия)), F2 ( 
("Arc CW (Дуга по часовой стрелке)") или F3 ("Arc CCW (дуга против часовой стрелки)"). 

� Вся контурная линия платы может быть удалена, выбором любой стороны или угла, и нажимая F8 ("Delete 
Outline (Удаляют Схему)"). 



5.11 Корпуса 
5.11.1 Анатомия корпусов 
Каждый PCB включает один или более корпусов. Каждый корпус содержит следующие элементы: 

• Reference designator (позиционное обозначение), такой как "U1" - которые обычно назначают в 
схематической диаграмме, и должны быть уникальными. 

• Package identifier (идентификатор упаковки), такой как "DIP14" – Корпуса входят в различные 
физические упаковки, и PCB проектировщик должен знать, какая упаковка будет использоваться для 
каждой корпуса, потому что это определит отпечаток (footprint) для корпуса в PCB размещении. 

• Pins (Штырьки) - электрические выводы корпуса называют штырьками, даже когда они – являются не 
штырьковыми выводами, такой как проволочные выводы, наконечники, и т.д. Штырьки 
идентифицированы названием (который обычно является числом), которое приложено к позиционному 
обозначению, такому как "U1.4" для штырька четыре на корпусе U1. Путь наименования штырьков будет 
зависеть от корпуса. Все штырьки нужно назвать, даже взаимозаменяемые штырьки, такие как у  
резистора. 

• Mounting holes – Монтажные отверстия могут использоваться, чтобы прикрепить корпуса к PCB. 
Застежка, такая как машинный винт можно передать через отверстие, или корпус может иметь встроенные 
застежки, такие как посты pressfit или паянные наконечники. Монтажные отверстия могут быть 
изолированными, или могут иметь контактную площадку и быть покрыты металлом. Весьма обычно 
использовать покрытый металлом монтажных отверстий, чтобы сделать подключение электрической цепи 
к корпусу, такой как заземление на экран соединителя. Поэтому, FreePCB обрабатывает все отверстия 
установки как штырьки. Названия штырька, назначенные монтажным отверстиям, обычно являются 
числами, которые выше чем числа, используемые для обычных штырьков. Например, 9-ти штырьковый 
соединитель D-SUB с 2 монтажными отверстиями имел бы штырьки номер 10 и 11 назначенными на 
монтажные отверстия. 

• Footprint (Отпечаток) - Это шаблон медных контактных площадок и других элементов, которые станут 
частью PCB размещения.  

 
Фактически, когда мы используем термин "корпус" во время схемы размещения PCB, мы обычно обращаемся к 
отпечатку корпуса, потому что это - то, с чем мы работаем в схеме размещения. Фактический корпус - 
электронный компонент, который будет припаян к отпечатку, когда PCB будет транслирован. 



Отпечатки имеют следующие элементы: 
 

• Pads (контактные площадки) - Это медные элементы, к которым подпаиваются штырьки. Существует 
два типа:  

o  Контактные площадки с отверстием (Through-hole pads) имеют отверстия, через которые 
проходят штырьки выводных компонентов перед спаиванием. Для контактной площадки с 
отверстием  на многослойной плате обычно имеются площадки на каждом медном слое, которые 
соединённые вместе образуют сплошную металлизацию отверстия. Такое расположение называют 
стеком контактных площадок (padstack). Контактные площадки с отверстием обычно бывают 
круглыми или квадратными. Общее расположение должно использовать квадратную контактную 
площадку для штырька 1 и круглые клавиатуры для остальных штырьков. 

o Площадки для поверхностного монтажа (Surface-mount pads) не имеют отверстия, и находятся 
только на одном уровне. Однако, они все еще представлены стеком контактных площадок,  хотя 
это довольно простой стек, только с одной площадкой. Площадки SMD почти всегда являются  
прямоугольными. 

• Контур корпуса (part outline) - Это графическое представление корпуса на слое шелкографии.  
• Позиционное обозначение (reference text) - Это текстовая строка для позиционного обозначения на слое 

шелкографии.  
• Другой текст (other text) - Текстовые строки, такие как номера штырьков, и т.д. Может быть добавлен к 

слою шелкографии.  
• Прямоугольник выбора (selection rectangle) - Это невидимо, пока корпус не выбран, тогда это показывают 

в цветном слое выбора (обычно белый). Это определяет границу корпуса в целях выбора. 
• Начало координат (origin)- Это невидимая точка, который служит началом координат для внутренней 

системы координат отпечатка. Когда отпечаток будет создан, позиция каждого элемента будет определена 
относительно начала координат. Когда отпечаток перетаскивается во время редактирования, он будет 
"прикреплен (attached)" к курсору в начале координат. Когда о позиция корпуса сообщена в строке 
состояния или в диалогах, это - фактически позиция начала координат, о котором сообщают. Центр 
штырька 1 часто используется как начало координат. 



Некоторые типичные отпечатки показаны ниже. 
 

 
 
В скриншоте выше, U1 есть IC в 20-ти штырьковой DIP упаковке, имеющей контактные площадки с отверстиями. 
Это было помещено в верхнюю (или компонент) сторона платы, таким образом элементы шелкового экрана 
отпечатка находятся на верхнем слое шелкографии. Это было выбрано для редактирования, таким образом этот 
выбранный  прямоугольник видим. Так как верхний медный слой является активным слоем разводки, его верхние 
площадки показаны в цвете верхнего медного слоя.  
U2 есть IC в 20-ти штырьковом корпусе PLCC для поверхностного монтажа, также на верхней стороне платы. Его 
контактные площадки оттянуты в цвете для верхнего медного слоя. C10 является SMD конденсатором в 
миниатюрной упаковке. R12 является SMD резистором в отличной миниатюрной упаковке, на нижней (сторона 
паек) стороне PCB. Его контактные площадки оттянуты в цвете нижнего медного слоя, и его элементы шелкового 
экрана оттянуты на нижнем слое шелкового экрана. Кроме того, его позиционное обозначение оттянуто как 
зеркальное отображение, так, чтобы это было читаемо с нижней стороны платы.  
 
5.11.2 Список корпусов (Partlist)  
 
В FreePCB, все корпуса в проекте содержатся в структуре данных, названной partlist, который пуст, когда проект 
начинает создаваться. Обычно, части добавляются к partlist импортированием списка соединений (netlist file) из 
редактора схемы. Это будет покрыто в  Части 5.14: Импортирование Файлов Списка соединений. Вы можете 
рассмотреть или редактировать partlist, выбрав Parts...  из меню Project, которое вызывает диалог View/Edit Part 
List, как показано ниже. 
 
 



 
 
Каждый корпус в проекте перечислен через позиционное обозначение, упаковку и отпечаток. Отдельные корпуса 
можно выбрать из списка, кликая по ним, или множественные части могут быть выбраны, кликая с удержанной 
клавишей CTRL. partlist может быть изменен, используя Add New Part, Edit Selection, и кнопок Delete 
Selection(s). Они будут описаны в следующих разделах.  
Важное примечание: Вы должны быть внимательными, изменяя partlist, по двум причинам. 

• Если Вы работаете из схемы, редактирование partlist может ввести несоответствия между схемой и PCB. 
Это не должно быть проблемой, если Вы только назначаете отпечатки, но может внести большую 
путаницу, если Вы добавляете или удаляете корпуса или изменяете позиционные обозначения. Если Вы 
действительно производите какие-нибудь изменения как эти, Вы должны отразить их обратно в схему 
(back-annotate). 

• Как только Вы нажимаете OK в диалоге View/Edit Part List, изменения, которые Вы производили, не могут 
быть уничтожены функцией Undo от меню Edit. Поэтому, Вы должны вероятно сохранить копию своего 
проекта заранее. 



5.11.3 Редактирование корпусов (Editing Parts) 
Корпуса могут быть добавлены, удалены или изменены при помощи диалога View/Edit Part List (показано выше) 
или окна размещения, используя методы, описанные ниже. 

• Новые корпуса могут быть добавлены к partlist, используя или выбор Part из меню Add, или кнопку Add 
New Part в диалоге View/Edit Part List. Любой метод вызывает Add/Edit Part диалог, показанный ниже 

 

 
 



o Новый корпус создан, вводя позиционное обозначение в поле Reference, и выбрав отпечаток из 
большого дерева управления, который занимает левую сторону диалога. Это управление содержит 
список всех файлов в выбранной библиотечной папке. Вы можете изменить библиотечные папки, 
используя кнопку Browse... Есть также вход для "локального кэша (local cache)", который 
содержит все отпечатки, которые уже загружены в проект. Вы можете развернуть библиотеку, 
нажимая "+" рядом с этим. В примере выше, библиотека C:\FreePCB\lib\sm_plcc.fpl развёрнута. 
Отпечаток "LCC-24" был выбран и показан в области окна предварительного просмотра. Его имя 
было автоматически введено в поле Footprint диалога. Альтернативно, Вы можете только 
напечатать название отпечатка непосредственно в это поле. 

o Если Вы оставите Position радио кнопку установленной в  с Drag to position, Вы переместите 
новый корпус, когда Вы нажмете OK. Если Вы хотите позиционировать компонент явно, Вы 
можете использовать радио кнопку Set position и X, Y, Angle и Side поля в блоке Position. Тогда, 
когда Вы нажимаете OK, новый корпус будет помещен в позицию, которую Вы устанавили. Если 
Вы выберете Offboard, то часть будет помещена слева от начала координат (origin). 

 
• Корпуса могут быть удалены или отредактированы из окна размещения, выбирая их, и используя 

функциональную клавишу или контекстное меню. С выбранным корпусом следующие пункты меню 
доступны: 

o F1 ("Edit Part") - это вызывает диалог Add/Edit Part, который показан ранее, за исключением 
того, что поля Reference и Footprint заполнены. Вы можете использовать этот диалог, чтобы 
изменить отпечаток или позицию корпуса.  

o F3 ("Glue Part") - это "приклеивает (glues)" корпус на месте так, чтобы он не мог быть случайно 
перемещенным, не "отклеивая" это. Для корпуса, которая уже приклеен, эта команда изменяется, 
чтобы "Отклеить корпус (Unglue Part)".  

o F4 ("Move Part") – это обычно используемая команда. Она инициализирует перемещение корпуса 
с курсором. Затем левым кликом можно закрепить корпус в новой позиции. Во время 
перемещения, следующие функциональные клавиши являются активными: 

� F2 ("Change Side") – переключает компонент из верхней стороны в нижнюю, или 
наоборот  

� F3 ("Rotate Part") - выполняют 90 градусное вращение корпуса по частовой стрелке 
o F7 ("Delete part") - это удаляет корпус из partlist. Вас спросят, желаете ли Вы также удалить все 

ссылки на корпус из списка соединений. Обычно Вы были бы ответ "Да", если Вы не думаете, что 
Вы могли бы добавить часть назад в более позднее время.  

o F8 ("Recalc. Ratlines") - это повторно вычисляет ratlines для всех соединений, подключенных с 
корпусом, чтобы минимизировать их длину. По умолчанию, эта команда выполняется 
автоматически каждый раз, когда корпус перемещен. 



• Корпуса могут также быть удалены или отредактированы с помощью диалога View/Edit Part List, 
следующим образом. 

o Вы можете удалить одну или более корпусов из списка, кликая на них (для множественного 
выбора нужно удерживать в нажатом состоянии клавишу CTRL), и затем нажать кнопку Delete 
Selection(s). Ссылки на корпус (а) не будут удалены из списка соединений.  

o Единственный корпус может быть отредактирован, используя кнопку Edit Selection, которая 
вызывает диалог Add/Edit Part, который показали ранее. Главная причина для использования 
диалога View/Edit Part List, чтобы редактировать корпуса, вместо того, чтобы только выбрать их в 
окне размещения и использовать меню функциональной клавиши, состоит в том, чтобы назначить 
отпечатки на корпуса, у которых их уже нет. Корпус без отпечатка не может быть отображен, 
таким образом он не может быть выбрана в окне размещения. Эта ситуация часто возникает, при 
импортировании файлы списка соединений, как говорилось в Части 5.14: Импортирование Файлов 
Списка соединений. 

 
5.11.4 Перемещение или изменение размеров позиционного 
обозначения  
 
Позиционное обозначение для корпуса можно переместить, 
выбирав его и нажав F4 ("Move Ref Tex"). Затем Вы можете 
перетащить его к новой позиции. Перемещаясь, его можно 
вращать на 90 градусов по часовой стрелке, нажимая F3 ("Rotate 
Ref Text").  
Вы можете изменить размер текстовой строки, выбрав её и 
нажимая F1 ("Set Size"). Это вызывает диалог, показанный ниже. 
Вы можете изменить высоту символа и штриховую ширину. 
Если Вы выберете Use default for height, то штриховая ширина 
будет автоматически установлена в 1/10 высоты. 
 
 
 
 
 
 

 
 
5.11.5 Создание невидимого позиционного обозначения  
 
Если Вы устанавливаете символьную высоту позиционного текста к "0", позиционное обозначение станет 
невидимым. Чтобы сделать его снова видимым, выберите корпус и щелкните правой кнопкой мыши, затем 
выберите Set Ref. Text Size из меню контекста, которое появится. Затем установите символьную высоту в 
ненулевое значение. 
 



5.12 Монтажные отверстия  
Монтажные отверстия используются, чтобы прикрепить PCB к внешней структуре, такой как скобка или корпус. В 
FreePCB монтажное отверстие есть корпус, который состоит из единственного штырька через отверстие. padstack 
для штырька может включать площадки, которые могут использоваться, чтобы подключить монтажное отверстие к 
соединению, точно так же как любой другой штырек. Фактическое отверстие в padstack будет показано в цвете для 
слоя сверловки. Если у монтажного отверстия будут площадки, то их покажут в цвете для их медного слоя.  
Так как монтажное отверстие есть корпус, оно может быть добавлено к partlist как любой другой корпус. Оно 
может быть включено в файл списка соединений, или оно может быть добавлено, используя Add > Part или Project 
> Parts... пункты меню. Некоторые монтажные отверстия различных размеров включены в библиотечный файл 
th_mounting_hole.fpl.  
Примеры монтажных отверстий показаны ниже. H5 не является площадкой, а у H6 есть круглая площадка и у H7 
есть квадратная площадка. 

 
 
Используя мышь, чтобы выбрать монтажное отверстие, Вы можете выбрать или корпус или штырек. Вы выбрали 
бы корпус, если бы Вы хотели, например, его переместить, в то время как Вы выбрали бы штырек, чтобы добавить 
подключение к соединению. Прямоугольники выбора для корпуса и штырька - почти одинакового размера. Так как 
у штырька есть приоритет, Вы сначала выберете его, когда Вы нажмете на это. Вы должны щелкнуть еще раз, 
чтобы выбрать корпус. Вы можете сказать, выбрали ли Вы штырек или корпусь, смотря на прямоугольник выбора 
или проверяя строку состояния. Для примера ниже, на левое изображении показан выбранный штырек H6. Правое 
изображение показан выбранный корпус для H6, после щелкания еще раз. 
 

 
Выбрана площадка                                                                                    Выбран корпус 

 
Выбор позиционного обозначения для монтажного отверстия может быть трудным, если оно наложится на 
площадку или отверстие для штырька, то начиная с нажатия на это мышью выберет или штырек или корпус. Чтобы 
обойти это, Вы можете использовать маску выбора, чтобы отключить выбор корпусов и/или штырьков.  
Так как позиционное обозначение монтажного отверстия не очень полезно, Вы можете хотеть сделать его 
невидимыми, выбирая и его и использующий F1 ("Set Size"), чтобы обнулить высоту символов. Вы можете также 
установить символьную высоту, выбирая корпус и используя Set Ref. Text Size из правой щелчка по меню, 
которое является, как Вы сделали позиционное обозначение видимым снова, если бы Вы хотели. 
 
 



5.13 Соединения, Ratlines и Разводка  
5.13.1 Соединения 
Соединение устанавливает штырьки, которые будут подключены вместе на PCB. У каждого соединения должно 
быть уникальное имя. Эти имя может быть описательным (таким как "GND" или "video_in") или просто 
отличительным (таким как "N06744"). В FreePCB название соединения ограничено по длине 40 символами, и может 
содержать специальные символы. Каждый штырек в соединении идентифицирован строкой, состоящей из 
позиционного обозначения корпуса, содержащего штырек, символа "." и имени штырька.  
Соединения обычно читаются от файла списка соединений, который также включает список корпусов в проекте 
(см. Часть 5.14: Импортирование Файлов Списка соединений). Два примера связей показаны ниже.  
Name: N00834 
Pins: U2.4 JP1.9  
 
Name: GND 
Pins: U2.7 C2.2 U3.3 C1.2 U1.19 Y1.4 JP5.3 JP4.10  
JP4.4 R2.2 C4.2 JP1.10 JP1.5 R1.2 C3.2 U1.8  
JP6.2 JP3.3 JP2.3 JP3.10 JP3.4 JP3.6 JP3.8 JP2.10  
JP2.8 JP2.2 JP2.4 JP2.6 JP3.2  
 
5.13.2 Список соединений  
 

В FreePCB, вся информация 
о соединениях хранится в 
структуре данных, названной 
списком соединений. Этот 
список может быть 
рассмотрен и изменен, 
выбирая Nets из меню 
Project. Это вызывает диалог 
View/Edit Netlist. 
Этот диалог содержит список 
всех связей в проекте. 
Название, число штырьков и 
заданная по умолчанию 
ширина дорожки, ширина 
перехода и диаметр 
отверстия перехода 
показывают для каждой сети.  
Переключатель рядом с 
каждым названием 
определяет видимость 
соединения. Если блок 
видимости 
неконтролируемый, то 
ratlines для этого соединения 
НЕ будет отображен в окне 
размещения. Это полезно, 
когда Вы работаете со 
специфическим соединением 
и не желаете быть 
отвлеченными с другим 

ratlines. Кнопка Make all visible/invisible проверок или непроверок всех блоков. 
 
 
 



В примере выше, ширина дорожки и перехода установлены в нуль для большинства связей. Это указывает, что по 
умолчанию должны использоваться проектные значения. Ширина для VCC и GND была установлена в ненулевое 
значения, которые будут использоваться для дорожек в этих соединениях. Ширину можно изменить, выбрав одну 
или более связей, и кликнув на кнопку Change widths. Это вызыает следующий диалог, который позволяет 
устанавливать новые ширины. 

 
Вы можете выполнить более обширное редактирование одиночного соединения, выбирая это и нажимая кнопку 
Edit selection, которая вызывает: 

 
Здесь Вы можете поменять имя, видимость и ширину соединения, и добавить или удалить штырьки. 
 



5.13.3 Ratlines  
Обычно, соединения будут направлены как серии дорожек, где каждый дорожка между 2 штырьками. Для любого 
соединеняи, содержащего больше чем 2 штырька, будут множественные способы, которыми можно развести 
соединение. Например, соединение, состоящая из штырьков U1.1, U2.2 и U3.3, может быть разведено как: 
 
(U1.1 к U2.2) и (U2.2 к U3.3) ИЛИ  
(U1.1 к U3.3) и (U2.2 к U3.3) ИЛИ  
(U1.1 к U3.3) и (U1.1 к U2.2) 
 
Для каждого соединения FreePCB автоматически генерирует ряд подключений, которые пытаются минимизировать  
полное расстояние между подключенными штырьками. Эти подключения показаны как ratlines между штырьками. 
Пример двух соединений, подключающих три корпуса, показан ниже. 
 

 
После большинства операций редактирования FreePCB повторно вычисляет ratlines для каждого затронутого 
соединения. Это является самым очевидным, когда Вы перемещаете части или добавляете медные области. 
Например, перемещение D1 вправо заставляет подключения изменяться, как показано ниже. 
 

 
Чтобы развести соединение, Вы можете выбрать каждую ratline и развести её как дорожку. Альтернативно, Вы 
можете игнорировать ratlines и направить трассы от штырька до штырька, используя обрубленные дорожки stub 
traces. Вы можете также использовать дорожки ответвления branching traces. Каждый из этих методов описан 
более подробно ниже.  



5.13.4 Изменение Ratlines  
Большую часть времени, Вы будете использовать ratlines, который вычисляет FreePCB. Однако, могут быть 
ситуации, когда Вы хотели бы больше контроля над ratlines. FreePCB обеспечивает несколько опций 
редактирования для ratlines: 

� ratline можно блокировать, выбрав её, и нажимая F3 ("Lock Connect"). Внешний вид ratline не изменится, но 
("L"), будет показывать, в его описании на строке состояния, что это блокировано. Блокированное 
подключение НЕ будет удалено, когда FreePCB повторно вычислит ratlines. Блокированное подключение 
может быть разблокировано, выбирав его, и нажимая F3 ("Unlock Connect"). 

� Подключение можно добавить к соединению, выбрав площадку для стартового штырька подключения, и 
нажав F4 ("Connect Pin"). Вы можете затем потянуть ratline к другому штырьку на той же самой 
соединении. Обычно, Вы должны блокировать ratline после добавления этого, иначе это будет вероятно 
удалено FreePCB в следующий раз, когда ratlines повторно вычислены. Вы можете также сделать 
подключение с отмененным штырьком, когда новый штырек будет добавлен к соединению. 

� ratline можно удалить из соединения, выбрав её, и нажав F7 ("Delete Connect"). Если ratline блокирован, Вы 
будете запрошены разблокировать это. Если Вы удалите ratline и не замените это, добавляя и блокируя 
другой, то это вероятно вновь появится в следующий раз, когда ratlines повторно вычислены. 

� ratlines для каждого соединения обычно повторно вычисляются после каждой операции редактирования, 
которая затрагивает соединение. Исключением являются те операции, которые непосредственно изменяют 
ratlines, такие как описанные выше. Чтобы вынудить FreePCB восстановить ratlines, нажмите F8 ("Recalc. 
Ratlines"). Область видимости этой команды зависит от того, кокой элемент был выбран, когда Вы нажали 
F8: 
� Если ничто не было выбрано, ratlines будет восстановлен для каждого соединения в проекте. 
� Если корпус был выбран, ratlines будет восстановлен для каждого соединения, прикрепленного к 

корпусу. 
� Если штырек, ratline, или дорожка были выбраны, ratlines будет восстановлен для соединения, 

прикрепленной к тому штырьку, ratline или дорожке. 
 
 
 



5.13.5 Разводка с Ratlines  
Этот метод состоит из преобразования ratlines в медные дорожки. Дорожки состоят из одного или более 
прямолинейных сегментов, подключенных вместе с вершиной в их точках подключения. Если два смежных 
сегмента будут на различных слоях, то переход будет помещен в вершину между ними.  
Чтобы начать разводку, выберите ratline, нажимая на неё. Она изменится на цвет выбора, чтобы указать, что была 
выбрана. Затем нажмите F4 ("Route Segment"). Вы начнёте сами тащить сегмент дорожки от штырька соединения 
которое есть радом с курсором когда вы нажали F4. Изображение ниже показывает сегмент, направляемый от 
штырька 1 из JP6.  

Отметьте, что сегмент находится на верхнем медном 
слое, потому что это был активный слой, когда мы 
запустили разводку. Вы можете изменить активный 
слой, нажимая одну из цифровых клавиш от "1" до 
"8", которые представляют доступные слои в порядке 
от верхнего до нижнего. Например, для платы с 
четырьмя слоями, "1" выбрала бы верхний медный 
слой, "2" выберет внутренний 1 слой, "3" выберет 
внутренний 2 слой, и "4" выберет нижний слой меди. 
Если Вы измените слои, разводя сегмент, то это 
немедленно переключится на новый активный 
уровень. В то время как сегмент перетаскивают, 
действуе сетка трассировки Routing Grid. Если 
стартовая точка для сегмента будет на сетке 
трассировки, то огол излома Snap Angle также будет 
действовать. 
 
 

 
 

 
Левый клик поместит вершину в позицию курсора, 
закончит первый сегмент в вершине, и 
инициализирует разводку второго сегмента от 
вершины, как показано в следующем изображении. 
Мы также переключили слои, нажав числовую 
клавишу "4", так, чтобы новый сегмент был 
оперенесён на нижний слой меди. 
 
 
 



Левый-клик еще раз, чтобы поместить следующую 
вершину и запустить разводку следующего сегмента. Таким 
образом Вы можете потянуть дорожку, состоящую из 
подключенных многих сегментов на многих слоях. 
Изображение слева показывает нашу завершенную 
разводку дорожки с несколькими сегментами на различных 
слоях, с 2 переходами. 
 
 
 
 
 
 
 
 
 

 
 

Чтобы закончить дорожку, нажмите F4 ("Complete 
Segment"), разведя последний сегмент. Сегмент будет 
автоматически расширен на конечный штырек дорожки. 
Альтернативно, Вы можете поместить курсор по 
конечному штырьку и сделать левый клик. Наша 
окончательная трасса показана слева. 
 
 
 
 
 
 
 
 
 
 

Пока разводите дорожку, Вы можете щелкнуть правой кнопкой мыши, чтобы прекратить разводку прежде, чем 
дорожка будет закончена. Неразведённая часть подключения будет показана как ratline между последней вершиной 
и конечным штырьком. Вы можете закончить дорожку позже, выбирая ratline и разводя её с любого конца. У 
дорожки могут быть множественные неразведённые части, как показано ниже. 

 
 
Вы можете изменить конечный штырек частично неразведённой дорожки, выбирая ratline к штырьку и нажимая F5 



("Change Pin"), затем рисуя новую ratline к другому штырьку. 
5.13.6 Удаление  
5.13.7 Разводка обрубленных дорожек (Stub Traces) 
Помимо дорожек, основанных на подключениях между штырьками, FreePCB поддерживает обубленные дорожки. 
Это дорожки, которые начинаются в штырьке, но не заканчиваются в штырьке. Вместо этого они заканчивают 
вслепую, обычно с переходом. Обрубленные дорожки главным образом используются, чтобы подключить штырьки 
SMT с медными областями, которые будут описаны в Части 5.15: Медные Области. Чтобы создать обрубленную 
дорожку, выберите стартовый штырек. Нажмите F3 ("Start Stub"), чтобы запустить перетаскивать сегмент дорожки 
от штырька. Сегмент будет на текущем активном слое, если штырек не будет штырьком SMT, в которомслучае  
активный слой изменится на слой штырька. При помощи левого-клика разместим вершину. Если Вы хотите больше 
чем один сегмент, добавьте дополнительную вершину. Затем закончите обрубленную дорожку, щелкая правой 
кнопкой мыши. Дорожка закончится в последней вершине, которую Вы поместили, и переход будет добавлен в 
вершине. Если Вы не хотите переход, выберите его и нажмите F3 ("Delete Via"). Если переход пройдет через 
медную область на той же самой соединении как стартовый штырек, то тепловое облегчение будет помещено, 
чтобы соединить переход с медной областью. Пример обрубленной дорожки, подключающего штырек с медной 
областью, показан ниже. Тепловое облегчение представлено "X" продвинутый на переход в цвете ratline. 
 

 
Обрубленные дорожки могут также использоваться для разводки между штырьками. Стартуйте разводку 
обрубленной дорожки от штырька как описано выше. Вместо того, чтобы закончить дорожку, щелкая правой 
кнопкой мыши, направьте дорожку к штырьку, который находится на том же самом соединении, или не 
назначенному ни на какое соединение. Когда Вы поместите оконечную точку сегмента где-нибудь на штырьке, 
обрубленная дорожка будет автоматически преобразована в нормальную дорожку между штырьками. Это может 
быть очень полезно, если Вы проектируете PCB "на лету", без списка соединений. 
 
 
 



5.13.8 Разводка ответвления от дорожки (Branching Trace) 
Как только Вы создали дорожку, ответвление дорожки можно добавить к ней, которое подключает дорожку с 
другими штырьками. Н примере показанном ниже изображена основная дорожка между штырьками с обоих концов 
JP3, и ответвление между средним штырьком и вершиной в основной дорожке. 
 

 
Есть два способа добавить ответвление дорожки. Первый метод выбирает вершину в дорожке и нажать F3 
("Connect PIN"). Затем потяните ratline от вершины до штырька, который Вы хотите добавить, и разведите ratline 
как обычно. Второй метод должен развести обрубленную дорожку от штырька до вершины.  
Обратите внимание, что нет никаких видимых различий между основной дорожкой и дорожкой ответвления. 
Однако, будут различия в некоторых операциях редактирования. Например, если Вы удалите дорожку ответвления 
тогда, то основная дорожка останется, но если Вы удалите основную дорожку, то исчезнут обе дорожки. Вы 
должны помнить это, когда создаёте дорожку ответвления, которую Вы могли бы хотеть изменить позже.  
Вы можете отличать независимые сегменты и вершина на основной дорожке или ответвлении, выбирая их и смотря 
на строку состояния. Основная дорожка между штырьками будет описан как дорожка (trace), в то время как 
дорожка перехода будет описан как переход (branch). Вершина, к которой подключено ответвление, называют 
"целевой вершиной (tee-vertex)". Если Вы выберете целевую вершину, то отображение строки состояния 
закончится параметром, таким как ("T1234"), где "T" указывает, что целевая вершина и "1234" является 
идентификатором для цели. Дорожки ответвления, которые соединяются с этой целью, покажут тот же самый 
параметр в строке состояния.  
Помимо дорожек между штырьками, ответвления могут быть добавлены к обрубленным дорожкам и даже к другим 
дорожкам ответвления. 
 
 
 



5.13.9 Переходы (Vias) 
Переходы используются, чтобы подключить медные элементы на различных слоях. В FreePCB они считаются 
частью дорожки, и могут появиться только в вершине дорожки. Переходы могут быть вынужденными forced или 
добровольными unforcsd. Добровольный переход генерируется автоматически, во время разводки дорожки. Это, 
будет происходить, всякий раз, когда необходимо будет подключить сегменты дорожки на разных слоях, и 
исчезнет, если дорожка будет изменен так, чтобы в этом больше не будет необходимо. Обычно, это - поведение, 
которое Вы будете хотеть. Однако, бывают моменты, когда Вы хотели бы наличие переходов, когда смежные 
сегменты дорожки находятся на том же самом слое. Например, Вы могли бы с помощью переходов подключить 
дорожку с медной областью. В этом случае, Вы можете "вызвать" переход, выбирая вершину и нажимая "f" 
клавишу. Принудительный переход не будет удален автоматически. Вам могут сказать, если переход вызван, 
выбирая его и смотря на строку состояния, которая покажет ("F") для вынужденного перехода. Вынужденный 
переход можно сделать добровольным, нажимая "u" клавишу. Имейте в виду, что переходы, которые созданы 
автоматически в конце обрубленных дорожек, вынужденные по умолчанию.  
Когда переходы созданы, значения по умолчанию будут использоваться для диаметров контактных площадок и 
отверстий. Они будут значениями по умолчанию для соединения, или если они не были определенны, тогда 
проектные значения по умолчанию будут использоваться. Размеры площадки и отверстия для переходов могут 
быть изменены, используя лиалог Set Trace and/or Via Widths, который описан в следующем разделе. 
 
 



5.13.10 Изменение дорожек 
Дорожки могут быть изменены, выбирая сегменты, вершины или ratlines и используя команды функциональных 
клавиш. Вы можете выбрать всю дорожку, кликая на сегмент или вершину, удерживая "t" клавишу. Вы можете 
выбрать всё соединение, нажимая на сегмент, вершину или штырек, удерживая "n" клавишу.  
Вот описания команд функциональной клавиши: 

� С выбранной ratline: 
� F1 (Set Width) — появляется диалог Set Trace and Via Widths, который описан ниже. 
� F3 (Lock/Unlock Connect) - блокируют или разблокировали ratline. Блокированный ratline не может 

быть устраненной опрерацией "Recalc. Ratlines". 
� F4 (Route Segment) — стартует перетаскивание оконечной точки разводимого сегмента, чтобы 

заменить ratline. 
� F5 (Change Pin) - это доступно только если у Вас есть выбранный ratline соединение частично 

разведённой дорожки к штырьку. Это позволяет Вам изменять штырек, с которым соединяется ratline. 
� F7 (Delete Connect) - удаляет подключение из соединения.  
� F8 (Recalc. Ratlines) - повторно вычисляют ratlines для сети, чтобы минимизировать их длину. 

 
� Пока разводится сегмент:  

� F4 (Complete Segment) - расширяет сегмент на оконечную точку ratline, и прекращает разводку. 
 

� С выбранным медным сегментом: 
� F1 (Set Width) — вызывает диалог Set Trace and Via Widths, который описан ниже. 
� F2 (Change Layer) — вызывает диалог, который позволяет Вам изменять слой сегмента, дорожки или 

соединения. F5 (Unroute Segment) — отменяет разводку сегмента, превращая его в ratline. 
� F6 (Unroute Trace) — отменяет разводку дорожки, превращая её в ratline. 
� F7 (Delete Connect) - удаляет подключение от соединения. 
� F8 (Recalc. Ratlines) - повторно вычисляет ratlines для соединения, чтобы минимизировать их длину. 

 
� С выбранной вершиной: 

� F1 (Set Position) — вызывает диалог, который позволяет Вам явно редактировать координаты X и Y 
вершины.  

� F4 (Move Vertex) — стартует перетаскивание вершины, чтобы переместить её.  
� F5 (Delete Vertex) — удаляет вершину, отменяя разводку смежных сегментов и преобразуя их в ratline.  
� F6 (Unroute Trace) — отменяет разводку дорожки, преобразуя её в ratline.  
� F7 (Delete Connect) - удаляет подключение от соединения.  
� F8 (Recalc. Ratlines) - повторно вычисляет ratlines для соединения, чтобы минизировать их длину. 

 
�  С конечной вершиной выбранной обрубленной дорожки: 

� F1 (Set position) — вызывает диалог, который позволяет Вам явно редактировать координаты X и Y 
вершины.  

� F2 (Add Segment) — стартует перетаскивание нового сегмента от вершины.  
� F3 (Add/Delete Via) - добавляет переход, или удаляет один, который уже присутствует.  
� F4 (Move Vertex) — стартует перетаскивание вершины, чтобы переместить её.  
� F5 (Delete Vertex) - удаляет вершину, отменяет разводку смежных сегментов, преобразуя их в ratline.  
� F7 (Delete Connect) - удаляет всю обрубленную дорожку. 
� F8 (Recalc. Ratlines) - повторно вычисляет ratlines для соединения, чтобы минимизировать их длину. 

 
 
 



� С полностью выбранной дорожкой: 
� F1 (Set Width) — вызывает диалог Set Trace and Via Widths, который описан ниже. 
� F2 (Change Layer) — вызывает диалог, который позволяет Вам изменять слой дорожки или 

соединения. 
� F6 (Unroute Trace) — отменяет разводку всей дорожки, преобразуя её в ratline. 
� F7 (Delete Connect) - удаляет подключение от соединения. 
� F8 (Recalc. Ratlines) - повторно вычисляет ratlines для соединения, чтобы минимизировать их длину. 

 
�  С всем выбранным ссоединением: 

� F1 (Set Width) — вызывает диалог Set Trace and Via Widths, который описан ниже.  
� F2 (Change Layer) - вызывает диалог, который позволяет Вам изменять слой соединения.  
� F3 (Edit Net) - добавляет переход, или удаляют один, который уже присутствует.  
� F8 (Recalc. Ratlines) - повторно вычисляют ratlines для соединения, чтобы минимизировать их длину. 

 
Диалог Set Trace and Via Widths, который вызван, нажатием F1 с соединением, дорожкой, сегментом или 
выбранной вершиной, показан ниже. 

 
 
Этот диалог позволяет Вам изменять размеры дорожки и перехода для сегмента, дорожки или соединения. Вы 
можете также установить новые размеры для соединение по умолчанию, так, чтобы они использовались для любого 
будущего разводимого соединения. 
 
5.13.11 Смена Штырьков (Swapping Pins) 
Вы можете поменять штырьки в корпусе, выбирая одного из них, удерживая "s" клавишу и нажимая на другой 
штырек. Вы будете запрошены поменять подключения со штырьками. 
 
 



5.14 Импорт Файлов Списка соединений  
5.14.1 Файлы Списка соединений  
После создания нового проекта, корпуса и соединения, могут быть добавлены к этому, импортируя файл списка 
соединений. Этот файл обычно производится схематическим редактором, но Вы можете создать его вручную в 
случае необходимости. Типовой файл списка соединений показан ниже. Этот файл будет использоваться позже в 
учебнике (см. Часть 7: Учебник). Это был произведено схематическим редактором Orcad Capture, в формате PADS-
PCB. Это - стандартный формат, и большинство схематических редакторов поддерживают его. Наиболее важно, 
FreePCB может читать это. 
 
*PADS-PCB*  
*PART*  
C1 CHIP_D  
C2 C1206  
C3 CHIP_B  
C4 CHIP_B  
D1 CHIP_B  
JP1 5X2HDR-100  
JP2 5X2HDR-100  
JP3 5X2HDR-100  
JP4 5X2HDR-100  
JP5 3X2HDR-100  
JP6 1X2HDR-100  
R1 C1206  
R2 C1206  
R3 C1206  
U1 28DIP300  
U2 dip14  
U3 К - 220  
Y1 8DIP300  
 
*NET*  
*SIGNAL* N00834  
U2.4 JP1.9  
*SIGNAL* GND  
U2.7 C2.2 U3.3 C1.2 U1.19 Y1.4 JP5.3 JP4.10  
JP4.4 R2.2 C4.2 JP1.10 JP1.5 R1.2 C3.2 U1.8  
JP6.2 JP3.3 JP2.3 JP3.10 JP3.4 JP3.6 JP3.8 JP2.10  
JP2.8 JP2.2 JP2.4 JP2.6 JP3.2  
*SIGNAL* N01846  
Y1.5 U1.9  
*SIGNAL* VCC  
U2.14 Y1.8 JP5.2 U3.2 C1.1 U1.20 JP1.8 JP1.3  
*SIGNAL* N02621  
U2.6 U1.21  
*SIGNAL* N02594  
U2.3 U1.22  
*SIGNAL* N02122  
JP2.1 U1.18  
*SIGNAL* N01526  
JP4.6 U1.15  
*SIGNAL* N01538  
JP4.8 U1.14  
*SIGNAL* N02277  
U1.17 JP3.1  
*SIGNAL* N00797  
JP1.4 U2.1  
*SIGNAL* N00534  
 



D1.1 JP6.1  
*SIGNAL* N01300  
U1.27 JP5.5  
*SIGNAL* N01342  
U1.28 JP5.4  
*SIGNAL* N01384  
JP5.1 U1.1  
*SIGNAL* N00809  
U2.5 JP1.7 U1.23  
*SIGNAL* N03791  
C3.1 R1.1 JP2.7 U1.3  
*SIGNAL* N01292  
U2.2 U1.24 JP1.2  
*SIGNAL* N03798  
C4.1 R2.1 JP3.7 U1.2  
*SIGNAL* N04614  
U1.13 JP3.5  
*SIGNAL* N04589  
JP2.5 U1.12  
*SIGNAL* N06956  
C2.1 U3.1 R3.2  
*SIGNAL* N07325  
R3.1 D1.2  
*END*  

 
Распечатка довольно очевидна. В *PART* секции файла есть строка для каждого корпуса, содержащая 
позиционное обозначение (такой как "U1") и идентификатор упаковки (такой как "28DIP300"). В *NET* секции 
каждая соединение начинается с ключевого слова *SIGNAL*, сопровождаемого названием соединения. Все 
штырьки в соединении затем перечислены на последующих строках.  
В порядке для FreePCB назначены отпечатки, идентификатор упаковки для каждого корпуса должены 
соответствовать отпечатку в одной из библиотек FreePCB. Пока нет никакого универсального стандарта для 
идентификаторов упаковки, Вы должны будете вероятно назначить им явно.  
В основном, есть 3 способа сделать это:  

1. В схематическом редакторе, назначьте идентификатор упаковки как атрибут для каждого корпуса, 
используя идентификаторы упаковки соответствующие отпечаткам FreePCB. Затем экспортируйте список 
соединений, и импортируйте его в FreePCB.  

2. Экспортируйте список соединений, редактируйте его используя редактор текста, и затем импортируйте его 
в FreePCB.  

3. Экспортируйте список соединений, импортируйте его в FreePCB, и затем установите любые неправильные 
или недостающие отпечатки в пределах FreePCB.  

 
Option 1 является определённо путь идти если вы думаете, что вы можете делать изменения в вашей схеме после 
вашего старта разводки платы, и хотите импортировать те изменения в FreePCB.  

 
Важное примечание: Для FreePCB, чтобы найти отпечатки, на которые ссылаются в файле списка соединений, 
библиотеки, содержащие те отпечатки, должны быть в заданной по умолчанию библиотечной папке для проекта 
(обычно..\lib). Если Вы используете отпечатки из библиотек в других папках, таких как..\lib_contrib или..\lib_extra, 
Вы должны переместить те библиотеки в.. .\lib прежде, чем импортировать файл списка соединений. Если Вы 
забываете делать это, Вы можете всегда назначить отпечатки позже, используя диалог Project > Parts... 
 
 



5.14.2 Импортирование Файлов Списка соединений в Проект  
Импортируем файл списка соединений, выбрав File > Import netlist.... Это вызовет следующий диалог. 
 

 
Выберите файл списка соединений, перемещаясь к правильной папке (в случае необходимости) и кликнув по имени 
файла. Я обычно перемещаю или копирую файл списка соединений в проектную папку прежде, чем импортировать 
это, но это не необходимо. Используя радио кнопки, Вы можете хотеть импортировать только части из файла, 
только соединения, или оба. Вы можете также выбрать формат файла (хотя в настоящее время только формат 
PADS-PCB поддержан). Затем нажмите OK. 
 
 
 



Если Вы импортируете файл списка соединений в пустой проект, без существующих корпусов или соединений, то 
файл немедленно загрузится. Иначе, появится диалог Import Options, как показано ниже. 
 

 
Этот диалог определяет, как FreePCB обрабатывает конфликты, которые могут возникнуть при импорте файла 
списка соединений в проект, который уже содержит корпуса и/или соединения. Эта ситуация обычно возникает, 
когда Вы используете схемный редактор. Например, предположите, что после импортирования Вашего начального 
списка соединений и расводки некоторых или всего PCB, Вы производите некоторые изменения в схеме и желаете 
импортировать те изменения. С настройки по умолчанию, показанные ниже, любые корпуса, отпечатки или 
соединения, который не соответствует новому файлу списка соединений, будут изменены или удалены, и проект 
будет точно соответствовать файлу списка соединений. Большую часть времени, это будет тем, что Вы хотите. 
Однако, предположите, что Вы добавили некоторые части к проекту (такие как монтажные отверстия, например), 
которые не находятся в Вашем файле списка соединений, и Вы подключили их к каким-то цепям. Затем Вы 
вероятно захотите выбрать For parts in project but not in netlist file: Keep parts and connections to nets (Для 
корпусов в проектк, но не в файле списка соединений: Сохранить корпуса и подключения к соединениям) 
с тем, чтобы Вы не потеряли эти корпуса и соединения. Или, если бы Вы изменили некоторые из отпечатков после 
импортирования списка соединений, то Вы вероятно захотите выбрать For parts with different footprints in project 
and netlist file: Keep footprints (Для корпусов с различными отпечатками в проекте и файле списка 
соединений: Сохранить отпечатки) с тем, чтобы Вы не вернулись назад к старым отпечаткам после импорта. 
Если Вы добавили соединения и желаете сохранить их, Вы вероятно захотите выбрать For nets in project that are 
not in netlist file: Keep nets (Для соединений в проекте, которые отсутствуют в файле списка соединений: 
Сохранить соединения). 
 
 



Вы должны использовать эти опции тщательно, поскольку они могут вызвать неожиданные результаты. Например, 
если Вы неосторожно поменяете имя соединения в схемном редакторе и затем импортируете список соединений с 
опцией Keep nets, то Вы завершите с 2 соединениями с различными названиями, со всеми штырьками в новом 
соединении за исключением любых штырьков, которые были в старом соединении, но не в новом. Кроме того, Вы 
потеряете всю разводку на новом соединении (см. примечание ниже). Или если Вы изменили позиционное 
обозначение корпуса в схемном редакторе, и Вы выбираете одну из опций Keep parts, Вы завершите с двойным 
корпусом.  
Последние три опции в диалоге (Retain traces(Сохранить дорожки), Retain stubs(Сохранить обрубки), Retain 
areas(Сохранить области)), определяют, попытается ли FreePCB сохранить разведённые дорожки и медные 
области, имена соединений которых были изменились в файле списка соединений, анализируя списки штырька. 
Как только Вы выбрав Import Options, кликнули OK. Файл списка соединений загрузится, и все новые корпуса 
будут помещены в окно размещения слева от начала координат. Чтобы видеть их, Вы можете выделить All Parts из 
меню View (или нажать клавишу "Home"), который корректирует окно размещения, чтобы сделать все части 
видимыми, как показано ниже. 
 

 
 



Если FreePCB будет неспособен соответствовать любому из идентификаторов упаковки с отпечатками от его 
библиотек, то появится следующее сообщение. 
 

 
В этом случае, Вы можете проверить partlist, выбирая Parts... из меню Project. Это вызовет диалог View/Edit Part 
List, как показано ниже. 
 

 
 
 



Отметьте, что отпечаток для U2 показывают как "??????", индицируя, что FreePCB был неспособен найти отпечаток 
с идентификатором "dip14". Отпечаток можно назначить на этот корпус, выбирая это и нажимая кнопку Edit 
Selection, которая вызывает диалог Add/Edit Part, показанный ниже. 
 

 
 



Вы можете назначить отпечаток на U2, разворачивая библиотечные файлы в диалоге, пока не найдёте отпечаток, 
которую Вы хотите, и затем кликнуть по нему, чтобы скопировать в поле Footprint диалога, как показано ниже. 
Если Вы знаете название отпечатка, Вы можете ввести его непосредственно. 
 

 
У U2 теперь должен быть отпечаток в окне размещения, помещенном в любую позицию, которую Вы 
устанавливаете в диалоге (X = 0, Y = 0 в примере выше). 
 
5.14.3 Экспорт Файлов Списка соединений  
Вы можете экспортировать файл списка соединений из проекта, используя пункт меню File > Export netlist.... В 
результирующем файле упаковка для каждого корпуса будет установлен в название фактического отпечатка , 
который использовался в проекте. 
 
 
 



5.15 Медные области (Copper Areas) 
помимо дорожек, медные области могут использоваться для подключений на PCB. Они обычно используются для 
плоскостей питания и земли, когда они могут занять весь слой платы. В FreePCB все медные области должны быть 
назначены в соединении.  
Медные области оттянуты как замкнутые ломаные линии (или полигоны), подобный границе платы. Они могут 
быть отображены как простая контурная линия, контурная линия с внутренней штриховкой, или контурная линия с 
немного штриховки вдоль ее внутреннего края. Эти шаблоны штриховки для визуальной ссылки только, поскольку 
фактическая медная область на PCB будет твердой медью. FreePCB автоматически создаст зазоры вокруг любых 
площадок или дорожек, которые проходят через медную область на том же самом слое. Однако, эти зазоры не 
будут отображены, но будут созданы в файлах Gerber.  
Чтобы создать новую медную область, выберите Copper Area из меню Add. Следующий диалог появится. 
 

Выберите соединение для медной области из Net раскрывающегося 
меню, или напечатайте имя соединения непосредственно в поле. 
Выберите слой из списка Layer. Выберите шаблон Штриховки Hatch 
pattern. Затем нажмите OK, чтобы запустить тянуть область. Курсор 
изменится на перекрестие, и Сетка разводки Routing Grid будет 
действовать. Двигайтесь в желательную позицию стартового угла, и 
левым кликом разместите его. Теперь Вы будете перетаскивать 
первую сторону ломаной линии. Как с контурной линией платы, Вы 
можете изменить стиль стороны от прямо до по часовой стрелке или 
против часовой стрелки образовать дугу при использовании меню 
функциональной клавиши. Продолжите левые клики, чтобы поместить 
остальную часть углов, и правый клик, чтобы закрыть ломаную 
линию. Медная область затем заполнится диагональным шаблоном 
штриховки, чтобы сделать это более видимым. 
 
 
 
 
 

 
Пример маленькой медной 
области на внутреннем 1 слое. Эта 
область была назначена на 
соединение заземления и  
использует полный шаблон 
штриховки. 
 
 
 



После того, как медная область создана, она может быть отредактирована, выбирая углы или стороны и используя 
меню функциональной клавиши. Это - точно то же самое как редактирование контур платы, таким образом Вы 
можете обратиться к Части 5.10: Контур платы для инструкций. Вы можете изменить шаблон штриховки, выбирая 
сторону и щелчок правой кнопкой мыши, затем выбирая Hatch style из меню контекста.  
Подключения между корпусами и медными областями могут быть сделаны двумя путями: 

� Штырьки через отверстие, которые проходят через медную область, могут подключатся используюя 
тепловое облегчение. Они будут размещены автоматически для штырьков на той же самой сети как медная 
область. Они обозначены "X" продвинутый штырек в цвете ratline. 

SMT площадки или штырьки через отверстие, которые не проходят через медную область, могут быть 
подключены, используя обрубленные дорожки, которые заканчиваются с переходом. Тепловое облегчение будет 
помещено автоматически на переход.  
 

Чтобы иллюстрировать, 4 корпусаи 
были помещены, лежа над медной 
областью в нашем предыдущем 
примере. Только GND соединение 
было сделано видимым, который 
является соединением, 
назначенной на медную область. 
Имейте в виду, что штырьки Y1.4, 
JP2.2, JP2.3, JP2.4, JP2.6, JP2.8, 
JP2.10 были все автоматически 
подключены с медной областью 
тепловым облегчением. 
 
 
 
 
 
 
 
Чтобы подключить R1.1 и C1.2, мы 
будем использовать обрубленные 
дорожки. Они были добавлены 
ниже. Отметьте, что переходы на 
концах заглушек были подключены 
с тепловым облегчением. Теперь 
всё GND соединение было 
подключено, используя медную 
область. 
 
 
 
 
 
 
 
 
 

 
Шаблон штриховки в медной области предназначен только для визуальная помощь, чтобы показать протяжённость 
бласти, позволяя другие особенности просвечиванию рисунка. Когда файлы Gerber будут сгенерированы, область 
будет твердой медью с зазорами для любых неподключенных площадок и дорожек, которые проходят через это. В 
учебнике Вы будете использовать медные области, чтобы создать плоскости питания и земли, которые занимают 
все слои PCB. 
 
 
 



5.15.1 Вырезы в медной области  
Иногда полезно "вырезать (cut out)" часть медной области. Это может быть сделано, чтобы создать открытие в 
медной области, или изменить ее схему. Чтобы создать вырез, выберите сторону или угол области и нажмите F6 
(Add Cutout). Затем потяните вырез так же, как Вы потянули бы новую область. Изображение ниже показывает 
нашу медную область с вырезом вокруг Y1 и JP2. 
 

 
Медные области могут быть помещены в вырезахх в других медных областях. 
 
 
 



5.16 Текст  
Текстовых строк могут быть добавлены к шелковому экрану или медным слоям PCB. Они полезны для того, чтобы 
показывать информацию, такую как отметки, номер версии, объявления об авторском праве, и т.д.  
Добавим текстовую строку к PCB, выбирая Text из меню Add. Следующий диалог выскочит.  
 

Введите желательную текстовую строку в Text: поле. Пробел и 
большинство специальных символов позволены. Используйте 
другие поля, чтобы установить слой, высоту символа и 
штриховую ширину. Высота символа обращается к 
максимальной высоте символа, не считая подстрочные 
элементы. Заданная по умолчанию штриховая ширина 
составляет 10 % символьной высоты. Установка флажка Mirror 
image потянет текст как зеркальное отображение, так, чтобы это 
могло читаться от нижней меди или нижнего уровня шелкового 
экрана. Если Вы оставите Drag to position, радио кнопка 
выбрана, то Вы будете перетаскивать текст, когда Вы нажмете 
OK. Иначе, Вы можете явно установить позицию и угол 
текстовой строки. Позиция обращается к более низкому левому 
углу строки (не включая подстрочные элементы). 
 
 
 



5.17 Вырезы в маске припоя (Solder Mask Cutouts) 
Маска припоя Solder mask является покрытием, которое применено к PCB, чтобы препятствовать тому, чтобы 
припой придерживался их. Это не является действительно необходимым для спаянных рукой плат, но является 
существенным для плат, которые спаяны, автоматически используя ванну припоя или методики обратного течения. 
В CAM процессе, предпологается что маска припоя является "слоем" PCB, и описана файлом Gerber так же медные 
слои или слои шелкографии. Обычно имеются верхняя и нижняя маски припоя, с отдельными файлами Gerber для 
каждой.  
Открытия должны быть сделаны в маске припоя для площадок, так как они требуют припоя. FreePCB создает эти 
открытия автоматически в файлах Gerber для уровней маски припоя, используя зазор, определенный в CAM 
диалоге.  
Иногда может быть необходимо создать дополнительные открытия в маске припоя. Например, у торцевых 
разъемов платы должно быть открытие вокруг них, чтобы предотвратить "перемычки" маски припоя между 
пальцами соединителя. Или, Вы могли бы хотеть иметь область пустой меди для экранирования или охлаждения. В 
FreePCB эти открытия упоминаются как вырезы cutouts. Вы можете добавить вырезы в слое маски припоя 
используя Add > Solder Mask Cutout. Это вызывает следующий диалог:  
 

Вы должны выбрать верхний или нижний слоя маски припоя, и 
шаблон штриховки hatch pattern. Нажимание OK позволяет Вам 
тянуть вырез как замкнутую ломаную линию, так же как контур 
платы или медной области. Это покажут в цвете для "top sm 
cutout" или "bot sm cutout" слоя в списке слоёв. 
 
 
 
 
 
 
 

 
Пример выреза в маске пайки вокруг торцевого разъёма показан ниже. 

 
Для двустороннего торцевого разъема вырезы должны 
быть сделаны на обоих верхнем и нижнем слоях маски 
припоя. 
 
 



5.18 Группы  
Помимо манипулирования отдельными элементами PCB, Вы можете также выполнить операции на группах groups  
элементов. Группа может содержать любые элементы PCB. Чтобы выбрать группу элементов, кликните - 
перетаскивайте прямоугольник, чтобы включить их. Они будут подсвечены, как показано в скриншоте ниже: 
 

 
К группе выбранных, отдельные элементы могут быть добавлены или удалены, кликая по ним с нажатой клавишей 
"ctrl". Маска выбора может быть полезной, когда делаешь это. Следующие операции могут быть выполнены на 
группах: 

� Move — Чтобы переместить группу, нажать F4 ("Move Group"). Группа элементов исчезнет из окна 
проекта, и Вы будете перетаскивать представление схемы группы. Используйте левый клик, чтобы 
поместить группу в новую позицию. 

� Delete - Нажать клавишу "Delete" или F8 ("Delete Group"), чтобы удалить группу из проекта. Имейте в 
виду, что некоторые элементы группы не могут быть удалены. В общем, элементы полигона, такие как 
контур платы, медные области, и т.д. будут удаленв только в том случае, если весь полигон был включен в 
группу. Для сегментов дорожки будет отменена трассировка, а не удалены.  

� Copy - Чтобы скопировать группу в буфер обмена, используйте ctrl-C или выберите Edit > Copy. Не все 
элементы могут быть скопированы. Элементы полигона будут только скопированы, если только весь 
полигон будет включен в группу. Дорожки будут скопированы, если только корпус (ы), содержащий 
штырьки, с которыми они подключены, будет также скопирована.  

� Cut - Для этой функции, используйте ctrl-X или выберите Edit > Cut. Это - только комбинация Copy и 
Delete. 

 
 
 



Paste - После того, как группа была скопирована в буфер обмена, она может быть вставлена в проект нажатием ctrl-
V или выбором Edit > Paste. Вставка является сложная операция, потому что элементы в группе, вероятно, 
придется переименовать прежде, чем они будут добавлены к проекту, чтобы избежать конфликтов с 
существующими названиями. Диалог Paste Group появится, как показано ниже. Для корпусов в группе у Вас есть 
опция переименования их или попытки многократно использовать оригинальные позиционные обозначения. Для 
соединений у Вас есть выбор переименования их или объединения их с существующими соединениями, имеющими 
то же название в проекте. 
 

 
� Save to file — Используйте Edit > Save to File..., чтобы сохранить группу как проектный файл. Этот файл 

может быть открыт для того, чтобы редактировать с FreePCB, или вставлен в другой проект (см. ниже).  
� Paste from file — Используйте Edit > Paste from File..., чтобы вставить проектный файл в текущий проект 

как группа. Диалог Paste Group появится, как показано выше. 
С небольшим творческим потенциалом Вы можете найти большое использование для операций группы в Ваших 
проектах. Например, чтобы отменить трассировку дорожек в проекте, установите маску выбора для выбора 
дорожек, выделять все дорожки в проекте и нажимать "Delete". 
 
 



5.19 Проверка правил проекта (Design Rule Checking) 
В идеальном мире, PCBs всегда изготовлялся бы точно как определено в файлах Gerber и сверловки. В реальной 
жизни, конечно, это не так. Из-за неточной природы процесса гравюры, медные особенности могут оказаться 
немного большими или меньшими чем указанный. Слои включения многослойных плат, возможно, не выстроются 
точно в линию, и размер и позиция отверстий могут измениться из-за производственных допусков. В практических 
терминах это означает, что есть более низкие пределы на ширину дорожки, размеры площадки и зазоры между 
медными особенностями и/или отверстиями. Эти пределы называют Правилами Проекта Design Rules, и изменятся 
в зависимости от производственного процесса.  
Изготовитель PCB должен обеспечить правила проекта для каждого процесса, что он предлагает. Например, 
правила проекта, зарегистрированные в Интернете для Advanced Circuits дешевый процессов, показаны ниже: 
 

Minimum trace width  
Минимальная ширина дорожки  

0.008 inch (0.2032 мм) 

Minimum clearance between copper features  
Минимальный зазор между медью 

0.008 inch (0.2032 мм) 

Minimum distance from copper to edge of PCB  
Минимальное расстояние от меди до края платы 

0.014 inch (0.3556 мм) 

Minimum annular ring width (pins)  
Минимальная ширина дужки для штырьков 

0.007 inch (0.1778 мм) 

Minimum annular ring width (vias)  
Минимальная ширина дужки для переходов 

0.005 inch (0.127 мм) 

Minimum silkscreen line width  
Минимальная ширина линии шелкографии 

0.008 inch (0.2032 мм) 

 
Правила проекта для PCB Express дешевых процессов: 
 

Minimum trace width  
Минимальная ширина дорожки  

0.007 inch (0.1778 мм) 

Minimum clearance between copper features  
Минимальный зазор между медью 

0.007 inch (0.1778 мм) 

Minimum distance from copper to edge of PCB  
Минимальное расстояние от меди до края платы 

0.020 inch (0.508 мм) 

Minimum space between pads (using solder mask clearance of 0.004 inch)  
Минимальное пространство между площадками (используя маску припоя с зазором 
0.1016 мм) 

0.013 inch (0.3302 мм) 

Minimum annular ring width (pads and vias)  
Минимальная ширина дужки для штырьков и переходов 

0.0085 inch (0.2159 мм) 

Minimum clearance from inner layer holes to copper 
Минимальный зазор между медью внутреннего слоя и отверстием 

0.0175 inch (0.4445 мм) 

Minimum silkscreen line width  
Минимальная ширина линии шелкографии 

0.007 inch (0.1778 мм) 

 
Если Вы делаете плату самостоятельно, Вы должны будете определить свои собственные правила проекта. 
 
 



FreePCB имеет контроль правил проектирования Design Rule Checker, который проверяет Ваш проект для согласия 
с установками правил проекта. Выбирая Tools > Design Rule Check вызывает следующий диалог: 
 

 
Переключатель Show unrouted connections as errors позволяет Вам обрабатывать ошибки подключения как 
ошибки DRC. Другие поля в диалоге объяснены ниже: 
 

trace width Минимально допустимая ширина дорожки 

pad to pad Минимальное расстояние между краями площадок, находящихся в разных цепях 

pad to trace Минимальное расстояние между краем площадки и дорожкой, находящихся в разных 
цепях 

trace to trace Минимальное расстояние между краями дорожек, находящихся в разных цепях 

hole to pad or trace Минимальное расстояние от края отверстия до площадке или дорожке другой цепи 

hole to hole Минимальное расстояние от края отверстия до края другого отверстия 

annular ring (pins) Минимальная ширина меди окружающей отверстия для штырька 

annular ring (vias) Минимальная ширина меди окружающей отверстия для переходного отверстия 

board edge to any copper Минимальный зазор между любой медью и краем платы 

board edge to hole Минимальный зазор между краем отверстия и краем платы 

copper area to copper area Минимальный зазор между областями меди 

 



Вы должны установить эти поля для правил проекта, которые Вы используете. Если изготовитель PCB не дает 
значение для определённого поля, Вы должны будете предположить разумное значение. Например, параметры 
настройки, которые я использовал бы для Advanced Circuits, показаны ниже: 
 

 
 
Установки для trace width, pad to pad, pad to trace, trace to trace, 
annular ring (pins), annular ring (vias), board edge to any copper, 
hole to pad or trace и copper area to copper area были взяты из 
правил проекта, зарегистрированных в Интернете. Поскольку там не 
было правил для hole to pad or trace, hole to hole или board edge 
to hole, я использовал 25 mils, который похожи на разумное 
значение. В случае необходимости, я могу уточнить это у 
производителя PCB. 
 
 
 



В качестве примера, давайте проверим проект, показанный ниже, который содержит множественные намеренные 
нарушения правила проекта. 
 

 
Чтобы проверить проект, выберем Tools > Design Rule Check и установим правила проекта как описано выше. 
Кликнув Check запускаем проверку и получаем следующий диалог, который перечисляет все нарушения. 
 

 
 



Когда Вы закроете диалог Design Rule Check, каждое нарушение будет обозначено в окне схемы размещения 
маленьким кольцом в цвете для ошибок DRC, как показано ниже.  
 

 
Эти маленькие 
кольца могжет быть 
тяжело заметить в 
плотном проекте. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Если вы держите 
нажатой клавишу 
"d", каждое кольцо 
будет преобразовано 
в большой сплошной 
круг, как показано. 
 
 
 



Теперь Вы можете увеличить отдельные ошибки и исправить их. Группа ошибок недалеко от низа платы  показана 
ниже. 

 
Вы можете выбрать одну из ошибок, нажимая на кольцо. Оно будет подсвечено, наряду с элементами, которые 
вызвали ошибку, и строка состояния покажет описание ошибки. В скриншоте ниже, я нажал на крайнюю справа 
ошибку. 
 

 
В этом случае, ошибкой есть нарушение расстояния между площадками, где расстояние - 0 mils вместо по крайней 
мере 8 mils. Мы можем устранить ошибку, перемещая площадку иили дорожку. Кольцо ошибки не будет 
автоматически удалено, когда Вы устраните ошибку, но Вы можете удалить его, выбрав и нажав клавишу "Delete". 
Вы можете удалить все ошибки, выбирая Tools > Clear DRC Errors. 
 
 



Важное примечание: Согласие с некоторыми правилами проекта также зависит от Ваших параметров настройки 
файла Gerber. Например, параметры настройки показанные ниже могут создать нарушение минимальной ширины 
линии шелкографии (которая должна быть по крайней мере 7 mils для Advanced Circuits) и ширины кольца для 
штырьков (которая должна быть по крайней мере 7 mils), таким образом они должны быть изменены на 
подходящие для правил проекта. 
 

 
Другое примечание: Если Вы нашли эту часть сбивающей с толку, некоторые изготовители PCB предоставляют 
информацию о правилах проекта на их вебсайтах. 
 
 
 



5.20 Экспорт файлов сверления и Gerber  
5.20.1 Создание Файлов 
Конечным шагом в создании размещения PCB является экспорт файлов, которые фирма изготовитель будет 
использовать, чтобы произвести Ваши платы. Эти файлы описаны ниже. 

� Gerber файлы - Эти файлы используются, чтобы создать фотошаблон, которое будет использоваться, 
чтобы сделать медные слои, шелковые экраны и маски для PCB. Там есть один файл для каждого слоя или 
маски. Формат есть расширенный Gerber RS274X.  

� Файл сверловки - Этот файл будет использоваться машиной, которая сверлит отверстия в PCB. Это 
использует формат Excellon, который является отраслевым стандартом. В основном, он начинается со 
списка размеров свёрл (в дюймах), и затем дает координаты центра каждого отверстия. Есть важная 
проблема относительно размеров свёрл, которая обсуждена в Части 5.19.3: Размеры свёрл. 
Пожалуйста читайте эту секцию прежде, чем Вы пошлете свои файлы в фирму изготовителя PCB. 

Чтобы экспортировать файлы сверловки и Gerber, выберите Generate CAM files... из меню File. Появится 
следующий диалог. 
 

 
В секции Files, выберите файлы, которые Вы хотите генерировать, проверяя или непроверяя поля рядом с каждым. 
 
 
 



Секция Gerber file options позволяет Вам выбрать или снять выделение следующих опций: 
� Include board outline - ставят этот флажок, чтобы включать контур платы во все Gerbers.  
� Add moires - добавляет символы муара (иногда названный "целями") для регистрации слоя.  
� Add layer description text - добавить текстовую строку в каждый Gerber файл, указывающий слой который 

это представляет. 
� Add pilot holes to pads and vias - добавляет пилотное отверстие к контактным площадкам с отверстием и 

переходам на верхнем и нижнем слоях, чтобы помочь в сверлении. 
� Use thermal reliefs for pins — при подключении контактных площадок с отверстиями к внутренними 

медными слоям, использовать тепловое облегчение. 
� Use thermal reliefs for vias - при подключении обрубленных дорожек к внутренним медным слоям с 

переходами, использовать тепловое облегчение. 
� Make cutouts in solder masks for vias - создавать открытия в масках припоя вокруг площадок переходов. 

 
Секция Gerber file dimensions позволяет Вам устанавливать значения для следующего: 

� Copper to copper-fill clearance - является зазором, который FreePCB создаст вокруг дорожек или 
переходов, которые проходят через медные слои. 

� Hole-edge to copper-fill clearance - является зазором, который будет создан вокруг просверленных 
отверстий. Пожалуйста обратитесь к Части 5.194: Зазоры сверловки для важного примечания об этих 
зазорах. 

� Solder mask clearance - пространство, которое FreePCB обеспечит вокруг площадок в масках припоя. 
� Pilot hole diameter - диаметр пилотных отверстий, если Вы выбрали их. 
� Minimum silkscreen stroke width - минимальная штриховая ширина, которую FreePCB будет использовать 

для слоя шелкографии, который обычно рекомендуется производителем платы. 
� Thermal relief line width - ширина линий, которые будут использоваться, чтобы подключить площадки или 

переходы к медным закрашенным областям, используя тепловое облегчение. 
� Board outline line width - ширина контурной линии платы, если используется.  
� Annular ring width (pins) and Annular ring width (vias) - ширина медных колец помещенный вокруг 

внутреннего штырька слоя и отверстий перехода с тепловыми вспомогательными подключениями к 
медным областям. 

 
Секция Panelizing позволяет Вам размножить Ваш проект, создавая множественные копии PCB в файлах Gerber: 
Number of boards (x)/(y) - число копий в каждой оси.  
Spacing edge-edge (x)/(y) - зазор между краями копий в каждой оси. 
 
Когда Вы кликаете Create Files, файлы будут записаны в Output folder. По умолчанию, это - подпапка проектной 
папки, названной CAM. Папка будет создана, если не существовала. Вы можете изменить это, если Вы хотите, или 
сбрасываете это к заданному по умолчанию пути кнопкой Set default. 
 
 
 



Предполагая, что все подходит, Вы будете видеть следующий Log диалог, с "*** SUCCESS ***" как конечная 
строка. Если ошибки происходят, в логфайле будут сообщения. Если ошибка произойдет, пока создаётся файл, то 
FreePCB будет обычно прерывать тот файл и продолжаться к следующему файлу. Каждый файл называют согласно 
его информационному наполнению, такому как top_copper.grb или drill_file.drl. 
 

 
Кликните OK, чтобы отпустить логфайл.  
Когда Вы закончены, создавая файлы, нажмите Exit в диалоге  Generate Gerber and Drill Files. 
 



5.20.2 Просмотр и Печать Файлов  
Есть много бесплатных программ, которые позволяют Вам просматривать Gerber и сверловки файлы. Прежде, чем 
послать Ваши файлы изготовителю платы, я СТРОГО предложил бы, чтобы Вы проверили их с одной из этих 
программ. Я использовал ViewMate от PentaLogix (прежде Lavenir). Вы можете загрузить это в 
www.pentalogix.com/Download/download.html. ViewMate позволяет Вам рассматривать и файлы Gerber и файлы 
сверловки, а также позволяет Вам делать пробную печать на принтер Windows. Так как функции печати в FreePCB 
еще не осуществлены, это в настоящее время - единственный способ напечатать Ваши проекты.  
Пример того как отображает ViewMate файлы Gerber FreePCB показано ниже. Этот файл Gerber включает 
контурную линию платы, moires и текст описания слоя ("Top Copper Layer"). 
 

 
 
 
 



5.20.3 Размеры свёрл 
Файл сверловки определяет размер и позицию каждого отверстия в PCB. Проблема, которая возникает с этими 
файлами, это обращения размера отверстия к фактическому размеру сверла (когда конечный диаметр отверстия 
будет на несколько mils меньше после металлизации) или конечному размеру (или покрытый металлом размер), 
который является конечным размером отверстия после металлизации. Мне имеет больше смысла определять 
конечный размер и позволять производителю платы фигуре, какое сверло использовать, так как они знают, 
насколько толстый будет их слой металлизации. FreePCB отпечатки используют конечные размеры, таким образом 
это есть размеры, которые появляются в файле сверловки.  
Вы ДОЛЖНЫ проверить с вашим производителем платы, однако, поскольку некоторые из них ожидают 
фактические диаметры долота, которые должны быть большими чем конечный размер. В этом случае, Вам, 
вероятно, придется редактировать файл сверловки и увеличить размеры практической отработки соответственно. 
Ваш производитель платы должна быть в состоянии помочь с этим, пока они знают то, что Вы хотите.  
Типовой файл практической отработки FreePCB показан ниже. 
;Holesize 1 = 24.0 PLATED MILS 
;Holesize 2 = 18.0 PLATED MILS 
;Holesize 3 = 14.0 PLATED MILS  
M48  
INCH  
T01C0.024  
T02C0.018  
T03C0.014  
%  
G05  
G90  
T01  
X028000Y018000  
X029000Y018000  
X028000Y017000  
X023000Y010000  
X023000Y011000  
X023000Y012000  
T02  
X012000Y017000  
X006000Y012000  
X012000Y012800  
X024000Y011000  
X024200Y009000  
X024200Y005000  
X024000Y003000  
T03  
X019000Y010000  
M30  
 
Строки, которые начинаются ";" комментарии. Каждый различный размер отверстия описан в комментарии, такой 
как 
 ;Holesize 1 = 24.0 PLATED MILS  
который указывает диаметр отверстия 24 mils, после металлизации. Строка 
 T01C0.024  
является фактической машинной командой на машину, которая устанавливает размер сверловки, в дюймах.  
Если Вы должны изменить размер сверления, чтобы учесть металлизацию, Вы должны изменить и комментарий и 
машинную команду. Например, чтобы использовать 28 mil сверо вместо 24 mil сверла, измените комментарий на 
 ;Holesize 1 = 28.0 UNPLATED MILS  
и машинная команда к  
 T01C0.028  
Некоторые производители платы попросят отдельный текстовый файл, который перечисляет размеры сверления. 
Вы можете посоветовать им смотреть на комментарии в начале файла практической отработки, или Вы можете 
скопировать их в отдельный файл. 



5.20.4 Зазоры сверления (Drill Clearances) 
Производители плат будут часто рекомендовать "drill clearance". Это - минимальный рекомендуемый размер зазора  
с отверстиями во внутреннем слое меди, которая должна быть создана вокруг просверленных отверстий, чтобы 
позволить безопасный проход отверстия без коротких замыканий. Как правило, они определят кое-что как "диаметр 
сверла плюс 0.025 дюйма". Это обращается к ДИАМЕТРУ зазора отверстия. FreePCB использует Hole-edge to 
copper-fill clearance значение, чтобы создать эти зазоры. Однако, потому что FreePCB обрабатывает этот зазор как 
расстояние между краем отверстия и краем меди, это будет различие в РАДИУСЕ между отверстиями, который 
является половиной различия в диаметре. Поэтому, чтобы создать зазор сверления "диаметр сверла плюс 0.025 
дюйма", Вы должны использовать Hole-edge to copper- fill clearance одной половины 0.025 дюймов, или 12.5 
mils. Это было бы округлено в большую сторону к 13 mils. 
 
 
 



6. Отпечатки и Библиотеки  
6.1 Библиотеки отпечатков 
Отпечатки сохранены в библиотечных файлах library files, у которых есть расширение .fpl. Каждый файл содержит 
множество отпечатков, обычно для упаковок того же самого типа. FreePCB идет с рядом библиотечных файлов, 
большинство которых было получено путём преобразования библиотеки от Ivex Design International Inc., 
производителя коммерческого программного обеспечения ECAD, которое обанкротилось в прошлом году. Эти 
файлы организованы в три группы: 

� Основные библиотеки (Core libraries) — Это наиболее часто используемые библиотеки. Они расположены 
в папке C:FreePCB\lib, если Вы сделали стандартную инсталляцию.  

� Дополнительные библиотеки — Это библиотеки с реже используемыми корпусами. Они расположены в 
C:FreePCB\lib_extra.  

� Внесенные библиотеки - Библиотеки, внесенные пользователями. Они расположены в 
C:FreePCB\lib_contrib. 

 
Когда Вы создадите проект в FreePCB, Вы выберете библиотечную папку, чтобы использовать для проекта. 
Обычно, это будет папкой основной библиотеки. Если Вы должны использовать любую из других библиотек, Вы 
должны скопировать их в папку оперативной библиотеки. Если Вы хотите, Вы можете скопировать ВСЕ файлы в 
папку оперативной библиотеки, таким образом они все будут в одном месте.  
Вы можете создать свои собственные отпечатки, используя Мастер создания отпечатков Footprint Wizard или 
Редактора отпечатков Footprint Editor, которые рассмотрены в Части 6.2: Мастер создания отпечатков и Часть 6.3: 
Редактор отпечатков. Если бы Вы создаете свои собственные отпечатки, я рекомендовал бы сохранить их в 
отдельных библиотечных файлах вместо стандартных файлов, которые идут с FreePCB. Таким образом, если есть 
обновления стандартных библиотек, Вы можете заменить их, не теряя Ваши собственные отпечатки.  
Каждый библиотечный файл документирован в файл формата PDF, у которого есть то же самое название как 
библиотечный файл за исключением расширения .pdf вместо .fpl. Если Вы ищете специфический отпечаток, файлы 
формата PDF - лучшее место, чтобы смотреть. Вы можете также просмотреть для отпечатков в Add > Part диалог, 
но файлы формата PDF содержат более подробную информацию, такую как размеры и площадок размеры.  
Если Вы создаете или изменяете свои собственные библиотеки, Вы можете сделать файлы формата PDF для них 
использования Tools > Make PDF from Library File... пунктом меню в Редакторе отпечатков.  
Библиотечные файлы, которые в настоящее время поставляются FreePCB, перечислены в секциях ниже. Отметьте, 
что файлы, содержащие отпечатки с площадками с отверстиями, начинаются с "th _", в то время как те с 
площадками SMT начинаются с "sm _". 
 
 
 



6.1.1 Основная библиотека 

Имя файла (.fpl) Источник(и) Тип Описание 

th_transistor Ivex, JEDEC through-hole JEDEC TO-серии упаковок транзисторов и ИС 

th_diode Ivex, JEDEC through-hole JEDEC DO-серии диодных упаковок 

th_capacitor Ivex through-hole Конденсаторы, полярные и неполярные 

th_resistor Ivex through-hole Резисторы, включая потенциометры 

th_connector Ivex through-hole Соединители 

th_header Ivex through-hole Headers 

th_sip Ivex through-hole SIP (однорядная) упаковки (100 mil расстояние) 

th_dip Ivex through-hole DIP (двухрядная) упаковки (100 mil расстояние) 

sm_resistor Ivex, IPC surface-mount Чип резистор 

sm_capacitor Ivex, IPC surface-mount Чип и танталовые конденсаторы 

sm_soic Ivex, IPC surface-mount SOIC (small outline IC) packages 

sm_sop Ivex, IPC surface-mount SOP and TSOP (small outline package) packages 

sm_soj Ivex, IPC surface-mount SOJ (small outline J-lead) packages 

sm_lcc Ivex, IPC surface-mount LCC (leadless chip carrier) packages 

sm_plcc Ivex, IPC surface-mount PLCC (plastic leaded chip carrier) packages 

sm_sot Ivex, Siemens surface-mount SOT (small outline transistor) packages 

led Ivex mixed Светодиоды 

test_point Ivex mixed Тестовые точки 

 
6.1.2 Дополнительные библиотеки (Extra libraries) 

Имя файла (.fpl) Источник(и) Тип Описание 

sm_qfp Ivex, IPC surface-mount PQFP, SQFP и QFP (quad flat-pack) упаковки (этот 
файл не находится в папке основной библиотеки, 
потому что слишком большой) 

device Ivex mixed Различные устройства 

sm_tantalum_cap Ivex surface_mount Танталовые конденсаторы от AVX 

elfa_cap Ivex mixed Конденсаторы из каталога ELFA 

elfa_chk Ivex mixed Различные устройства из каталога ELFA 

elfa_pot Ivex mixed Потенциометры из каталога ELFA 

elfa_res Ivex mixed Резисторы из каталога ELFA 

flatpack Ivex, JEDEC mixed Quad flatpacks 

sm_ipc782  surface-mount Различные устройства от IPC отсутствующие в других 
библиотеках 

siemens2  mixed Siemens LCC упаковки 

siemens3  mixed Siemens SO упаковки 

siemens4  mixed Siemens QFP упаковки 

transformer  mixed Трансформаторы 

tx_inst  mixed Различные упаковки Burr-Brown и Texas Instruments  

 
 



6.1.3 Внесенные библиотеки 

Имя файла (.fpl) Источник(и) Тип Описание 

flintstone Аноним смешанный Различные реле, горшки, трансформаторы и 
соединители 

 
6.2 Мастер создания отпечатка 
Могут быть времена, когда Вы будете нуждаться в отпечатке, которого нет в одной из библиотек, поставляемых с 
FreePCB. Мастер отпечатка является инструментом для генерации отпечатков для множества стандартных 
упаковок. Он вызывается с помощью пункта меню Tools > Footprint Wizard. Которое вызывает следующий диалог: 

 
 
 



Отпечаток создаётся, устанавливая различные средства управления в диалоге. Они описаны ниже: 
� Name - Это название, которое будет назначено отпечатку, когда он будет сохранен (например DIP28).  
� Type - тип упаковки. Строка диаграммы выбранного типа будет показана в диалоге (QUAD в примере 

выше). 
� SIP (однолинейная упаковка) — содержит один ряд одного или более штырьков. 
� DIP (двухлинейная упаковка) - две строки штырьков, пронумерованных как для DIP IC упаковки. 
� QUAD - четыре строки штырьков, упорядоченных как прямоугольник (как показано выше) и 

пронумерованный  как для PLCC или QFP упаковки. 
� HEADER - штырьки, упорядоченные в сетку и пронумерованные последовательно столбцом. 
� HEADER2 - то же самое как HEADER кроме штырьков, пронумерованных последовательно строкой. 
� PGA/BGA (для массива решетки штырька или шара) - штырьки упорядочены в прямоугольнике, и 

названы, используя соглашение для массива решетки. 
� Units - mils или мм. 
� Number of pins 

� Total - общее количество штырьков в упаковке.  
� Per horizontal row (только для упаковок QUAD, HEADER и PGA/BGA) - число штырьков на 

горизонтальной строке.  
� Per vertical row (только для упаковок QUAD, HEADER и PGA/BGA) - это заполняется автоматически, 

для информации.  
� Pin 1 position (только для упаковкb QUAD) — здесь есть три опции:  

■ top row, center pin (верхний ряд, средний штырёк) 
■ bottom row, left-most pin (нижний ряд, крайний левый штырёк) 
■ top row, left-most pin (верхний ряд, крайний левый штырек) 

� Pads 
� Shape — там есть четыре опции: 

■ Rectangular - прямоугольная площадка 
■ Pin 1 square, others round - квадратная площадка для штырька 1, другие круглые  
■ Round - круглые площадки 
■ Square — квадратные  площадки  
■ None — используется для создания отверстия без площадки (например для монтажного 

отверстия). 
� Hole diameter - диаметр отверстия в пложадке для площадки с отверстием (пробел или "0" для 

площадки SMT). Width (X) - ширина площадки (показывается как "X" в диаграмме строки). 
� Length (Y) - длина площадки (показывается как "Y" в диаграмме строки).  
� Spacing (E) - интервал между центрами площадок в пределах строки ("E" в диаграмме строки). 

� Distance between top and bottom rows - выбирая одну из этих трех радиокнопок, это расстояние может 
быть установлено как: 
� Inner-inner (G1) - расстояние между внутренними полями площадок ("G1" в диаграмме).  
� Center-center (C1) - расстояние между центрами площадок ("C1" в диаграмме).  
� Outer-outer (Z1) - расстояние между внешними полями площадок ("Z1" в диаграмме). 

� Distance between left and right rows  - выбирая одну из этих трех радиокнопок, это расстояние может 
быть установлен как: 
� Inner-inner (G2) - расстояние между внутренними полями площадок ("G2" в диаграмме).  
� Center-center (C2) - расстояние между центрами площадок ("C2" в диаграмме).  
� Outer-outer (Z2) - расстояние между внешними полями площадок ("Z2" в диаграмме). 

Preview — клик по этой кнопке создает предварительный просмотр отпечатка в диалоге. 
 
 
 



Лучший источник размеров специфической упаковки - таблица данных изготовителя. Это обычно доступно в 
Интернете. В некоторых случаях, изготовитель будет даже поставлять рисунок предложенного отпечатка PCB (для 
частей SMT, они часто упоминаются как "land patterns (образец посадки)").  
После того, как Вы ввели параметры настройки для отпечатка, кликните Preview, чтобы видеть изображение 
отпечатка. Если это смотрится OK, Вы можете сохранить это в библиотечном файле, кликнув Save. Это вызовет 
диалог сохранения отпечатка показанный ниже. 
 

 
 
Footprint name скопировано от Мастера, и может быть изменено здесь, если Вы хотите. Author, 
Source и Description могут быть заполнены текстом, описывающим отпечаток. Библиотечное окно списка файла 
позволяет Вам выбирать библиотечный файл, или вводить новое имя файла, чтобы создать новый. Это будет 
инициализировано к user_created.fpl.  
Несколько примеров отпечатков, созданных с Мастером отпечатка даны ниже. 
 
 
 



6.2.1 Пример 1: Монтажное отверстие или Контрольная точка с единственным штырьком  
Чтобы создать отпечаток единственного штырька для монтажного отверстия или контрольной точки, установите 
Type в "SIP" и Number of pins в "1". Параметры настройки для монтажного отверстия с диаметром отверстия 100 
mils и круглой площадкой диаметром 200 mils показаны ниже. 
 

 
 



6.2.2 Пример 2: Резистор с осевыми выводами 
 

Давайте стартуем с рисунка резистора, взятого 
из таблицы данных Panasonic. Этот отпечаток 
будет для 1/4Вт типа ERD25. 
 
 
 
 
 
 
 
 
 
 
 
От таблицы данных длина упаковки составляет 
6.35 мм. Чтобы учесть изгиб выводов, мы 
увеличим пространство между площадками до 
12.5 мм. Диаметр выводов составляет 0.60 мм. 
Чтобы позволить зазор для вставки, диаметр 
отверстия составит 0.9 мм. Диаметр площадки 
составит 1.4 мм. Установки мастера отпечатка 
показаны ниже. 
 
 
 

 



 
6.2.3 Пример 3: DIP упаковка с прямоугольными площадками  
Здесь приводятся настройки для DIP ИС отпечатка с 20 штырьками через отверстие площадками. Стандартный DIP 
интервал между штырьками - 100 mils, и интервал между строками - 300 mils. Мы будем использовать 
прямоугольные площадки 80 X 40 mils в размере с отверстиями диаметром 25 mil. 
 



 
 
 
 



6.2.4 Пример 4: QFP упаковка с 100 штырьками  
Этот отпечаток основан на упаковке для Cypress CY7C1329, 64 КБ X 32 синхронной кэш RAM. Размеры упаковки 
показаны на рисунке ниже, который был скопирован с таблицы данных Cypress. 
 

 
Для отпечатка, мы хотим площадки расширить 
0.5мм за конец каждого штырька, так мы добавим 
1.0 mm к внешним размерам строк штырьков. Кроме 
того, мы повернули упаковку на его стороне так, 
чтобы штырек 1 был в левом нижнем углу. 
Параметры настройки для мастера отпечатка 
показаны ниже. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 



6.3 Редактор отпечатка (Footprint Editor) 
 
Мастер отпечатка - самый простой способ создать нового отпечатка, но он ограничен определенными 
предопределенными шаблонами штырька. Будут времена, когда Вы будет нужна большая гибкость в размещении 
штырька. Кроме того, Вы можете хотеть создать более информативные или артистические контуры для своих 
отпечатков.  
Редактор отпечатка позволяет Вам делать все эти вещи. Он может быть открыто в FreePCB несколькими 
способами: 
Выбирая File > Open Footprint Editor пункт меню - Это доступно, даже когда нет никакого проекта, открытого в 
FreePCB.  
Выбирая Tools > Footprint Editor пункт меню - Это доступно только, когда есть открытый проект в FreePCB. 
Выбирая корпус, и нажимая F2 ("Edit Footprint") - Это открывает Редактора отпечатка с уже импортированным 
отпечатком корпуса. Когда Вы оставите Редактора отпечатка, Вас спросят, желаете ли Вы заменить оригинальный 
отпечаток корпуса своим измененным. 
 
6.3.1 Окно редактора отпечатков (Footprint Editor) 
Когда Вы открываете Редактора отпечатков, это не создает новое окно, но вместо этого заменяет обычное окно 
FreePCB. Вы можете сказать, что Вы находитесь в Редакторе отпечатка, смотря на область заголовка окна. Когда 
Вы закончили редактировать отпечаток, Вы можете возвратиться к FreePCB, нажимая F8 ("Return to PCB"), или 
выбирая File > Return to PCB Layout или Tools > Return to PCB layout элементы меню или кликая в боксе 
"Close" в верхний правый угол.  
Копия экрана Footprint Editor, с импортированным отпечатком DIP8, показана ниже. 

 
 
 



Поскольку Вы могли бы ожидать, меню в Редакторе отпечатка Footprint Editor отличается от меню FreePCB. Они 
упомянуты ниже: 

� File - 
� New footprint — Стартует редактирование нового отпечатка. 
� Import Footprint - Импорт отпечатка из библиотечного файла.  
� Save Footprint As - Сохраняют отпечаток в библиотечном файле. 
� Return to PCB layout - Закрывает Footprint Editor и возвращаются к FreePCB.  

� Edit -  
� Undo — отмена последней операции редактирования (если возможно). 

� View -  
� Entire footprint - изменяет размеры и повторно выравнивает по центру окно, чтобы отобразить все 

элементы отпечатка. 
� Add -  

� Pin - Добавляет новый штырек или строку штырьков.  
� Polyline - Добавляет новую ломаную линию к слою шелкового экрана.  
� Text - Добавляет текстовую строку 

� Tools - 
� Footprint Wizard - Вызывает Мастера отпечатка.  
� Make PDF from Library File - Делает файл формата PDF, описывающий отпечатки в библиотечном 
� файле. Return to PCB Layout - То же самое как в меню File.  

� Help - 
� About FreePCB - Дисплей "Окно информации" с номером версии. 

 
Другие элементы окна, такие как панель инструментов, список слоёв, меню функциональной клавиши, строка 
состояния и окно размещения такие же как для FreePCB. 
 
 
 



6.3.2 Элементы отпечатка 
Отпечаток состоят из 4 основных элементов. Они: 

� Pins - они осуществлены как стек контактных площадок padstacks. Стек площадок содержит медные 
площадки для верхнего, внутренних и нижнего слоёв, а же как дополнительного отверстия. 

� Polylines — Это графические элементы на уровне шелкового экрана. Они могут быть замкнутыми или 
разомкнутыми.  

� Reference designator - Это текстовая строка позиционного обозначения. Поскольку фактическое 
позиционное обозначение является собственностью корпуса а не отпечатка, Footprint Editor использует 
строку "REF" как указатель места заполнения. Это всегда присутствует и не может быть удалено, но это 
можно изменить размер. 

� Selection box - это прямоугольник, который включает все другие элементы, используемые для выбора 
корпуса во время размещения PCB. Это сгенерировано автоматически, во время сохранения отпечатка.  

Создание отпечатка фактически очень похоже к размещение PCB, и если Вы использовали FreePCB тогда, у Вас 
уже есть большинство необходимых навыков. Поэтому, мы проявим учебный подход к предмету. В следующих 
немногих частях мы создадим отпечаток для поляризованного конденсатора. Размеры конденсатора, показанные на  
рисунке ниже, взяты от таблицы данных Panasonic. Мы создадим отпечаток для конденсатора с диаметром корпуса 
12.5-мм. 
 

 
 



6.3.3 Старт нового отпечатка 
Из FreePCB, вызовите Редактор отпечатка Footprint Editor из меню File или Tools. Вы стартуете с окна размещения, 
которое пусто за исключением символа начала координат и позиционного обозначения, как показано в скриншоте 
ниже. Так как мы будем использовать метрическую систему измерения, удостоверьтесь, что Units есть "мм". 
 

 
 



6.3.4 Добавление и Редактирование Штырьков  
Выберем элемент меню Add > Pin. Это вызывает диалог Add/Edit Pin. Средства управления в этом диалоге в 
значительной степени очевидны. Некоторым из них позволены или запрещены в зависимости от добавленного 
штырька. Так как мы добавляем первый штырек, Padstack > Same as pin # заблокирован, потому что пока 
штырьки отсутствуют вообще.  
Конденсатор имеет выводы диаметром 0.6 мм. Для зазора мы будем использовать диаметр отверстия 0.9 мм и 
диаметры площадки 1.5 мм. Для первого штырька мы будем использовать квадратные площадки на верхних и 
нижних слоях и круглую площадку на внутренних слоях. Выберите Padstack > Through-hole радиокнопку и 
установите диаметр отверстия hole diameter в 0.9 мм. Установите Top pad > Shape в "square (квадратная)" и 
ширину Width в 1.5 мм. Inner pads >Shape должны быть "round (круглой)". Bottom pad должна быть такой же как 
Top pad. Установите позицию Position в X = 0.0 и Y = 0.0. Диалог должен выглядеть следующим образом: 

 
 
 

Нажимание OK должно привести к площадке, помещаемой в начало 
координат. 
 
 
 



Согласно таблице данных, интервал между выводами составляет 5 мм таким образом мы поместим наш второй 
штырек в X = 5.0 мм и Y = 0.0 мм. Чтобы сделать это проще, установите видимость Visible сетки размещения 
Placement в "1 мм". Теперь выберите Add > Pin, чтобы добавить второй штырек. 
 

 
С тех пор уже есть один штырек в нашей занимаемой площади, диалог предстанет инициализированным для 
второго штырька, с Padstack то же самое как штырек 1 по умолчанию. Однако, мы должны использовать круглую 
площадку для штырька 2 вместо квадратного. Поэтому, непроверьте Padstack > Same as pin # флажок, и 
измените Padstack > Top pad > shape на "round(круглый)". Затем Вы можете проверить Padstack > Inner pads > 
Same as top pad и Padstack > Bottom pad > Same as top pad чтобы сделать эти площадки такими же как 
верхняя площадка. 
 
 
 



Теперь диалог должен быть похожим: 
 

 
 

Нажмите OK, чтобы оставить диалог и запустить перетаскивание 
площадки. Поместите её в X = 5.0 мм и Y = 0.0 мм, как показано. 
 
 
 



6.3.5 Добавление Ломаных линий (Adding Polylines) 
Теперь, мы добавим некоторую графику шелкового экрана к нашему отпечатку, содержащий контур корпуса (круг 
с приблизительно тем же самым диаметром как диаметр конденсатора), и "+", чтобы отметить позитивный вывод, 
который в соответствии с соглашением является штырьком 1.  
Давайте начнём с круга. Это будет закмкнутая ломаная линия, с дугами для сторон. Так как нам нужно разместить 
углы на полпути между штырьками на Оси X, установим сетку размещения  Placement в "0.5 мм". Кроме того, 
удостоверьтесь, что угол Angle сетки установлен в "45". Тогда выберите пункт меню Add > Polyline. Это вызовет  
диалог Add Polyline: 

 
 
Так как для круга мы нуждаемся в замкнутой ломаной линии, то удостоверьтесь, что кнопка Closed выбрана, как 
показано выше. Line width установлена в 0.254 мм (или 10 mil) по умолчанию. Это - разумное значение, таким 
образом Вы можете оставить это в покое. Нажмите OK, чтобы запустить перетаскивание первого угла ломаной 
линии. Поместите его в X =-4.0 мм, Y = 0.0 мм. Пока перетаскиваете второй угол, нажмите F2 ("Arc (CW)"), чтобы 
изменить стиль на дугу по часовой стрелке. Поместите второй угол в X = 2.5 мм, Y = 6.5 мм. Поместите третий угол 
в X = 9.0 мм, Y = 0.0 мм и четвертый угол в X = 2.5 мм, Y =-6.5 мм. Затем щелкните правой кнопкой мыши, чтобы 
закрыть ломаную линию. Ваш круг должен быть похожим: 
 

 
 
 



Теперь давайте добавим "+". Выберем Add > Polyline, но на сей раз сделайте ее открытой ломаной линией. 
Потяните вертикальную линию, помещая первый угол в X =-6.0 мм, Y = 5.0 мм и второй угол в X =-6.0 мм, Y = 1.0 
мм. Тогда щелкните правой кнопкой мыши, чтобы прекратить тянуть. Добавьте другую открытую ломаную линию, 
и потяните горизонтальную строку, помещая первый угол в X =-8.0 мм, Y = 3.0 мм и второй угол в X =-4.0 мм, Y = 
3.0 мм. Теперь Ваш отпечаток должен быть похожим: 
 

 
6.3.6 Изменение позиционного указателя (Reference Designator)  
Наконец, давайте переместим позиционный указатель за пределы контурной линии корпуса. Кликните на нём, 
чтобы выбрать, и нажав F4 ("Move Ref Text"), запустите перетаскивание это. Переместите это выше контура 
корпуса и поместите левым кликом. Если Вы хотите сделать это большим или меньшим, Вы можете нажать F1 
("Set Size"), и затем используйте диалог Reference Text Properties, чтобы изменить размер и штриховую ширину, 
как Вы считаете целесообразным. Ваша конечная площадка должна выглядеть как: 
 

 
 



6.3.7 Сохранение отпечатка  
Чтобы сохранить Ваш новый отпечаток в библиотечном файле, выберите элемент меню File > Save As. Это 
вызовет диалог Save Footprint. Введите имя отпечатка Footprint name и (опционально) Автор Author, Источник 
Source и Описание Description, как показано ниже. Затем выберите библиотечный файл Library file, который Вы 
желаете использовать (или ввести новое имя файла), и нажать OK, чтобы сохранить отпечаток. 
 

 
 



6.3.8 Импорт Отпечатка  
Пока, мы описали, как создать отпечаток с нуля. Во многих случаях, будет проще начаться с существующего 
отпечатка и изменить его. Вы можете импортировать отпечаток в редактор Footprint Editor используя элемент меню  
File > Import footprint. Это вызывает следующий диалог. 
 

 
Отсюда, Вы можете выбрать библиотечную папку, открыть библиотечные файлы и выбрать отпечатки. Вы будете 
видеть предварительный просмотр выбранного отпечатка в диалоге. Нажмите OK, чтобы импортировать отпечаток  
в редактора отпечатка. Тогда Вы можете редактировать его. 
 
 
 



6.3.9 Использование Мастера отпечатка 
 

Вы можете также использовать 
Мастера отпечатка изнутри 
редактора отпечатка. Вот пример. 
Давайте сделаем отпечаток для 
упаковки PGA показанной ниже. 
Это - датчик изображения Kodak. 
Диаметр штырька - 18 mils, и 
интервал между штырьками - 100 
mils. Штырьки называют как обычно 
для PGA. 
 
 
 
 
 
 
 
 
 

Находясь в редакторе отпечатка, выберите Tools > Footprint Wizard. Мы будем использовать круглые площадки  
диаметром 50 mils, и диаметром отверстия 28 mils. Так как штырьки упорядочены в 11 столбцах и 11 строках, мы 
первоначально создадим наш отпечаток как матрицу 11 x  11 = 121 штырёк. Затема мы удалим лишние. Установите 
диалог Footprint Wizard показано ниже. 
 



 
Нажмите Done, чтобы создать отпечаток и импортировать его в Редактор отпечатка Footprint Editor. Это должно 
быть похожим: 
 



 
Теперь, выберите каждый лишний штырек и удалите его. Переместите "REF" строку так, чтобы это было видимо с 
корпусом на месте Ваша законченная площадка должна походить: 
 

 



6.3.10 Создание Файлов формата PDF из Библиотек 
Если Вы создаете или изменяете библиотечный файл, Вы можете сделать файл формата PDF, описывающий 
отпечатки в библиотеке, Tools > Make PDF from Library File.... Это вызовет следующий диалог: 
 

 
В случае необходимости, используйте поле Library Folder, чтобы выбрать библиотечную папку. Используйте  
раскрывающееся меню Library File, чтобы выбрать файл, который Вы желаете документировать. Чтобы сделать 
файлы формата PDF из всех библиотечных файлов в папке, листайте до основания меню файла и выберите "*** all 
library files ***", как показано ниже. Вы можете использовать меню Page size, чтобы выбрать между символом и 
размерами страницы A4, и меню Units, чтобы выбрать единицы измерения, которые будут использоваться в 
формате PDF. Затем Make PDF file, чтобы сделать файл (ы). 

 
 
Типовая страница из файла формата PDF показана ниже. 
 
 
 



 
 



7. Учебник  
7.1 Схема 
Лучший способ изучить новую CAD программу состоит в том, чтобы использовать её. Этот учебник будет вести 
Вас через размещения маленького PCB для моторного контроллера, чья схема показана ниже. Извините, что это 
изображение является довольно большим.  
Вы можете желать распечатать копию схемы так, чтобы Вы могли следовать за этим, поскольку мы располагаем 
PCB. 
 

 
 



7.2 Создавание Проекта  
Сначала мы создадим новый проект под названием "Motor". 
Выберите New меню File. Следующий диалог должен появиться. 
 

� Введите слово "motor" в блок Name. Это 
устанавливает название проекта.  

� Так как у проектной папки обычно есть то же самое 
название как проект, "motor" будет автоматически 
добавлен до конца пути папки в блоке Project Folder, 
который должен теперь читать "..\projects\motor". 
Отметьте, что этот путь относительно 
местоположения приложения, которое обычно 
находится в FreePCB\bin. Если Вы хотели 
использовать некоторую отличную от проектной 
папку, Вы можете отменить значение по умолчанию, 
вводя отличный путь папки, который может быть 
указан относительно папкт приложения или 
абсолютно. Если проектная папка не будет уже 
существовать, то FreePCB создаст ее (хотя его 
родительская папка должна существовать). Так как 
проектная папка "motor" уже существует и содержит 
файл списка соединений для моторного контроллера, 
я предложил бы оставить этот путь в покое.  

� Точно так же Вы можете отменить путь к 
Библиотечной Папке Library Folder, которая 
содержит библиотеки отпечатков. Если бы Вы 
сделали стандартную инсталляцию FreePCB, то в 
этом нет необходимости.  

� Если Вы решаете перемещать свои папки, Вы можете 
изменить заданные по умолчанию пути, редактируя 
файл default.cfg в папке прикложения. Если Вы 
перемещаете библиотечную папку после создавания 
проекта, Вы можете редактировать библиотечный 
путь в файле проекта motor.fpc. 

� Оставьте число медных слоёв в "4".  
� Заданный по умолчанию размеры дорожек и 

переходов Default trace and via widths будут применены к любому соединению или дорожке, у которого 
нет явно назначенных размеров. Так как мы будем использовать 10 mils как нашу заданную по умолчанию 
ширину дорожки, Вы можете оставить их в покое.. 

� Menu of trace and via widths является списком значений, которые будут представлены если Вы позже 
явно назначите размеры дорожки или соединения. Вы не ограничены использованием этих значений, но 
использование выбора из меню удобно и уменьшает шанс ошибки. Если Вы знаете, что Вы будете 
использовать определенные размеры, которые не находятся в заданном по умолчанию меню, Вы можете 
добавить их нажатием на Add. С помощью Delete Вы можете удалить элементы, которые Вы не будете 
использовать или редактировать элемент, выбирая его и нажимая Edit. 

� В этом учебнике мы будем использовать размеры дорожки 10 и 15 mils. Выберите каждый из других 
размеров в меню и удаляя их. 

Автосохранение Autosave будет автоматически периодически сохранять Ваш проект. Позвольте Enable это и 
установите интервал Interval в 5 минут. 
 
 
 



� Теперь Ваш диалог должен быть похожим: 
 

 
� Нажмите OK, чтобы выйти из диалога.  
� Область заголовка окна FreePCB должен теперь 

читаться "FreePCB - motor.fpc *", где motor.fpc - 
название проектного файла, который Вы будете 
создавать. Звездочка указывает, что проект был 
изменен, и информация не была сохранена. Чтобы 
удостовериться, что Вы можете сохранить файл, 
выберите Save от меню File (или нажмите ctrl-s). 
FreePCB запишет файл и звездочка исчезнет. 

�  Если Вы хотите смотреть проектный файл, Вы 
можете открыть motor.fpc редактором текста, 
таким как Блокнот. Вы будет видеть, что там есть 
секция опций [options]  файла, содержащего 
опции, которые Вы устанавливаете, наряду с 
некоторыми другими опциями по умолчанию. 
Большинство других секций файла, таких как 
ajhvs [shapes], корпуса [parts] и т.д. будут 
пустыми. 

� В следующей части мы начнём проектировать 
нашу PCB импортируя файл списка соединений. 

 
 



7.3 Импортирование Списка соединений  
Файл списка соединений, который мы будем использовать, был перечислен в Части 5.14: Импортирование Файлов 
Списка соединений. Вы могли бы хотеть делать обзор той секции перед продолжением. Корпус U2 преднамеренно 
оставили неправильным, таким образом мы должны будем установить это после того, как файл импортирован. 

� Выберите Import из меню File. Появится диалог, называемый Open. 
 

 
� В случае необходимости, переместитесь к проектной папке "motor". Выберите файл motor.net.  
� Выберите Parts and Nets в секции Import диалога.  
� Выберите PADS-PCB в секции Format диалога.  
� Нажмите кнопку Open.  
� FreePCB откроет окно Log и импортирует список соединений, описывая этот прогресс в Log. Вы должны 

видеть сообщение указывающее что отпечаток не была найден для U2. Нажмите OK, чтобы убрать Log. 
� Все импортированные части будут расположены в стеке слева от символа начала координат в окне 

размещения. 
 
 
 



� Выберите View > All Parts (или нажмите клавишу "Home"), чтобы видеть их. Подключения между 
штырьками будут показаны как ratlines. 

 

 
� Теперь мы установим недостающий отпечаток. Выберите Parts... из меню Project. Диалог View/Edit Part 

List должен появиться: 
 

� Этот диалог показывает список всех 
корпусов, которые были 
импортированы, с их позиционными 
обозначениями, идентификаторами 
упаковки и отпечатками. 

�  Отметьте, что отпечаток для U2 
показан как "??????", указывая, что 
идентификатор пакета "dip14" не 
соответствует ни одному из отпечатков 
Free PCB. Мы должны установить это. 

� Выберем строку для U2, кликнув по 
ней. 

Нажмите кнопку Edit Selection(s). Диалог 
Add/Edit Part должен появиться как показано 
ниже. 
 
 
 



� Этот диалог позволяет Вам 
редактировать параметры для 
корпуса U2, включая его отпечаток. 
Все доступные библиотеки 
отпечатков показаны в большом 
древесном контроле, занимающем 
большую часть диалога. Первый 
входит "local cache", который не 
является фактически библиотекой, 
но который содержит все отпечатки, 
которые в настоящее время 
загружены в FreePCB. 

� Разверните "th_dip.fpl" библиотеку 
кликнув "+" рядом с ней. Эта 
библиотека содержит отпечатки для 
DIP упаковок. Её имя начинается "th 
_", указывая, что она содержит 
отпечатки с штыревыми 
контактными площадками. 

� Выберите "14DIP300" от библиотеки 
кликнув на это. Изображение 
отпечатка появится в окне 
предварительного просмотра, и 
"14DIP300" должен заменить 
"??????" в поле Footprint. Теперь 
диалог должен выглядеть как: 

 
 

� Нажмите на OK.  
� Окно сообщений должно появится 

спрашивая хотите ли Вы заменить 
все примеры "dip14" с "14DIP300", 
или только U2. Поскольку там есть 
только один пример, Вы можете 
нажать или на YES или NO. 

� Это должно возвратить Вас к 
диалогу View/Edit Partlist, заменив 
"??????" на "14DIP300" для корпуса 
U2. 

� Нажать OK. U2 должен теперь иметь 
отпечаток, помещенная в позицию 
(0,0), как показано ниже. 

 



 
OK, теперь все отпечатки загружены. Сохраните свою работу. В следующей части мы создадим плату. 
 
 
 



7.4 Рисование контура платы 
В этой секции, мы создадим контур платы для нашего PCB. Это будет прямоугольная плата, 3 дюйма длиной 2 
дюймами высотой. Вы могли бы хотеть сделать обзор Части 5.10: Контур платы перед началом. 

� Во-первых, давайте переместим U2 в сторону. Раскройте на начале координат платы, помещая курсор по 
этому месту и прокрутив вперед колёсико мышки (или нажимая PgUp). Выберите U2, кликнув на нём. 
Белая контурная линия должна появиться вокруг неко, указывая, что это было выбрано. Нажмите F4, 
чтобы начать переместить это, и тащите это влево от начала координат, чтобы создать место для контура 
платы. Перемещайте окно как нужно колёсиком перемещения или надавливая "space". (Между прочим, 
окно, описывающее всю горячую клавиатуру, доступно в Help > Keyboard shortcuts.). 

� Левый-клик мыши помещает U2 в его новую позицию.  
� Когда рисуете контурную линию платы, действуе сетка размещения Placement. Установите это в разумно 

большое число как 100 или 200 mils. 
� Выберите Board Outline из меню Add. Курсор должен измениться на перекрестие. Поместите перекрестие 

в начале координат (то есть. X=0, Y=0). Левым кликом поместите первый угол платы. 
� Теперь переместите курсор вертикально вверх. Вы должны тянуть синий линейный сегмент, 

представляющий левую сторону платы. Переместите курсор в X=0, Y=2000 и левым кликом поместите 
левый верхний угол платы. 

� Точно так же поместите углы в X=3000, Y=2000 и X=3000, Y=0.  
Теперь щелкните правой кнопкой мыши, чтобы закрыть контурную линию платы нарисованную от последнего угла 
до первого. Контур вашей платы должна быть похожим: 

 
 
 



Вы можете проверить позицию угла, кликая на нём, чтобы выбрать. Маленький белый квадрат, показавшийся за 
углом, указывать, что он был выбран. Тогда нажмите F1 ("Set Position"), чтобы вызвать диалог Corner Position. Это 
отображает точные координаты выбранного угла, и позволяет Вам изменять их, если Вы хотите. Этот диалог очень 
полезен, если Вы проектируете плату с необычными размерностями. 
 

 
� Если Вы желаете, Вы можете испытать некоторые из других команд редактирования контура платы, как 

описано в Части 5.10: Контур платы. Когда Вы закончити, убедитесь, что контур был восстановлен к его 
оригинальной прямоугольной форме. 

Сохраните Save проект из меню File. 
 
 
 



7.5 Добавление монтажных отверстий  
Теперь мы добавим монтажные отверстия в углах PCB. Вы могли бы хотеть делать обзор Части 5.12: Монтажные 
отверстия перед началом. 

� Монтажные отверстия фактически специальный тип корпуса, состоящий из единственного штырька через 
отверстие. Они добавляются к проекту как любой другой корпус. Они могут быть включены в файл списка 
соединений, или они могут быть добавлены позже. Так как наш файл списка соединений не включал 
монтажные отверстия, мы добавим их используя меню Add > Part. 

� Установите сетку размещения в небольшое число, такое как 25 mils.  
Выберите Part из меню Add. Следующий диалог должен появиться 
 

 
� Введите "H1" в поле диалога Reference . Это будет позиционное обозначение для первого монтажного 

отверстия. 
Разверните библиотечный файл C:\FreePCB\lib\th_mounting_hole.fpl, нажимая "+" рядом с ним. Затем нажмите на 
"HOLE_125_SQUARE_250". Это является отпечаток для монтажного отверстия 125 mils в диаметре, с квадратной 
площадкой 250 mils в диаметре. Это о правильном размере для #4 машинных винтов. 
 
 
 



Теперь диалог должен быть похожим: 
 

 
 



Нажмите OK, чтобы закрыть диалог и начать перетаскивать монтажное отверстие. Переместите его в X = 150, Y = 
150, как показанный ниже. 
 

 
 



Нажмите левую кнопку мыши, чтобы поместить отверстие. Теперь схема размещения должна быть похожей 
 

 
 



� Точно так же, добавьте еще 3 монтажных отверстия в других углах PCB, используя позиционные 
обозначения H2, H3 и H4, как показано ниже. Отметьте, что, когда Вы используете диалог Add > Part, 
чтобы добавить эти отверстия, это подойдет инициализированное с последним отпечатком, который Вы 
добавили, с позиционным обозначением увеличенным на один, таким образом Вы только должны нажать 
OK или нажать "return", чтобы добавить следующую часть. 

 

 
� Теперь мы подключим H4 к цепи GND, так, чтобы это могло использоваться, чтобы заземлить PCB к его 

корпусу. Чтобы сделать это, мы должны выбрать штырек H4.1, вместо корпуса H4, так как подключения 
всегда делаются к штырькам. Имейте в виду, что в скриншоте выше, прямоугольник выбора вокруг H4 не 
имеет "X" через это, указывая, что выбран корпус, а не штырек. Строка состояния также показывает, что 
корпус H4 был выбран. 

 
 
 



� Чтобы выбрать штырек для H4, кликните где-нибудь на площадке. Теперь прямоугольник выбора должен 
содержать "X", и строка состояния должен указать, что штырек H4.1 был выбран, как показано ниже. Если 
бы Вы хотели переназначить корпус (чтобы переместить это, то например) Вы щелкнули бы еще раз на 
площадке. 

 

 
� С выбранным штырьком, нажмите F1 ("Set Net"), которая вызовет следующий диалог. Используйте 

раскрывающееся меню, чтобы выбрать цепь GND, как показано. 
 

 
 



� Нажмите OK, чтобы назначить H4.1 на цепь GND. ratline к штырьку должен появиться. 
 

 
 



� Теперь мы подключим H3.1 с GND, при рисуя ratline от H4.1 до H3.1. Со штырьком H4.1 все еще 
выбранный, нажмите F4 ("connect Pin"). Теперь Вы будете перетаскивать ratline от H4.1. Поместите конец 
ratline по H3 и левым-кликом подключите H3.1 к H4.1, как показано ниже. 

 

 
 



Точно так же, подключите H4 с H1 и H2. 
 

 



Теперь нажмите F8 ("Recalc ratlines"), чтобы перерисовать ratlines, минимизировав их полную длину. 
 

 
 



7.6 Размещение корпусов  
В этой части, мы разместим корпуса в наш PCB. 

� Установите сетку размещения Placement в разумное значение, такое как 100 mils для того, чтобы 
поместить корпуса со штырьковыми выводами, у которых интервал штырька 100 mils. Это облегчит 
выравнивание корпусов. Позже, мы можем использовать меньшую сетку для корпусов поверхностного 
монтажа. 

� Выберите Show all из меню View (или нажмите клавишу "Home") так, чтобы Вы могли видеть все корпуса. 
Это поможет, если Вы сделаете окно FreePCB как можно больше (хотя тогда у Вас может быть проблема, 
видеть этот учебник, если у Вас нет двойных мониторов). 

� Прежде, чем поместить любые корпуса, займите минуту, чтобы делать обзор схемы. Если Вы уже не 
сделали этого, это может быть полезным, чтобы напечатать схему так, чтобы Вы могли обратиться к ней, 
проектируя PCB. Так как U1 - наибольшая и наиболее "подключенная" часть, я предложил бы поместить 
это куда-нибудь около центра платы, с другим IC's неподалёку. Разъёмы JP1-JP6 вероятно должны быть 
помещены около краев. 

� Давайте начнём, помещая U1. Выберите его, кликнув по нему. Белая контурная линия должна появиться 
вокруг корпуса, показывая, что это было выбрано. Будте осторожными, что бы не нажимать на одну из 
площадок или позиционное обозначение, или Вы выберете это вместо всей части. Если у Вас есть 
проблема, найти U1, Вы можете использовать View > Show part, чтобы выбрать это позиционное 
обозначение. 

� Предупреждение: Иногда может быть трудно выбрать маленький корпус, у которой есть относительно 
большие площадки, такие как a конденсатор поверхностного монтажа. Однако, вот уловка, которую Вы 
можете использовать. FreePCB никогда не будет выбирать кое-что, что уже выбрано, если есть 
альтернатива. Поэтому, если Вы нажимаете на корпус и выбираете площадку вместо этого (или какая-
нибудь структура перекрывания), щелкаете еще раз, и Вы будете обычно получать корпус. Вы должны 
убедиться, что позволили достаточно времени между щелчками, чтобы Windows не принимала Ваши два 
щелчка за двойной щелчок, который обычно ничего не делает. 

 
 



� С выбранным U1, нажмите F4, чтобы начать перемещать это. Перетащите это к центру платы. Курсор 
будет "прикреплен" к штырьку 1 корпуса. Вращайте это, нажав F3, так, чтобы корпус стал вертикально со 
штырьком 1 в верхнем левом углу. Когда это около центра платы, левым кликом поместите его. Это 
должно смотреться примерно так: 

 

 
� Обратите внимание, что ratlines двигаются с корпусом. После того, как Вы поместили это, Вы, возможно, 

обратите внимание, что часть из ratlines изменили своё подключение к штырькам. Это потому что FreePCB 
автоматически оптимизирует ratlines для минимизации полной длины после перемещения корпуса. 

 
 
 



� Теперь давайте поместим другие DIP ИС, U1 и Y1, как показано здесь: 
 

 
� Теперь поместите DIP разъёмы вокруг краев платы, как показано здесь: 

 

 
Поскольку Вы помещаете корпуса, это - хорошая идея смотреть на ratlines, чтобы попытаться найти оптимальное 
размещение для легкой разводки. Однако, Вы должны не обязательно видеть во всех ratlines. На этой плате мы 
будем использовать внутреннии слои для VCC и GND соединений. Поэтому, мы могли бы также сделать ratlines 
для этих соединений невидимым. 



� Выберите Nets... из меню Project. Следующий диалог должен появиться: 
 

 
Большая часть диалога занята списком всех сетей. Номер штырьков и дорожки и перехода размеры для каждого 
соединения показаны рядом с названием соединения. Кроме того, налево от каждого названия переключатель, 
который определяет видимость ratlines соединения. В настоящее время, все соединения видимы. Чтобы сделать 
VCC и GND невидимыми, отмените выбор поля рядом с ними. Тогда нажмите OK. Теперь стало меньше видимых 
ratlines. 
 

 
 



� Теперь поместите остальную часть корпусов. Как упомянуто выше, выбор маленького корпуса 
конденсаторов поверхностного монтажа может быть хитрым, если Вы не помещаете курсор точно между 
пложадками, или используете метод с двумя щелчками. Вы можете хотеть использовать мелкую сетку 
размещения Placement, такую как 50 mils. Поскольку Вы помещаете каждый корпус, Вам, вероятно, 
придется переместить другие части вокруг, чтобы создать место или улучшить эффективность 
подключений. Попытайтесь не переполнить вещи слишком много. На реальной жизни плотно заполнил 
плату, размещение корпусов может быть важным по отношению к успешной разводке, таким образом это 
платит занятым временем, чтобы понять это правильно. Это не должно быть большой частью проблемы на 
этой плате, как бы то ни было. 

� Вы можете видеть мое конечное размещение корпусов ниже. Отметьте, что я переместил U2 направо от 
U1, чтобы сократить ratlines между этими корпусами. 

 

 
� Теперь, давайте позиционируем позиционные обозначения для корпусов на слое шелкового экрана, таким 

образом они будут правильно ориентированный и видимый, когда корпуса спаяны на. Во-первых, 
установите сетку размещения Placement в маленькое значение, такое как 10 mils, для более тонкого 
контроля размещения этих маленьких элементов. Выберите каждое позиционное обозначение, нажимая на 
него, и переместите его с клавишей F4. Как с корпусами, F3 вращает позиционное обозначение, 
перемещаясь. 

� Так как позиционные обозначения для монтажных отверстий не очень полезны, Вы можете сделать их 
невидимый, выбирая их и нажимая F5 ("Set Size"), и затем обнулив их размер. Так как они 
позиционированы непосредственно по площадкам для монтажных отверстий, Вы вероятно не будете в 
состоянии выбрать их, нажимая на них, так как Вы получите или корпус или штырек вместо этого. 
Поэтому, используйте маску выбора, чтобы отключить выбор корпусов и/или штырьков, и затем нажать на 
позиционное обозначение. Альтернативно, с выбранным корпусом монтажного отверстия, выберите Set 
Ref. Text Size из меню правого клика. Это также, как Вы сделали бы их видимыми снова, увеличивая их 
размер. 

 
 
 



Вот конечный скриншот. 
 

 
 



7.7 Добавление корпусов и редактирование соединений  
Изменение проекта PCB через добавление, замену или удаление корпусов или изменение списка соединений, 
иногда упоминается как редактирование "на лету". FreePCB дает Вам фактически неограниченную свободу для 
этого типа редактирования. Однако, Вы должны использовать эту свободу осторожно. Имейте в виду, что, изменяя 
partlist и список соединений, Вы создаете несоответствие между своей схемой размещения PCB и схемным 
оригиналом. Если вы делаете любые значимые изменения вы должны осторожно обратно вносить их в схему, в 
противном случае диагностика PCB может стать кошмаром. Вообще, "оперативное" редактирование лучше всего 
используется для относительно незначительных изменений. Если вы нуждаетесь выполнять более обширные 
переработки, вы должны вероятно возвращаться в ваш схемный редактор и создавать новый файл списка 
соединений.  
В этой части мы добавим три блокировочных конденсатора к нашему PCB, один для каждого DIP корпуса. Мы 
подключим их с VCC и GND соединениям. Так как FreePCB обеспечивает несколько методов для того, чтобы они 
сделали это, мы будем судить их все. 

� Установите сетку размещения в разумное значение для конденсаторов поверхностного монтажа, таких как 
50 mils.  

� Выберите Parts... из меню Project. Диалог View/Edit Part List должен появиться. 
 

 
� Отметьте, что последний конденсатор в списке корпусов - C4. Мы добавим C5, C6 и C7.  
� Нажмите Add New Part. Это вызовет диалог Add/Edit Part. 

 
 
 



 
� Разверните библиотеку sm_capacitor.fpl, кликая "+" знак рядом с ней.  
� Выберите отпечаток "C1206", кликнув по нему. Поле Footprint должно измениться на "C1206".  
� Введите "C5" в поле Reference. Теперь Вы должны видеть: 

 
  



Нажмите OK, чтобы добавить часть к partlist. 
� Теперь Вы вернетесь в диалог View/Edit Part List. Нажмите OK, чтобы выйти. Ваш новый конденсатор 

C5 будет видим слева от начала координат. 
 

 
Выберите C5, нажимая на него, и переместите его около вершины Y1. Переместите текст позиционного 
обозначения, если необходимый так, чтобы это было видимо. 
 

 



 



� Теперь мы подключим штырьки C5. Начнём, делая видимыми только соединения VCC и GND. Выберите 
Project > Nets..., чтобы поднять диалог View/Edit Netlist. 

 

 
Нажмите кнопку Make all visible/invisible дважды, чтобы очистить все переключатели и сделать все соединения 
невидимыми. Затем нажмите на поле для VCC и GND, чтобы сделать эти соединения видимыми. Затем нажмите 
OK. Теперь только VCC и GND ratlines видимы, как показано. 
 



 



� Нажмите на крайнюю справа площадку C5, чтобы выбрать её. Это будет штырёк 2, если Вы не вращали 
корпус. Нажмите F1 ("Set Net"), чтобы появился следующий диалог: 

 

 
� От раскрывающегося меню, выберите VCC, или только напечатайте "VCC" в текстовое поле. Нажмите OK, 

чтобы соединить штырек. Нажмите F8 ("Recalc. Ratlines"), чтобы повторно вычислить ratlines для VCC, 
чтобы включать новый штырек C5.2. 

� Теперь выберите крайнюю левую площадку C5, и повторите вышеупомянутую процедуру, чтобы 
подключить это с GND. Теперь Вы должен видеть ratlines на обе площадки C5. 

 

 
Давайте использовать немного различный метод, чтобы добавить C6. Выберите Add > Part. Диалог Add/Edit Part 
выскочит. Это тот же самый диалог, что Вы вызвали ранее из диалога  View/Edit Partlist, за исключением того, что 
кнопка Drag to position теперь разрешена и выбрана. На сей раз, выберите C0805 для отпечатка нового корпуса. 
Введите C6 в поле Reference. 
 
 
 



 
� Нажать OK. Вы должны перетащить схему для C6. Поместите это около штырьков 19 и 20 U1, как 

показано. 
 

 
 



Мы подключим C6 к VCC и GND соединениям рисуя ratlines между штырьками. Выберите верхнюю площадку  C6, 
нажимая на неё. Затем нажмите F4 ("Connect Pin"). Вы должны запустить перетаскивать ratline от площадки. 
Переместите курсор по площадке для штырька 20 U1 (который присоединен к соединению VCC), и нажмите, чтобы 
подключить ratline с этим штырьком. Точно так же, подключите нижнюю площадку C6 к штырьку U1.19. Выберите 
C6, нажимая на нём, и нажмите F8 ("Recalc. Ratlines"), чтобы повторно вычислить ratlines для C6. Ваша схема 
размещения должна выглядеть следующим образом: 
 

 
� Наконец, добавьте C7 используя Add > Part, тем же самым способом, которым мы добавили C6. 

Поместите это около вершины U2, так же как мы поместили C5 около вершины Y1. 
 
 
 



Теперь давайте подключим это к VCC и GND используя Project > Nets..., вызовем диалог View/Edit Netlist. Тогда 
выберите сеть VCC, нажимая на неё, как показано. 
 

 
Теперь нажмите на Edit selection. Появится диалог Add/Edit Net. 
 

� Введите C7.2 в текстовое поле рядом с кнопкой 
Add Pin. Затем нажмите на Add Pin. C7.2 должен 
быть добавлен к списку Pin list. Нажмите OK, 
чтобы принять это. Это возвратит Вас к диалогу 
View/Edit Netlist. 

� Теперь выберите GND соединение, нажимая на это, 
и редактируя список штырька так же, как Вы 
сделали для VCC, на сей раз добавляя C7.1. 

� Совет: Когда Вы добавляете штырек к соединению  
используя диалог Add/Edit Net, убедитесь, что Вы 
кликнули на Add Pin. Не просто кликнуть на OK, 
который выходит из диалога, не добавляя штырек. 

 
 
 



Нажмите F8 ("Recalc. Ratlines"), чтобы добавить ratlines к недавно добавленным штырькам. Схема размещения 
должна теперь смотреться как: 
 

 
В следующей части мы будем использовать медные области и обрубленные дорожки, чтобы создать мощность и 
плоскости для VCC и GND. 
 
 
 



7.8 Добавление медных областей 
В этой части, мы создадим медные области на внутренних слоях для плоскостей питания и земли. 

� Выберите Project > Nets.... Диалог View/Edit Netlist должен появиться. Если Вы продолжаете от 
последней части, только VCC и GND соединения будет видимы, как показано. 

 

 
� Нажмите на Make all visible/invisible один или два раза, чтобы сделать все сети невидимыми. Тогда 

нажмите на переключателе GND, чтобы сделать только это соединение видимым. 
� Обратите внимание, что ширина дорожки для каждого соединения "0". Это означает, что проектное 

значение по умолчанию 10 mils будет использовано. Давайте изменим ширину следа для GND к 15 mils. 
 

� Выберите соединение GND, нажимая на ее имя, 
который должен подсветить это. Тогда нажмите на 
кнопку Change widths. Следующий диалог 
должен появиться. 

� Выберите "15" для новой ширины соединения 
GND выбирая то значение из раскрывающегося 
меню, или вводят "15" в текстовое поле. Оставьте 
Use default via for this trace width радиокнопку 
выбранной. Если мы хотим отменить значение по 
умолчанию для перехода, то мы можем выбрать 
Set via widths вместо этого, и установить  ширину 
перехода и размер отверстия явно в текстовых 
полях. Нажмите OK, чтобы выйти из диалога. 

 
 

 



Диалог View/Edit Netlist должен теперь быть похожим: 
 

 
Нажмите OK, чтобы выйти из диалога. Окно схемы размещения должно теперь показать только ratlines для 
соединения GND, как показано. 
 

 
 



Теперь мы добавим медную область для плоскости GND. Во-первых, установите сетку разводки  в 50 mils. Затем 
выберите Add > Copper Area. Следующий диалог должен появиться. 
 

 
Мы будем использовать "inner 1" медный слой для плоскости GND. Выберите "GND" из Net  раскрывающегося 
списка, или тип "GND" в текстовое поле. Выберите "inner 1" из списка Layer. Установите шаблон штриховки Full. 

 
 
 



� Нажмите OK, чтобы выйти из диалога и начать тянуть ломаную линию для медной области. Курсор 
должен изменится на перекрестие. Мы хотим потянуть контур медной области 50 mils внутри контура 
платы. Поместите курсор в левый нижний угол медной области, которая будет в X = 50, Y = 50. Левым 
нажатием поместить первый угол. Затем переместите курсор в X = 50, Y = 1950 и левым щелчком 
поместить второй угол. Поместите третий угол в X = 2950, Y = 1950 и четвертый угол в X = 2950, Y = 50. 
После размещения четвертого угла, щелкните правой кнопкой мыши, чтобы замкнуть ломаную линию. 
Теперь Ваша плата должна быть похожей: 

 

 
�  Обратите внимание, что медная область была оттянута с диагональным шаблоном штриховки, в цвете для 

слоя, "inner 1". Кроме того, большинство ratlines для соединения GND исчезло, и символы X-shaped в цвете 
ratline появились на штырьках через отверстие в соединение. Они указывают внутренние подключения 
этих штырьков к области меди GND, используя металлизированные отверстия с тепловым облегчением. 

� Мы все еще должны подключить штырьки SMT с областью меди GND. Для этого мы будем использовать 
обрубленные дорожки stud traces, которые являются короткими дорожками, которые начинаются на 
штырьке и заканчиваются на переходе в плоскость GND. 

� Давайте нвчнём c нижнего штырька C1. Выберите штырек, кликнув по нему. Белый блок с "X" через это 
должно появиться вокруг штырька, указывая, что он был выбран, и строка состояния должна содержать 
описание штырька. 

 
 
 



� Теперь начинайте тянуть обрубленную дорожку, нажав F3 ("Start Stub"). Курсор должен измениться на 
крест и Вы будете перетаскивать конец сегмента дорожки от штырька, на верхнем медном слое. Вы можете 
увеличить масштаб прокручивая колёсико мышки или клавишей "Page Up". Переместите курсор короткое 
расстояние ниже штырька, и левым щелчком установите вершину. Затем щелкните правой кнопкой мыши, 
чтобы закончить дорожку. Переход должен появиться в вершине, как показано. Обратите внимание, что 
есть символ теплового облегчения на переходе, указывая внутреннее подключение с областью меди GND. 

 

 
� Если Вы недовольны своей дорожкой, Вы можете удалить его, выбирая сегмент дорожки или конечный 

переход и нажав F7 ("Delete Connection"). Вы можете переместить конечный переход, выбирая его и нажав 
F4 ("Move Vertex"). Вы можете добавить сегменты, выбирая конечный переход и нажав F2 ("Add 
Segment"). 

� Так как обрубленная дорожка обычно используются, чтобы подключить штырьки с медными областями на 
других слоях, конечный переход добавляется автоматически, когда Вы заканчиваете обрубленную 
дорожку. Если Вы хотите, Вы можете удалить переход, выбирав её и нажав F3 ("Delete Via"). Это может 
быть полезно, если Вы подключаете штырек с медной областью на том же самом слое, или если Вы 
используете обрубленную дорожку в некоторой другой цели, такой как дорожка экрана. 

 
 
 



Теперь, когда Вы знаете, как это делается, добавьте обрубленные дорожки ко всем штырькам SMT, у которых есть 
ratlines. Вы можете нуждаться переместить некоторые из спозиционных обозначений, чтобы сохранить их 
свободными от конечных переходов, так как это плохая практика, когда элемент шёлкового экрана накладывается 
на площадки или переходы. Ваша плата должна смотреться примерно так: 
 

 
� Поздравления, Вы теперь развели все соединения GND, которая является безусловно наибольшей сетью в 

проект. Медная область облегчила эту задачу. 
� Так как мы не будем делать никакой разводки на "inner 1" медном слое, и так как шаблон штриховки может 

буть раздражающим, когда мы работаем над другими слоями, давайте сделаем его невидимым. Выберите 
Layers из меню View, чтобы поднять диалог View/Edit Layers, и отключить переключатель Visible рядом с 
Inner 1. Нажмите OK, и медная область должна исчезнуть. Альтернативно, мы можем изменить шаблон 
штриховки, выбирая сторону и щелкая правой кнопкой мыши, затем выбирая Hatch style в контекстном 
меню. 

� Теперь, давайте добавим медную область для соединения VCC на "inner 2" медном слое. Вы только 
должны повториться те же самые шаги, которые Вы выполнили для области GND. Они: 
� Сделайте соединение VCC видиммым.  
� Измените ширину дорожки VCC на 15 mils.  
� Потяните медную область VCC на "inner 2" слое (Вы можете использовать те же самые угловые 

позиции как для область GND).  
� Добавьте обрубленные дорожки для всех площадок SMT на соединении VCC. Должно быть четыре, на 

C1, C5, C6 и C7.  
� Сделайте "inner 2" слой невидимым. 

 
 



� Выберите Project > Nets..., чтобы начать диалог View/Edit Netlist. Сделайте VCC и GND видимыми. Ваша 
плата должна быть похожей: 

 

 
В следующей части мы разведём остальную часть соединений на верхних и нижних медных слоях. 
 
 
 



7.9 Разводка 
Хорошо, давайте разведём наш PCB. Перед началом Вы могли бы хотеть сделать обзор Части 5.13: Соединения, 
Ratlines и Разводка. 
 

� Дополнительно: Если Вы хотите попробовать некоторые из ratline особенностей редактирования, которые 
были описаны в Части 5.13: Соединения, Ratlines и Разводка: 
� Сначала сохраним Ваш проект, таким образом Вы можете перезагрузить это, если что-то испортите.  
� Из меню, выберите Project > Nets..., чтобы вызвать диалог View/Edit Netlist. Сделайте все соединения 

невидимыми кроме GND. 
� Выберите ratline и удалите это, нажимая F7 ("Delete Connect"). Затем нажмите F8 ("Recalc. Ratlines"), и 

ratline должен вновь появиться. 
� Вы можете добавить новый ratline между штырьками на том же самом соединении, выбирая один из 

штырьков, и используя F4 ("Connect Pin"), который позволяет Вам тянуть ratline к другому штырьку. 
Тогда нажмите F3 ("Lock Connect"), чтобы блокировать это. Теперь, если Вы нажимаете F8 ("Recalc. 
Ratlines"), некоторый другой ratline на сети должен исчезнуть. 

� Вы можете разблокировать блокированное подключение с F3. Затем, если Вы нажимаете F8, 
подключения должны вернуться назад к их оригинальному состоянию. 

� OK, назад к делу. Используйте диалог View/Edit Netlist, чтобы сделать все сети видимыми.  
� В случае необходимости, используйте диалог View/Edit Layers, чтобы сделать медные слои inner1 и inner2 

невидимыми 
� Теперь Ваша плата должна смотреть примерно так: 

 
 
 



� Выберите разумно маленькое значение для сетки разводки, такой как 10 mils.  
� Мы будем разводить дорожки на верхнем и нижнем медных слоях, так как inner1 и inner2 использоваys для 

VCC и GND плоскостей. В настоящее время активный уровень показан на строке состояния ("Top" в 
скриншоте выше). Нажмите "4" клавиша, чтобы переключиться на нижний слой (так как есть 4 слоя). 
Нажмите "1" клавиша, чтобы переключиться назад на верхний слой. Клавиши "2" и "3" выбрали бы 
внутренние (inner) слои. 

� Теперь выберите одну из длиннейших ratlines, такую как одна в низу слева от JP4.8 к U1.14. Нажмите F4 
("Route Segment"), чтобы начать разводку. Курсор должен измениться на перекрестие, и Вы будете 
перетаскивать сегмент дорожки от того штырька, который был ближайшим к курсору, когда Вы нажали F4. 
Так как активный слой - "Top", сегмент дорожки будет окрашен в зелёный. Обратите внимание, что угол 
сегмента фиксируется по углом кратным 45 градусов. 

� Поместите первую вершину в дорожку, левым кликом мышки. Теперь Вы будете перетаскивать новый 
сегмент от вершины. Нажмите "4", чтобы переключиться на нижний слой. Сегмент станет красным, и 
переход должен появиться в вершине. 

� Продолжите добавлять сегменты, пока Вы не готовы завершить дорожку при рисунке сегмента на 
последней вершине в конечном штырьке. Нажмите F4 ("Complete Segment"), чтобы добавить последний 
сегмент, или только лево-нажать на конечном штырьке. Ваша дорожка должна смотреться примерно так 
как показано на скриншоте ниже. Обратите внимание, что я использовал больше сегментов и переходов 
чем необходимо. 

 

 
 



� Теперь давайте попытаемся редактировать дорожку, которую Вы только протянули. Выберите одну из 
вершины, нажимая на неё. Маленький белый блок вокруг этого указывает, что это было выбрано, и 
информация о вершине должна появиться в строке состояния. Опции редактирования для вершины: 
� F1 ("Set Position") - выскакивает диалог, чтобы явно установить X и Y координаты вершины.  
� F4 ("Move Vertex") - запускает перемещение вершины, перетаскивая это с мышью. Ломаный угол не 

будет  действовать, но сетка разводки будет.  
� F5 ("Delete Vertex") - удаляет вершину, и отменяет разводку для двух смежных сегментов, которые 

будут заменены единственным сегментом ratline.  
� F6 ("Unroute trace") — отменяет разводку всей дорожки, которая возвращается к ratline.  
� F7 ("Delete Connect") - удаляет дорожку, не заменяя её ratline.  
� F8 ("Recalc. Ratlines") - восстанавливают ratlines для соединения. 

� Теперь выберите один из сегментов дорожки, который должен побледнеть, указывая, что он был выбран. 
Опции редактирования для сегмента дорожки: 
� F1 ("Set Width") - выскакивает диалог, разрешающий Вам установить ширину соединения, дорожки 

или сегмента дорожки.  
� F5 ("Unroute Segment") - заменяют сегмент на ratline.  
� F6 ("Unroute trace") — отменяет разводку всей дорожки, которая возвращается к ratline.  
� F7 ("Delete Connect") - удалть дорожку, не заменяя её на ratline.  
� F8 ("Recalc. Ratlines") - восстанавливают ratlines для соединения. 

� Большинство этих опций редактирования довольно очевидны, таким образом Вы можете испытать их 
самостоятельно. Попробовать удаление вершины или сегмента дорожки, и затем изменяя маршрут 
получающийся ratline. Ratlines между вершиной направлены точно так же как ratlines между штырьками. 

 
 
 



� Теперь давайте изменим размеры некоторых дорожек. Раскройте окно на компонентах в верхнем левом 
углу, как это: 

 
� Дорожки между JP6, D1, R3, C2 и U3 — мощные дорожки и поэтому давайте сделаем их шире чем 

значение по умолчанию 10 mils. Выберите ratline между JP6.1 и D1.1. Строка состояния должна указать, 
что это - соединение "N00534". Нажмите F1 ("Set Width"). Следующий диалог должен выскочить: 

 

 
 У раскрывающегося меню для Trace width (mils) есть две опции, 10 и 15 mils. Давайте используем 20 mils вместо 
этого, печатая "20" непосредственно в текстовое поле. Нажмите OK, чтобы выйти из диалога. 
 



� Теперь разведите дорожку. Так как D1 - корпус SMT, сегмент дорожки, который соединяется с D1.1, 
должен быть на верхнем слое. Если Вы начнёте разводку от этого штырька, то активный слой будет 
автоматически установлен в  "Top". Если Вы начинаете разводку от JP6.1, который является штырьком 
через отверстие, Вы можете начать или на "Top" или на "Bottom", но Вы должны быть на "Top", чтобы 
завершить дорожку к D1.1. 

Точно так же, установите ширину других дорожек мощности к 20 mils и разведите их. Ваша плата должен быть 
похожей: 
 

 
 



Теперь разведите остальную часть дорожек на плате. Не стесняйтесь творчества с размерами дорожки и разводкой, 
если Вам нравится. Если бы мы фактически собирались произвести плату, то это могло бы выглядеть примерно как  
это. 
 

 
 



7.10 Добавление Текста 
Чтобы завершить наш шедевр, давайте добавим некоторый текст на верхнем слое шелкового экрана, чтобы 
идентифицировать плату. 

� Выбрать Text из меню Add, чтобы выскочил диалог Add/Edit Free Text. 

 
� Введите "Motor Controller" в поле Text. Удостоверьтесь что 

Units установлены в "MIL". Введите "100" в поле Uppercase 
Height, как показано ниже. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
� Нажать OK. Вы перетащите прямоугольник, который представляет рамку редактирования для текста. 



Поместите эту недалеко от низа PCB, и лево-щелчок. 
 

 
Это завершает нашу схему размещения PCB. В следующей части мы будем создавать файлы Gerber и сверловки, 
которые Вы послали бы изготовителю, чтобы изготовить Вашу плату. 
 
 



7.11 Проверка правил проекта 
Design Rules Правил Проекта - ряд правил, которые устанавливают минимальные пределы для размерностей, таких 
как ширина дорожки и зазоры. Они необходимы, потому что производственный процесс PCB подвергается 
определенным ограничениям и допускам, и проект должен учесть это. Например, Вы не можете использовать 
ширину дорожки 1 mil в Вашей схеме размещения, потому что физически невозможно протравить их достоверно. 
Если у Вас есть свой PCBs, сделанный для Вас, производитель платы должен обеспечить правила проекта, 
основанные на их процессе. Например, Advanced Circuits рекомендует следующее для их дешевого процесса: 
 

Minimum trace width  
Минимальная ширина дорожки  

0.008 inch (0.2032 мм) 

Minimum clearance between copper features  
Минимальный зазор между медью 

0.008 inch (0.2032 мм) 

Minimum distance from copper to edge of PCB  
Минимальное расстояние от меди до края платы 

0.014 inch (0.3556 мм) 

Minimum annular ring width (pins)  
Минимальная ширина дужки для штырьков 

0.007 inch (0.1778 мм) 

Minimum annular ring width (vias)  
Минимальная ширина дужки для переходов 

0.005 inch (0.127 мм) 

Minimum silkscreen line width  
Минимальная ширина линии шелкографии 

0.008 inch (0.2032 мм) 

 
Программа контроля правил проектирования (Design Rule Checker или DRC) является инструментом, который Вы 
можете использовать, чтобы удостовериться, что Ваш проект не содержит нарушений этих правил. Они 
упоминаются как Ошибки (Errors) DRC. Так как Ваш учебный проект, может не содержать ошибок DRC, я 
предложил бы, чтобы Вы закрыли свой проект и вместо этого открыли C:\freepcb\tutorial\motor_drc_errors.fpc, как 
показано ниже. Это содержит несколько типичных ошибок. См., можете ли Вы определить их. 
 



 
 



Теперь давайте выполним Программу контроля правил проектирования. Вы можете начать это, выбирав пункт 
меню Tools > Design Rule Check. Это вызовет следующий диалог: 
 

 
Мы изменим поля в диалоге, чтобы соответствовать Advanced Circuits значениям. Trace width(Ширина дорожки) 
должна быть установлена в 8 mils. Значения pad to pad, pad to trace, trace to trace и copper area to copper area 
должны быть установлены в 8 mils. annular ring (pins) значение должно быть установлено в 7 mils, и annular ring 
(vias) значение, должно быть установлено в 5 mils. board edge to any copper полю должен быть установлен в 14 
mils. hole to pad or trace, board edge to hole и hole to hole значения не даны, что позволяет нам использовать 25 
mils, которые кажутся разумными. Ваш диалог должен быть похожим: 
 



 
Теперь нажмите OK, чтобы выполнить проверку. Новый диалог должен выскочить со списком ошибок, как 
показано ниже. 
 

 
Ошибки 0 и 1 являются нарушениями минимального зазора между площадками и краем платы. Ошибки 2 и 3 
являются нарушениями зазора дорожки и площадки. Если Вы будете пристально смотреть на окно схемы 
размещения, то Вы будете видеть, что символы, состоящие из маленьких оранжевых колец, были помещены на 
сайте каждой ошибки, как показано ниже. 
 



 
Эти маленькие круги могут быть трудно различимыми, но если Вы нажимаете "d" на клавиатуре, они становятся 
намного большими сплошными кругами, как показано. 
 

 
Теперь раскройте окно на одной из ошибок, таких как тот в U1.16. 



 

 
Нажмите на кольцо ошибки DRC, чтобы подсветить его. Элементы PCB, которые вызвали нарушение, будут также 
подсвечены, как показано. Кроме того, описание ошибки появится в строке состояния. 
 
 

В этом случае, ошибкой является нарушение зазора 
между площадкой U1.16 и сегментом дорожки, 
проходящим через это, которые не находятся на 
той же самой связи. Ой! 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Вы можете исправить ошибку, изменяя маршрут 
дорожки, чтобы избежать площадки, как показано. 
Отметьте, что символ ошибки DRC автоматически не 
исчезает, но Вы можете удалить его, выбирая его и 
нажимая клавишу "Delete", или делая повторный 
запуск Программы контроля правил проектирования. 
 
 
 



Теперь давайте раскроем окно на Ошибках DRC на левой стороне платы, и давайте выберем одну из них. 
 

 
В этом случае, ошибка - нарушение зазора между площадкой и краем палаты. В основном, JP6 слишком близко к 
краю платы. Мы можем решить проблему, перемещая это далее направо, как показано. 
 

 
Я оставлю это до Вас, чтобы найти и установить последнюю ошибку. Тогда Вы можете выполнить Программу 
контроля правил проектирования снова, которая не должна найти ошибки. Вы должны перезагрузить свой проект 
motor.fpc прежде, чем начнёте следующую часть. Когда Вы закрываете проект motor_drc_errors.fpc, я предложил 
бы, чтобы Вы НЕ сохраняли свои изменения, таким образом Вы или кто - то еще можете использовать его снова. 
 
 
 



7.12 Созданий файлов сверловки и Gerber 
Конечный шаг в этом учебнике, делают файлы Gerber и файл сверловки, который Вы послали бы изготовителю 
PCB. Вы могли бы хотеть делать обзор Части 5.19: Экспорт файлов сверловки и Gerber перед продолжением. 
Выберите Generate CAM files... из меню File. "CAM" - акроним для "Computer-Aided 
Manufacturing (Автоматизация производства)". Следующий диалог должен появиться. 
 

 
В секции Files, выберите файлы, которые Вы желаете создать, проверяя или непроверяя поля рядом с ними.  
В секции Gerber file options Вы можете выбрать: 

� Include board outline — добавляет контур платы к каждому файлу Gerber  
� Add moires - добавляет муаровые шаблоны (также названный "targets (цели)") к каждому файлу Gerber  
� Add layer description text - добавляет текстовую строку, описывающая слой к каждому файлу Gerber  
� Add pilot holes - добавляют пилотный отверстия к площадкам и переходам на верхнем и нижнем слоях 
� Use thermal reliefs for pins - использует тепловое облегчение для подключения штырьки через отверстие с 

медной областью  
� Use thermal reliefs for vias - использует тепловое облегчение для подключения перехода с медной 

областью  
� Make cutouts in solder mask for vias - делают открытия для площадок переходов в слоях маски припоя 

 
В секции Panelizing Вы можете выбрать количество копий, которые будут произведены в каждом направлении и 
интервале между копиями. 
 
 
 



Секция Gerber file dimensions позволяет Вам устанавливать числовые параметры для файлов Gerber. Когда Вы 
делаете реальную плату, Вы получили бы их от изготовителя PCB. Значения, показанные выше, довольно типичны 
для дешевого, многослойного процесса. 

� Copper to copper-fill clearance - зазор который будет создан вокруг дорожек и переходов которые 
проходят через медные области. 

� Hole-edge to copper-fill clearance - зазор который будет создан вокруг отверстий проходящих через 
медные области. 

� Solder mask clearance - зазор, который будет создан вокруг площадок и переходов в маске припоя. 
� Pilot hole diameter - диаметр пилотных отверстий в площадках, если Вы хотели включать их.  
� Minimum silkscreen stroke width - минимальная ширина дорожки, которая будет использоваться для 

элементов на слое шелкографии. 
� Thermal relief line width - ширина дорожек в тепловом облегчении, которое подключает площадки с 

медной областью. 
� Board outline line width - ширина дорожек используемых для рисования контура платы.  
� Annular ring width (pins) - ширина кольца помещённого во внутреннем слое вокруг штырька для теплового 

облегчения соединений. 
� Annular ring width (vias) - ширина кольца помещённого во внутреннем слое вокруг перехода для теплового 

облегчения соединений. 
� Shrink SMT pads for paste mask - сокращения размера площадки маски пасты. 

 
Output folder - папка получатель для файлов, которые будут созданы. По умолчанию, это - подпапка проектной 
папки, названной "CAM". Вы можете изменить это, если Вам хочется. Папка будет создана, если она не будет уже 
существовать (хотя его родительская папка должна существовать).  
Теперь нажмите Create files, чтобы сделать файлы. Следующий диалог должен появиться. 
 

 
 



Если были какие-нибудь ошибки, сообщения появятся в диалоге. Обычно, ошибка приведет к прерыванию FreePCB 
что файл и продолжающийся к следующему. Нажмите OK, чтобы отклонить диалог.  
Теперь Вы можете рассмотреть свой Gerber и сверловки файлы, используя Gerber Viewer, такие как ViewMate от 
PentaLogix (который свободен, и доступен здесь). ViewMate может также напечатать проверочную копию на 
Вашем принтере. Вы должны ВСЕГДА проверять свои файлы прежде, чем использовать их, чтобы сделать PCB. 
Кроме того, читайте Часть 5.20.3: Размеры сверла для важной информации о файле сверлоаки.  
Скриншоты файлов Gerber для верхнего шелкового экрана, верхнего и внутреннего 1 медных слоёв нашего 
учебного проекта показаны ниже. Они выглядят довольно сырыми в скриншотах. Чтобы ценить только, насколько 
точный они действительно, Вы должны открыть свои собственные файлы в ViewMate и раскрыть на некоторых из 
меньших особенностей. 
 

 

 
 



 
Хорошо, это - конец обучения. Я попытался покрыть большинство главных особенностей FreePCB. Теперь Вы 
должны быть готовы создать собственную плату. 
 
 



8. Форматы файла  
8.1 Проектных Файлов 
Проектный файл (*.fpc) - текстовый файл ASCII, содержащий всю информацию для единственного проекта. Это 
составлено из множественных секций, где каждая секция начинается с названия, окруженного квадратными 
скобками, такими как "[options]". В пределах каждой секции есть множественные элементы, где каждый элемент 
начинается с разграниченного двоеточием ключевого слова, такого как "units:". Там обычно будут один или более 
параметров после каждого ключевого слова. Могут также быть элементы, вложенные ниже других элементов. Эти 
отношения показывают, выравнивая строки за вложенные элементы.  
Параметры, которые следуют за ключевым словом, являются строками, разграниченными свободным местом. 
Чтобы позволить свободное место в пределах параметра, такого как пробел в пределах имени файла, первый 
параметр после ключевого слова может быть окружен двойными кавычками (например,"test file"), и свободное 
место между кавычками не будет считаться разделителем. Последующие параметры не могут содержать 
внедренное свободное место.  
Многие из параметров представляют размерности, такие как длины линии или размеры. По умолчанию, 
размерности выражены в нанометрах. Суффикс может быть добавлен к размерности, чтобы указать другие 
единицы измерения, такие как "100MM" или "23.5MIL". Для отпечатков есть элемент, названный "units:" который 
изменяет заданные по умолчанию единицы измерения для всех параметров отпечатка, так, чтобы суффиксы не 
требовались.  
Вот список всех секций и элементов, которые могут появиться в проектном файле. Для каждого элемента, ключеве 
слово показано, сопровождается списком параметров, где описание каждого параметра окружено "<>", 
опциональные элементы окружены "{}". Этот список является текущим на программную версию 1.327. 
 
[options] 
version: <the version number of the freepcb.exe application that created the file, such as "1.328"> 
file_version: <the version number of the oldest freepcb.exe application that can read the file, such as 
"1.312"> 
project_name: <the name of the project, usually the same as the project file name without the ".fpc" 
extension> 
full_library_folder: <the absolute path to the default library folder for the project> 
CAM_folder: <the absolute path to the folder for CAM files , or "" if not yet defined> 
ses_file_path: <the absolute path to the last .ses file imported , or "" if not yet defined> 
dsn_bounds_poly: <the board outline index used for the bounds for the .dsn file> 
dsn_signals_poly: <the board outline index used for the bounds for signals the .dsn file> 
autosave_interval: <the interval between autosaves in msec, or "0" if autosave disabled> 
netlist_import_flags: <the flags set in the last "import netlist" dialog> 
units: <the currently-selected units for the project, either "MM" or "MIL"> 
visible_grid_spacing: <the currently-selected visible grid spacing, in nanometers> 
       visible_grid_item: <the first item in the menu of visible grids> 
       visible_grid_item: <the next item in the menu of visible grids> 
         ... 
       visible_grid_item: <the last item in the menu of visible grids> 
placement_grid_spacing: <the currently-selected placement grid spacing, in nanometers> 
       placement_grid_item: <the first item in the menu of placement grids> 
       placement_grid_item: <the next item in the menu of placement grids> 
        ... 
       placement_grid_item: <the last item in the menu of placement grids> 
routing_grid_spacing: <the currently-selected routing grid spacing, in nanometers> 
       routing_grid_item: <the first item in the menu of routing grids> 
       routing_grid_item: <the next item in the menu of routing grids> 
        ... 
       routing_grid_item: <the last item in the menu of routing grids> 

 
 



snap_angle: <the currently-selected snap angle in degrees> 
fp_visible_grid_spacing: <the currently-selected visible grid spacing for the Footprint Editor, in 
nanometers> 
fp_visible_grid_item: <the first item in the menu of visible grids for the Footprint Editor> 
fp_visible_grid_item: <the next item in the menu of visible grids for the Footprint Editor> 
... 
fp_visible_grid_item: <the last item in the menu of visible grids for the Footprint Editor> 
fp_placement_grid_spacing: <the currently-selected placement grid spacing for the Footprint Editor, in 
nanometers> 
fp_placement_grid_item: <the first item in the menu of placement grids for the Footprint Editor> 
fp_placement_grid_item: <the next item in the menu of placement grids for the Footprint Editor> 
... 
fp_placement_grid_item: <the last item in the menu of placement grids for the Footprint Editor> 
fp_snap_angle: <the currently-selected snap angle for the Footprint Editor, in degrees> 
fill_clearance: <for Gerber files, the copper-copper clearance for copper areas> 
mask_clearance: <for Gerber files, the solder-mask clearance> 
thermal_width: <for Gerber files, the width of the cross-hairs for thermal reliefs> 
min_silkscreen_width: <for Gerber files, the minimum width of silk-screen lines> 
board_outline_width: <for Gerber files, the width of board-outline lines> 
hole_clearance: <for Gerber files, clearance from holes to copper areas> 
pilot_diameter: <for Gerber files, the pilot hole diameter> 
annular_ring_for_pins: <for Gerber files, the width of annular rings for through-hole pins> 
annular_ring_for_vias: <for Gerber files, the width of annular rings for vias> 
shrink_paste_mask: <for paste mask Gerber files, pad size reduction> 
cam_flags: <bitwise ORed flags for CAM options> 
cam_layers: <bitwise ORed flags for CAM files to generate> 
cam_drill_file: <flag to make a drill file> 
cam_units: <units to use for CAM parameters in dialog> 
cam_n_x: <for panelizing, number of boards horizontally> 
cam_n_y: <for panelizing, number of boards vertically> 
cam_space_x: <for panelizing, horizontal spacing of boards> 
cam_space_y: <for panelizing, vertical spacing of boards> 
drc_check_unrouted: <flag to treat unrouted connections as DRC errors> 
drc_trace_width: <minimum trace width for DRC> 
drc_pad_pad: <minimum pad-pad clearance for DRC> 
drc_pad_trace: <minimum pad-trace clearance for DRC> 
drc_trace_trace: <minimum trace-trace clearance for DRC> 
drc_hole_copper: <minimum hole-copper clearance for DRC> 
drc_annular_ring_pins: <minimum annular ring width for pins for DRC> 
drc_annular_ring_vias: <minimum annular ring width for vias for DRC> 
drc_board_edge_copper: <minimum copper-board_edge clearance for DRC> 
drc_board_edge_hole: <minimum hole-board_edge clearance for DRC> 
drc_hole_hole: <minimum hole-hole clearance for DRC> 
drc_copper_copper: <minimum copper_area-copper_area clearance for DRC> 
default_trace_width: <default trace width for project> 
default_via_pad_width: <default via pad width for project> 
 

 



default_via_hole_width: <default via hole diameter for project> 
n_width_menu: <number of trace width menu items> 
width_menu_item: <index of first item> <trace width> <via pad width> <via hole diameter> 
width_menu_item: <index of this item> <trace width> <via pad width> <via hole diameter> 
... 
width_menu_item: <index of last item> <trace width> <via pad width> <via hole diameter> 
n_copper_layers: <number of copper layers in project> 
layer_info: <name of first layer> <index into layer array> <color: red> <color: green> <color: blue> 
<flag if visible> 
layer_info: <name of next layer> <index into layer array> <color: red> <color: green> <color: blue> 
<flag if visible> 
... 
layer_info: <name of last layer> <index into layer array> <color: red> <color: green> <color: blue> 
<flag if visible> 
[footprints] 
name: <name of footprint> 
{author: <name of author>} 
{source: <description of source>} 
{description: <description of footprint>} 
units: <units: "NM", "MM" or "MIL"> 
sel_rect: <for selection rectangle: left> <bottom> <right> <top> 
ref_text: <for reference text: height> <left> <bottom> <angle> <line width> 
{text: <text string> <height> <x> <y> <angle> <line width> <flag if mirrored> <layer>} 
... 
{outline_polyline: <line width> <starting x> <starting y> 
next_corner: <next x> <next y> <side style> 
next_corner: <next x> <next y> <side style> 
... 
close_polyline: <if closed polyline, last side style>} 
... 
n_pins: <number of pins> 
pin: <pin name> <hole_diameter> <x> <y> <angle> 
top_pad: <shape> <width> <length/2> <length/2> <corner radius> 
inner_pad: <shape> <width> <length/2> <length/2> <corner radius> 
bottom_pad: <shape> <width> <length/2> <length/2> <corner radius> 
pin: <pin name> <hole_diameter> <x> <y> <angle> 
top_pad: <shape> <width> <length/2> <length/2> <corner radius> 
inner_pad: <shape> <width> <length/2> <length/2> <corner radius> 
bottom_pad: <shape> <width> <length/2> <length/2> <corner radius> 
.... 
pin: <pin name> <hole_diameter> <x> <y> <angle> 
top_pad: <shape> <width> <length/2> <length/2> <corner radius> 
inner_pad: <shape> <width> <length/2> <length/2> <corner radius> 
bottom_pad: <shape> <width> <length/2> <length/2> <corner radius> 
[board] 
outline: <number of corners in board outline> <outline index> 
corner: <index> <x> <y> <style of next side> 
corner: <index> <x> <y> <style of next side> 
... 
corner: <index> <x> <y> <style of next side> 
... 
[solder_mask_cutouts] 
sm_cutout: <number of corners in solder mask cutout> <fill style> <layer> 
corner: <index> <x> <y> <style of next side> 
corner: <index> <x> <y> <style of next side> 
... 
corner: <index> <x> <y> <style of next side> 
... 

 



[parts] 
part: <reference designator> 
ref_text: <height> <line width> <angle> <x> <y> 
package: <package identifier from netlist file, or ""> 
shape: <footprint name> 
pos: <position: x> <y> <side> <angle> <flag if glued> 
[nets] 
net: <name of net> <# pins> <# connections> <# areas> <default trace width> <default via pad width> 
<default via hole dia> <visibility> 
pin: <index of first pin in net> <name, such "U1.5"> 
pin: <index of next pin in net> <name, such "U1.5"> 
... 
pin: <index of last pin in net> <name, such "U1.5"> 
connect: <index of this connection> <index of start pin> <index of end pin> <# segments> <flag if 
locked> 
vtx: <first trace vertex: index> <x> <y> <first/last vertex, pad layer> <force via flag> <via pad 
width> <via hole dia> <tee id> 
seg: <first trace segment: index> <layer> <width> <via width> <via hole diameter> 
vtx: <next trace vertex: index> <x> <y> <first/last vertex, pad layer> <force via flag> <via pad width> 
<via hole dia> <tee id> 
seg: <next trace segment: index> <layer> <width> <via width> <via hole diameter> 
... 
seg: <last trace segment: index> <layer> <width> <via width> <via hole diameter> 
vtx: <last trace vertex: index> <x> <y> <first/last vertex, pad layer> <force via flag> <via pad width> 
<via hole dia> <tee id> 
area: <index of this copper area> <# corners> <layer> <hatch style> 
corner: <index of first corner> <x> <y> <style of next side> <flag if last corner of this contour> 
corner: <index of next corner> <x> <y> <style of next side> <flag if last corner of this contour> 
... 
corner: <index of last corner> <x> <y> <style of next side> <flag if last corner of this contour> 
[texts] 
text: <text string> <x> <y> <layer> <angle> <mirror flag> <height> <line width> 
 

8.2 Библиотечные Файлы библиотечный файл (*.fpl) являются текстовым файлом ASCII, содержащим одну или 
более занимаемых площадей. Формат для этого файла - точно то же самое как [занимаемые площади] секция 
проектного файла, описанного выше. 
 
8.3 Конфигурация Регистрирует файл конфигурации (default.cfg), текстовый файл ASCII, содержащий заданные по 
умолчанию параметры, которые используются для новых проектов. Это расположено в той же самой папке как 
выполнимая программа "freepcb.exe". Это использует точно тот же самый формат как [опции] секция проектного 
файла, как описано выше, с 2 дополнительными элементами: 
 
parent_folder: <абсолютный или относительный путь к заданной по умолчанию родительской папке для новых 
проектов> library_folder: <абсолютный или относительный путь к заданной по умолчанию библиотечной папке для 
новых проектов> 
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9. Объявление об авторском праве Лицензии: 
 
FreePCB: редактор схемы размещения PCB Copyright (C) 2003, 2004 программой This Аллaна Райта является 
бесплатным программным обеспечением; Вы можете перераспределить это и/или изменить это в соответствии с 
Лицензией Широкой публики ГНУ как издано Фондом бесплатного программного обеспечения; или версия 2 
Лицензии, или (в Вашей опции) любая более поздняя версия. Эта программа распространена в надежде, что это 
будет полезно, но БЕЗ ЛЮБОЙ ГАРАНТИИ; без даже подразумеваемой гарантии 
 
ВЫСОКИЙ СПРОС или ПРИГОДНОСТЬ В СПЕЦИФИЧЕСКОЙ ЦЕЛИ. Лицензия Широкой публики ГНУ для 
большего количества подробностей. См. 
 
Вы должны были получить копию Лицензии Широкой публики ГНУ наряду с этой программой; в противном 
случае напишите Фонду бесплатного программного обеспечения, Inc., 59 Мест Храма - Набор программ 330, 
Бостон, Массачусетс 02111-1307, США. Полные сроки и условия Лицензии Широкой публики ГНУ следуют. 
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Лицензия Широкой публики ГНУ 
 
· · · · · · · 
 
[Чешский язык | английский язык | японский язык], Что сделать, если Вы видите возможные Трансляции 
нарушения GPL GPL GPL Часто задаваемые вопросы Лицензия Широкой публики ГНУ (GPL) в Лицензии 
Широкой публики ГНУ формата The открытого текста (GPL) в формате Texinfo Лицензия Широкой публики ГНУ 
(GPL) в формате LaTeX Лицензия Широкой публики ГНУ (GPL) как приложение в формате DocBook 
 
Оглавление 
 
 ЛИЦЕНЗИЯ ШИРОКОЙ ПУБЛИКИ ГНУ 
 
   СРОКИ преамбулы И УСЛОВИЯ ДЛЯ ТОГО, ЧТОБЫ СКОПИРОВАТЬ, РАСПРЕДЕЛЕНИЕ И 
МОДИФИКАЦИЯ, Как Применить Эти Сроки к Вашей Новой Программе 
 
Версия 2 ЛИЦЕНЗИИ ШИРОКОЙ ПУБЛИКИ ГНУ, июнь 1991 
 
Copyright (C) 1989, 1991 Free Software Foundation, 59 Мест Храма Inc. - Набор программ 330, Бостон, Массачусетс 
02111-1307, США, Всем разрешают скопировать и распространить дословные копии этого документа лицензии, но 
изменение этого, не позволены. 
 
Преамбула лицензии для большинства программного обеспечения разработана, чтобы убрать Вашу свободу 
совместно использовать и изменить это. В отличие от этого, Лицензия Широкой публики ГНУ предназначена, 
чтобы гарантировать Вашу свободу совместно использовать и изменить свободное программное обеспечение - 
чтобы удостовериться, что программное обеспечение свободно для всех своих пользователей. Эта Лицензия 
Широкой публики относится к большей части программного обеспечения Фонда бесплатного программного 
обеспечения и любой другой программе, авторы которой передают использование этого. (Некоторое другое 
программное обеспечение Фонда бесплатного программного обеспечения охвачено Лицензией Широкой публики 
Библиотеки ГНУ вместо этого.) Вы можете применить это к своим программам, также. 
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Когда мы говорим о бесплатном программном обеспечении, мы обращаемся к свободе, не цене. Наши Лицензии 
Широкой публики разработаны, чтобы удостовериться, что у Вас есть свобода распространить копии бесплатного 
программного обеспечения (и взимать за этот сервис, если Вы желаете), что Вы получаете исходный текст или 
можете получить его, если Вы хотите его, что Вы можете изменить программное обеспечение или использовать 
части его в новых бесплатных программах; и это, Вы знаете Вас, может сделать эти вещи. Чтобы защитить Ваши 
права, мы должны сделать ограничения, которые запрещают любому отказывать Вам в этих правах или просить, 
чтобы Вы сдали права. Эти ограничения транслируют к определенным обязанностям за Вас, если Вы 
распространяете копии программного обеспечения, или если Вы изменяете его. Например, если Вы 
распространяете копии такой программы, или бесплатный или за плату, Вы должны дать получателям все права, 
которые Вы имеете. Вы должны удостовериться, что они, также, получают или могут получить исходный текст. И 
Вы должны показать им эти сроки, таким образом они знают свои права. Мы защищаем Ваши права с двумя 
шагами: (1) защищают авторским правом программное обеспечение, и (2) предложение Вы эта лицензия, которая 
дает Вам юридическое разрешение скопировать, распространяет и/или изменяет программное обеспечение. Кроме 
того, для защиты каждого автора и наш, мы хотим удостовериться, что все понимают, что нет никакой гарантии для 
этого бесплатного программного обеспечения. Если программное обеспечение изменено кем - то еще и передано, 
мы хотим, чтобы его получатели знали, что то, что они имеют, не является оригиналом, так, чтобы любые 
проблемы, введенные другими, не размышляли над репутациями оригинальных авторов. Наконец, любой 
бесплатной программе постоянно угрожают программные патенты. Мы желаем избежать опасности, что 
передистрибьюторы бесплатной программы индивидуально получат патентные лицензии, в действительности 
делая частную программу. Чтобы предотвратить это, мы прояснили, что любой патент должен лицензироваться для 
всеобщего свободного использования или не лицензироваться вообще. Точные сроки и условия для того, чтобы 
скопировать, распределение и модификация следуют. СРОКИ И УСЛОВИЯ ДЛЯ ТОГО, ЧТОБЫ СКОПИРОВАТЬ, 
РАСПРЕДЕЛЕНИЕ И МОДИФИКАЦИЯ 0. Эта Лицензия относится к любой программе или другой работе, 
которая содержит примечание, помещенное держателем авторского права, говорящим это, может быть 
распространен в соответствии с этой Лицензией Широкой публики. "Программа", ниже, обращается к любой такой 
программе или работе, и "работа, основанная на Программе", означает или Программу или любую производную 
работу согласно закону об авторском праве: то есть работа, содержащая Программу или часть этого, или дословный 
или с модификациями и/или оттранслированный в другой язык. (В дальнейшем, трансляция включена без 
ограничения в термине "модификация".) Каждое лицо, имеющее патент обращено как "Вы". Действия кроме 
копирования, распределения и модификации не охвачены этой Лицензией; они вне его области видимости. Годовая 
динамика изменений выполнения Программы не ограничена, и вывод от Программы покрыт, только если ее 
информационные наполнения составляют работу, основанную на Программе (независимый от того, чтобы быть 
сделанным, выполняя Программу). Является ли это истиной, зависит от того, что делает Программа. 1. Вы можете 
скопировать и распространить дословные копии исходного текста Программы, поскольку Вы получаете его, в 
любой передающей среде, при условии, что Вы заметно и соответственно издаете на каждой копии 
соответствующее объявление об авторском праве и оговорку гарантии; сохраните неповрежденным все 
примечания, которые ссылаются на эту Лицензию и на отсутствие любой гарантии; и дайте любым другим 
получателям Программы копию этой Лицензии наряду с Программой. Вы можете взыскать плату за физическую 
годовую динамику изменений передачи копии, и Вас, май в Вашей опции предлагает гарантийную защиту в обмен 
на плату. 2. Вы можете изменить свою копию или копии Программы или любую часть этого, таким образом 
формируя работу, основанную на Программе, и скопировать и распространить такие модификации или работу в 
соответствии с Секцией 1 выше, при условии, что Вы также удовлетворяете всем этим условиям: 
 
· a) Вы должны заставить измененные файлы нести видные примечания, заявляющие, что Вы изменили файлы и 
 
Руководство пользователя FreePCB - Версия 1.4 164 21 апреля 07 
 



 
· 
 
· 
 
дата любого изменения. b) Вы должны вызвать любую работу, которую Вы распространяете или издаете, это 
полностью или частично, содержит или получен из Программы или любой части этого, чтобы лицензироваться в 
целом бесплатно для всех третьих лиц в соответствии с этой Лицензией. c), Если измененная программа обычно 
читает команды в интерактивном режиме когда выполнено, Вы должны вызвать ее, когда начато работая для такого 
интерактивного использования самым обычным способом, чтобы напечатать или отобразить объявление включая 
соответствующее объявление об авторском праве и примечание, что нет никакой гарантии (или иначе, говоря, что 
Вы обеспечиваете гарантию), и что пользователи могут перераспределить программу при этих условиях, и 
сообщение пользователю, как рассмотреть копию этой Лицензии. (Исключение: если сама программа 
интерактивна, но обычно не печатает такое объявление, Ваша работа, основанная на Программе, не обязана 
печатать объявление.) 
 
Эти требования относятся к измененной работе в целом. Если опознаваемые секции той работы не получены из 
Программы, и могут разумно считаться независимыми и отдельными работами в себе, то эта Лицензия, и ее сроки, 
не относятся к тем секциям, когда Вы распространяете их как отдельные работы. Но когда Вы распространяете те 
же самые секции как часть целого, которое является работой, основанной на Программе, распределение целого 
должно быть на сроках этой Лицензии, разрешения которой для других лиц, имеющих патент простираются на все 
целое, и таким образом на каждую часть независимо от того, кто написал это. Таким образом, это не намерение 
этой секции требовать прав или оспорить Ваши права работать написанное полностью Вами; скорее намерение 
состоит в том, чтобы осуществить право управлять распределением производных или коллективных работ, 
основанных на Программе. Кроме того, простое соединение частей другой работы, не основанной на Программе с 
Программой (или с работой, основанной на Программе) на томе памяти или дистрибутивной передающей среды, не 
приносит другую работу под областью видимости этой Лицензии. 3. Вы можете скопировать и распространить 
Программу (или работа, основанная на этом, под Секцией 2) в объектном коде или выполнимой форме в 
соответствии с Секциями 1 и 2 выше при условии, что Вы также делаете одно из следующего: 
 
· 
 
· 
 
· 
 
a) Сопровождайте это с законченным соответствующим машинно-читаемым исходным текстом, который должен 
быть распространен в соответствии с Секциями 1 и 2 выше на передающей среде, обычно используемой для 
программного обмена; или, b) Сопровождают это с письменным предложением, действительным в течение по 
крайней мере трех лет, чтобы дать любому третьему лицу, для заряда не больше, чем Ваша стоимость физически 
выступающего исходного распределения, законченная машиночитаемая копия соответствующего исходного текста, 
быть распространенными в соответствии с Секциями 1 и 2 выше на передающей среде, обычно используемой для 
программного обмена; или, c) Сопровождают это с информацией, которую Вы получили относительно 
предложения распространить соответствующий исходный текст. (Эта альтернатива позволена только для 
некоммерческого распределения и только если Вы получили программу в объектном коде или выполнимой форме с 
таким предложением, в соответствии с Подразделом b выше.) 
 
Исходный текст для работы означает привилегированную форму работы для того, чтобы сделать модификации к 
этому. Для выполнимой работы законченный исходный текст означает весь исходный текст для всех модулей, 
которые это содержит, плюс любые связанные файлы определения интерфейса, плюс скрипты, используемые, 
чтобы управлять трансляцией и инсталляцией выполнимой программы. Однако, как специальное исключение, 
распространенный исходный текст не должен включать ничего, что обычно распространяется (или в источнике или 
в двухчастной форме) с главными компонентами (компилятор, ядро, и так далее) операционной системы, на 
которой выполняется выполнимая программа, если тот сам компонент не сопровождает выполнимую программу. 
Если распределение выполнимого или объектного кода сделано, предлагая доступ, чтобы скопировать с 
определяемого места, то, предлагая эквивалентный доступ, чтобы скопировать исходный текст от того же самого 
счета места как распределение исходного текста, даже при том, что третьи лица не вынуждены скопировать 
источник наряду с объектным кодом. Руководство пользователя FreePCB - Версия 1.4 165 21 апреля 07 
 



 
4. Вы не можете скопировать, изменить, сублицензировать, или распространить Программу кроме как явно 
обеспечено согласно этой Лицензии. Любая попытка иначе, чтобы скопировать, измените, сублицензируйте или 
распространите Программу, является пустым, и автоматически закончит Ваши права согласно этой Лицензии. 
Однако, сторонам, которые получили копии, или права, от Вас согласно этой Лицензии не будут заканчивать их 
лицензии, пока такие стороны остаются в полном согласии. 5. Вы не обязаны принимать эту Лицензию, так как Вы 
не подписали ее. Однако, ничто иное не предоставляет Вам разрешение изменить или распространить Программу 
или ее производные работы. Эти действия запрещены согласно закону, если Вы не принимаете эту Лицензию. 
Поэтому, изменяя или распространяя Программу (или любая работа, основанная на Программе), Вы указываете 
свое принятие этой Лицензии, чтобы сделать так, и все ее сроки и условия для того, чтобы скопировать, 
распространяя или изменяя Программу или работы, основанные на этом. 6. Каждый раз Вы перераспределяете 
Программу (или любая работа, основанная на Программе), получатель автоматически получает лицензию от 
оригинального лицензиара, чтобы скопировать, распространить или изменить Программу, подчиненную этим 
срокам и условиям. Вы не можете ввести дальнейшие ограничения для осуществления получателей прав, 
предоставленных здесь. Вы не ответственны за предписание согласия третьими лицами к этой Лицензии. 7. Если, 
как следствие решения суда или утверждения о доступном нарушении или по любой другой причине (не 
ограниченный, чтобы запатентовать проблемы), условия наложены на Вас (ли в соответствии с постановлением 
суда, соглашением или иначе), которые противоречат условиям этой Лицензии, они не извиняют Вас от условий 
этой Лицензии. Если Вы не можете распространить, чтобы удовлетворить одновременно Ваши обязательства 
согласно этой Лицензии и любые другие подходящие обязательства, то как следствие Вы не можете 
распространить Программу вообще. Например, если патентная лицензия не разрешила бы безгонорарное 
перераспределение Программы всеми те, кто получает копии прямо или косвенно через Вас, тогда единственный 
способ, которым Вы могли удовлетворить, и это и эта Лицензия должны будут воздержаться полностью от 
распределения Программы. Если какая-нибудь часть этой секции считается недействительной или не имеющей 
законной силы при каком-нибудь специфическом обстоятельстве, равновесие секции предназначено, чтобы 
примениться, и секция в целом предназначена, чтобы примениться при других обстоятельствах. Это не цель этой 
секции побудить Вас нарушать любые патенты или другие требования права собственности или оспаривать 
законность любых таких требований; у этой секции есть единственная цель защитить целостность свободной 
системы распространения программного обеспечения, которая осуществлена общественными действиями 
лицензии. Много людей сделали щедрые содействия широкому диапазону программного обеспечения 
распространенными через ту систему в уверенности относительно непротиворечивого приложения той системы; 
это до автора/дарителя, чтобы решить, желает ли он или она распространить программное обеспечение через 
любую другую систему, и лицо, имеющее патент не может наложить тот выбор. Эта секция предназначена, чтобы 
сделать полностью ясным, что, как полагают, является последствием остальной части этой Лицензии. 8. Если 
распределение и/или использование Программы ограничены в определенных странах или патентами или 
защищенными авторским правом интерфейсами, оригинальный держатель авторского права, который помещает 
Программу согласно этой Лицензии, может добавить явное географическое дистрибутивное ограничение, исключая 
те страны, так, чтобы в распределении разрешили только или среди стран, не таким образом исключенных. В таком 
случае эта Лицензия включает ограничение как будто написанный в теле этой Лицензии. 9. Фонд бесплатного 
программного обеспечения может издать пересмотренные и/или новые версии Лицензии Широкой публики время 
от времени. Такие новые версии будут подобны в духе существующей версии, но могут отличаться подробно, 
чтобы обратиться к новым проблемам или проблемам. Каждой версии дают различающий номер версии. Если 
Программа определяет номер версии этой Лицензии, которая относится к ней и "любая более поздняя версия", у 
Вас есть опция следующих за сроками и условиями или той версии или любой более поздней версии, изданной 
Фондом бесплатного программного обеспечения. Если Программа не определяет номер версии этой Лицензии, Вы 
можете выбрать любую версию, когда-либо издаваемую Фондом бесплатного программного обеспечения. 
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10. Если Вы желаете включить части Программы в другие бесплатные программы, дистрибутивные условия 
которых являются различными, напишите автору, чтобы попросить разрешение. Для программного обеспечения, 
которое защищено авторским правом Фондом бесплатного программного обеспечения, напишите Фонду 
бесплатного программного обеспечения; мы иногда делаем исключения для этого. Наше решение будет 
управляться двумя целями сохранения свободного состояния всех производных нашего бесплатного программного 
обеспечения и продвижения совместного использования и многократного использования программного 
обеспечения вообще. НИКАКАЯ ГАРАНТИЯ 11. ПОТОМУ ЧТО ПРОГРАММА ЛИЦЕНЗИРУЕТСЯ 
БЕСПЛАТНО, НЕТ НИКАКОЙ ГАРАНТИИ ДЛЯ ПРОГРАММЫ, ДО СТЕПЕНИ, РАЗРЕШЕННОЙ 
ДЕЙСТВУЮЩИМ ЗАКОНОДАТЕЛЬСТВОМ. КРОМЕ ТЕХ СЛУЧАЕВ, КОГДА ИНАЧЕ УСТАНОВЛЕННЫЙ В 
ПИСЬМЕННОЙ ФОРМЕ ДЕРЖАТЕЛИ АВТОРСКОГО ПРАВА И/ИЛИ ДРУГИЕ СТОРОНЫ ОБЕСПЕЧИВАЮТ, 
ПРОГРАММА "КАК" БЕЗ ГАРАНТИИ ЛЮБОГО ВИДА, ИЛИ ВЫРАЖАЛА ИЛИ ПОДРАЗУМЕВАЛА, 
ВКЛЮЧАЯ, НО НЕ ОГРАНИЧИЛ, ПОДРАЗУМЕВАЕМЫЕ ГАРАНТИИ ВЫСОКОГО СПРОСА И 
ПРИГОДНОСТИ В СПЕЦИФИЧЕСКОЙ ЦЕЛИ. ВЕСЬ РИСК ОТНОСИТЕЛЬНО КАЧЕСТВА И 
ПРОИЗВОДИТЕЛЬНОСТИ ПРОГРАММЫ С ВАМИ. ЕСЛИ ПРОГРАММА ОКАЗЫВАЕТСЯ ДЕФЕКТНОЙ, ВЫ 
ПРИНИМАЕТЕ СТОИМОСТЬ ВСЕГО НЕОБХОДИМОГО ОБСЛУЖИВАНИЯ, РЕМОНТА ИЛИ ИСПРАВЛЕНИЯ. 
12. НИ В КОЕМ СЛУЧАЕ ЕСЛИ НЕ ТРЕБУЮЩИЙСЯ ЗАКОН BYAPPLICABLE ИЛИ СОГЛАСОВАННЫЙ НА В 
ПИСЬМЕННОЙ ФОРМЕ БУДЕТ ЛЮБОЙ ДЕРЖАТЕЛЬ АВТОРСКОГО ПРАВА, ИЛИ ЛЮБАЯ ДРУГАЯ 
СТОРОНА, КОТОРАЯ МОЖЕТ ИЗМЕНИТЬ И/ИЛИ ПЕРЕРАСПРЕДЕЛИТЬ ПРОГРАММУ КАК РАЗРЕШЕНО 
ВЫШЕ, БЫТЬ СКЛОННОЙ К ВАМ ДЛЯ УБЫТКОВ, ВКЛЮЧАЯ ЛЮБЫЕ ОБЩИЕ, СПЕЦИАЛЬНЫЕ, 
НЕПРЕДВИДЕННЫЕ ИЛИ КОСВЕННЫЕ УЩЕРБЫ, ПРОИСТЕКАЮЩИЕ ИЗ ИСПОЛЬЗОВАНИЯ ИЛИ 
НЕСПОСОБНОСТИ ИСПОЛЬЗОВАТЬ ПРОГРАММУ (ВКЛЮЧАЯ, НО НЕ ОГРАНИЧЕННАЯ ПОТЕРЕЙ 
ДАННЫХ ИЛИ ДАННЫХ, ВЫПОЛНЯЕМЫХ НЕТОЧНЫЙ ИЛИ ПОТЕРЯМИ, ПОДДЕРЖАННЫМИ ВАМИ ИЛИ 
ТРЕТЬИМИ ЛИЦАМИ ИЛИ ОТКАЗОМ ПРОГРАММЫ РАБОТАТЬ С ЛЮБЫМИ ДРУГИМИ ПРОГРАММАМИ), 
ДАЖЕ ЕСЛИ ТАКОМУ ДЕРЖАТЕЛЮ ИЛИ ДРУГОЙ СТОРОНЕ СОВЕТОВАЛИ ОТНОСИТЕЛЬНО 
ВОЗМОЖНОСТИ ТАКИХ УБЫТКОВ. КОНЕЦ СРОКОВ И УСЛОВИЙ, Как Применить Эти Сроки к Вашей Новой 
Программе, Если Вы разрабатываете новую программу, и Вы хотите, чтобы это было самого большого возможного 
применения общественности, лучший способ достигнуть, это должно сделать это бесплатным программным 
обеспечением, которое все могут перераспределить и изменить согласно этим срокам. Чтобы сделать так, 
прикрепите следующие примечания программе. Является самым безопасным прикрепить их к началу каждого 
исходного файла, чтобы наиболее эффективно передать исключение гарантии; и у каждого файла должны быть по 
крайней мере строка "авторского права" и указатель туда, где полное примечание найдено. одна строка, чтобы дать 
имя программы и идею того, что это делает. Copyright (C) yyyy название программы This автора является 
бесплатным программным обеспечением; Вы можете перераспределить это и/или изменить это в соответствии с 
Лицензией Широкой публики ГНУ как издано Фондом бесплатного программного обеспечения; или версия 2 
Лицензии, или (в Вашей опции) любая более поздняя версия. Эта программа распространена в надежде, что это 
будет полезно, но БЕЗ ЛЮБОЙ ГАРАНТИИ; без даже подразумеваемой гарантии 
 
ВЫСОКИЙ СПРОС или ПРИГОДНОСТЬ В СПЕЦИФИЧЕСКОЙ ЦЕЛИ. Лицензия Широкой публики ГНУ для 
большего количества подробностей. См. 
 
Вы должны были получить копию Лицензии Широкой публики ГНУ наряду с этой программой; в противном 
случае напишите Фонду бесплатного программного обеспечения, Inc., 59 Мест Храма - Набор программ 330, 
Бостон, Массачусетс 02111-1307, США. 
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Также включите информацию, как войти в контакт с Вами электронной и бумажной почтой. Если программа 
интерактивна, заставьте ее вывести короткое примечание как это, когда она начинается в интерактивном режиме: 
версия 69 Gnomovision, имя года Copyright (C) автора Гномовизайона не идет с АБСОЛЮТНО НИКАКОЙ 
ГАРАНТИЕЙ; для типа подробностей `показывают w'. Это - бесплатное программное обеспечение, и пожалуйста 
перераспределять это при определенных условиях; напечатайте `показ c' для подробностей. Гипотетические 
команды `показывают, что w' и `показывают, что c' должен показать соответствующие части Лицензии Широкой 
публики. Конечно, команды, которые Вы используете, можно назвать чем - то другим чем `показ w' и `показ c'; они 
могли даже быть щелчками мыши или пунктами меню - безотносительно исков Ваша программа. Вы должны также 
получить своего работодателя (если Вы работаете как программист), или Ваша школа, если таковые вообще 
имеются, чтобы подписать "оговорку авторского права" для программы, в случае необходимости. Вот выборка; 
измените названия: Yoyodyne, Inc. Тем самым отвергает весь интерес авторского права к `Gnomovision' программы 
(который делает проходы в компиляторах), написанный Джеймсом Хэкером. сигнатура Енота Ty, 1 апреля 1989 Ти 
Кун, президент Недостатка Эта Лицензия Широкой публики не разрешает включать Вашу программу в частные 
программы. Если Ваша программа - библиотека подпрограммы, Вы можете считать более полезным разрешить 
связывать частные приложения с библиотекой. Если это - то, что Вы хотите сделать, используйте Лицензию 
Широкой публики Библиотеки ГНУ вместо этой Лицензии. 
 
Возвратитесь к домашней странице ГНУ. Фонд бесплатного п/о & запросы ГНУ & вопросы к gnu@gnu.org. Другие 
способы войти в контакт с фондом бесплатного п/о. Комментарии к этим web-страницам к 
webmasters@www.gnu.org, пошлите другие вопросы в gnu@gnu.org. Объявление об авторском праве выше. Фонд 
бесплатного программного обеспечения, Inc., 59 Мест Храма - Набор программ 330, Бостон, Массачусетс 02111, 
Обновленные США: Последний измененный: понедельник 26 мая 14:51:41 EDT 2003 
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